Notices

Copyright Notice
© Keysight Technologies 2013-2019

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies as governed by United States and international copyright laws.

Manual Part Number
B1540-90020

Edition
Edition 1, June 2013
Edition 3, January 2016
Edition 4, March 2019

Printed in:
Printed in Malaysia

Published by:
Keysight Technologies Japan K.K.
9-1, Takakura-cho, Hachioji-shi, Tokyo
192-0033 Japan

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights
The Software is “commercial computer software,” as defined by Federal Acquisition Regulation ("FAR") 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement ("DFARS") 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public; or (3) Furnish technical information related to commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR OF ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT SHALL CONTROL.

Declaration of Conformity
Declarations of Conformity for this product and for other Keysight products may be downloaded from the Web. Go to http://www.keysight.com/go/conformity. You can then search by product number to find the latest Declaration of Conformity.

Latest Information
To get the latest firmware/software/electronic manuals/specifications/support information, go to www.keysight.com and type in the product number in the Search field at the top of the page.
NOTICE: This document contains references to Agilent Technologies. Agilent’s former Test and Measurement business has become Keysight Technologies. For more information, go to www.keysight.com.
Measurement Resources

The measurement resources supported by Keysight B1500 series are shown below. For reading this manual, ignore the information about the unsupported resources.

<table>
<thead>
<tr>
<th>Resource</th>
<th>B1500A</th>
<th>B1505A</th>
<th>B1506A</th>
<th>B1507A</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPSMU</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPSMU</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes (B1511B)</td>
<td>Yes (B1511B)</td>
</tr>
<tr>
<td>MCSMU</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MFCMU or CMU</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HRSMU</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HVSPGU or SPGU</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HVSMU</td>
<td></td>
<td>Yes</td>
<td>Yes (B1513C)</td>
<td>Yes (B1513C)</td>
</tr>
<tr>
<td>HVMCU</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HCSMU</td>
<td></td>
<td>Yes</td>
<td></td>
<td>Yes for H20/H21</td>
</tr>
<tr>
<td>UHCU</td>
<td></td>
<td>Yes</td>
<td></td>
<td>Yes for H50/H51/H70/H71</td>
</tr>
<tr>
<td>UHVU</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- HPSMU High power source/monitor unit (B1510A)
- MPSMU Medium power source/monitor unit (B1511A/B)
- MCSMU Medium current source/monitor unit (B1514A)
- MFCMU or CMU Multi frequency capacitance measurement unit (B1520A)
- HRSMU High resolution source/monitor unit (B1517A)
- HVSPGU or SPGU High voltage semiconductor pulse generator unit (B1525A)
- HVSMU High voltage source/monitor unit (B1513A/B/C)
- HVMCU High voltage medium current unit (N1266A with one B1513A/B/C and two B1514A/B1512A)
- HCSMU High current source/monitor unit (B1512A)
- UHCU Ultra high current unit (N1265A with two B1514A/B1512A)
- UHVU Ultra high voltage unit (N1268A with two B1514A/B1512A)
EasyEXPERT Software

The EasyEXPERT software is installed in the Keysight B1500 for the measurement execution and the measurement data analysis. And you can use the EasyEXPERT for an external PC and that provides the following additional advantages to the B1500, allowing you to minimize the amount of offline tasks performed on the B1500 and increase the working ratio for measurements.

- Allows the B1500, B2900, 4155, 4156, E5260, or E5270 to be controlled from an external computer while online.
- Allows test setup to be created on an external computer while offline.
- Allows data analysis to be performed on an external computer while offline.

For the information on installation of EasyEXPERT to the external PC, see “Using EasyEXPERT on External PC” on page 7-1.
In This Manual

This manual describes the reference information of Keysight Technologies EasyEXPERT which is the system software of Keysight Technologies precision current-voltage analyzer series. This manual covers the following topics.

6. "Remote Control Interface"
   Explains about the EasyEXPERT remote control interface which is a command set used to control EasyEXPERT by a program.

7. "Using EasyEXPERT on External PC"
   Explains how to run EasyEXPERT on an external PC.

8. "Utilities"
   Introduces the utility programs.

9. "Application Library"
   Lists the furnished application tests. Also describes the maximum measurement value and accuracy for the result data measured by using the QSCV[2] application test.

10. "If You Have a Problem"
    Introduces how to solve a problem you may encounter. Also describes how to perform the system recovery and the data backup/recovery.

11. "Error Message"
    Lists error codes and error messages.

A. "Appendix"
    Shows useful reference information for the use of the EasyEXPERT.

User’s Guide Vol. 1 consists of the following chapters.

1. “Main GUI”
2. “Classic Test Definition”
3. “Application Test Definition”
4. “Function Details”
5. “Built-in Programming Tool”
NOTE
To get the latest firmware/software/manual/specifications/support information, go to http://www.keysight.com/find/easyexpert.

NOTE
The information is subject to change without notice due to the future enhancement. The actual screen image of EasyEXPERT may be different from the image shown in this manual.
6. Remote Control Interface

Introduction ................................................................................. 6-3
Supported Operations .................................................................... 6-4
Preparation for Communication .................................................. 6-5
Checking Windows Firewall Setting ............................................. 6-6

Notational Convention and Command Summary ......................... 6-7

Common Commands ..................................................................... 6-12
*CLS ................................................................. 6-12
*IDN? ................................................................. 6-12
*OPC? ................................................................. 6-12

BENCh Subsystem ....................................................................... 6-13
[:BENCH]:APPlication:CATalog? .............................................. 6-13
[:BENCH]:APPlication:SESelect .............................................. 6-13
[:BENCH]:COUNt .............................................................. 6-13
[:BENCH]:COUNt:RESet ....................................................... 6-14
[:BENCH]:LOAD[:SETup] ....................................................... 6-14
[:BENCH]:PRESet:CATalog? ................................................. 6-14
[:BENCH]:PRESet:OPEN ...................................................... 6-14
[:BENCH]:PRESet[:SESelect]:NAME? ................................. 6-15
[:BENCH]:PRESet:SETup:CATalog? ....................................... 6-15
[:BENCH]:PRESet:SETup:SESelect ....................................... 6-15
[:BENCH]:[:SESelect]:ABORt .............................................. 6-16
[:BENCH]:[:SESelect]:NAME .............................................. 6-16
[:BENCH]:[:SESelect]:NUMBer ............................................. 6-16
[:BENCH]:[:SESelect]:RUN[:SINGle] ...................................... 6-17
[:BENCH]:[:SESelect]:STRing ............................................. 6-17
[:BENCH]:TAG ......................................................... 6-18

CALibration Subsystem ............................................................ 6-19
:CALibration[:SMU]:ZERO:FULLrange ...................................... 6-19
:CALibration[:SMU]:ZERO:MEASure[:CURRent] .................... 6-19
7. Using EasyEXPERT on External PC

System Requirements .................................................. 7-3
Recommended GPIB Interface ..................................... 7-4
.NET Framework ....................................................... 7-5
IO Library ............................................................... 7-5
Contents

To Install EasyEXPERT in External PC ............................................. 7-6
Before Starting EasyEXPERT ....................................................... 7-7
To Start EasyEXPERT on Your PC .................................................. 7-8
To Change Execution Mode and GPIB Settings ................................. 7-9
Using 4155B/4156B/4155C/4156C ............................................... 7-10
Using E5260A/E5262A/E5263A/E5270B ......................................... 7-13
Using B2900A ................................................................. 7-15

8. Utilities

System Requirement .............................................................. 8-3
License Management Tool ......................................................... 8-4
   License Management Tool GUI ............................................... 8-5
Setup File Converter ............................................................... 8-6
   Setup File Converter GUI ..................................................... 8-7
MDM File Converter ............................................................... 8-8
   MDM File Converter GUI .................................................... 8-9
Utility Programs ................................................................. 8-10
   User Account Management Tool .......................................... 8-10
   Offline Configuration Tool .................................................. 8-11
   Software Configuration Tool ............................................... 8-12
   Prober Control ............................................................ 8-13
   SetupFileConverter.exe ...................................................... 8-24
   MdmFileConverter.exe ....................................................... 8-27
   sleep.exe ................................................................. 8-30
   XSLT ............................................................... 8-31
Contents

9. Application Library
   Application Test Definitions .................................................. 9-3
   QSCV Maximum Measurement Value and Accuracy ......................... 9-24
      Maximum Measurement Value .............................................. 9-24
      Measurement Accuracy .................................................... 9-28

10. If You Have a Problem
    When You Operate B1500 ...................................................... 10-3
        Power On Trouble ....................................................... 10-3
        SCUU is not Detected ................................................. 10-3
        ASU is not Detected .................................................. 10-4
        N1265A/N1266A/N1268A is not Detected ............................. 10-4
        GPIB Devices are not Detected ...................................... 10-4
        To Simplify the Connections ......................................... 10-5
    When You Perform Measurement ............................................ 10-6
        Measurement Takes More Time than Specified ...................... 10-6
        Noise Affects the Measured Values ................................ 10-7
        Voltage Measurement Error is Large ................................. 10-8
        SMU Oscillates for High-Frequency Device Measurements ....... 10-8
        SMU Oscillates for Negative Resistance Measurements .......... 10-9
        Large Current Causes High Temperature (Thermal Drift) ....... 10-10
        Measurement Damages the Device under Test ....................... 10-10
        Leaving Connections Damages Devices after Measurement ........ 10-10
        Unexpected Sampling Measurement Data is Returned ................ 10-11
        MFCMU Causes Unbalance Condition .................................. 10-11
    Notice for Migrating from 4155/4156 .................................. 10-12
    Before Shipping to Service Center ...................................... 10-14
       To Make Backup ................................................................ 10-14
       To Check Module Slots .................................................. 10-14
Contents

To Check ASU/SMU Combination ........................................ 10-14
To Collect Equipment and Accessories ................................. 10-15

Data Backup and Recovery .............................................. 10-16
Folders to Backup .......................................................... 10-17
To Make Database Backup .............................................. 10-17
To Restore Database Backup ........................................... 10-18
To Make Backup of Other Data ....................................... 10-18
To Restore Backup of Other Data .................................... 10-19
To Move the EasyEXPERT Database ................................ 10-19

Updating EasyEXPERT ..................................................... 10-20
Performing a Clean Install of EasyEXPERT ......................... 10-21

B1500 System Recovery ................................................... 10-22
Before Performing System Recovery .................................. 10-22
Preparation ................................................................. 10-23
To Perform System Recovery ......................................... 10-23
To Initialize Database .................................................. 10-26
To Restore Database ..................................................... 10-26

11. Error Message

Keysight EasyEXPERT Operation Error ................................. 11-3
Keysight FLEX Execution Error ........................................ 11-54
Keysight B1500 Self-test/Calibration Error ........................... 11-82
Setup File Converter Execution Error ................................. 11-97
MDM File Converter Execution Error ................................. 11-98

A. Appendix

EasyEXPERT Measurement Capabilities v.s. Instruments .......... A-3
EasyEXPERT File Summary .............................................. A-5
6 Remote Control Interface
Remote Control Interface

This chapter explains about the EasyEXPERT remote control interface which is a command set used to control EasyEXPERT by using a program via LAN, and consists of the following sections.

- “Introduction”
- “Notational Convention and Command Summary”
- “Common Commands”
- “BENCh Subsystem”
- “CALibration Subsystem”
- “RESult Subsystem”
- “STANDby Subsystem”
- “SYSTem Subsystem”
- “WORKspace Subsystem”
- “Error Messages”

**NOTE**

The following conventions are used in this chapter.

- For Windows 7/8.1/10 64 bit version
  
  `<program folder>`: `<system drive>`: `\Program Files (x86)`

- For Windows XP, Vista, 7/8.1/10 32 bit version
  
  `<program folder>`: `<system drive>`: `\Program Files`

`<system drive>`: Drive the EasyEXPERT has been installed

**NOTE**

Sample programs

Sample programs for using the EasyEXPERT remote control interface are stored in the following folder. See the program code for your reference of programming.

`<program folder>`: `\Agilent\B1500\EasyEXPERT\Samples\Remote Control`

**NOTE**

About socket services

Keysight instruments are standardized on using port 5025 for socket services. A data socket on this port can be used to send and receive commands, queries, and query responses. All commands must be terminated with a newline for the message to be parsed. All query responses will also be terminated with a newline.
Introduction

The EasyEXPERT remote control interface is a software interface usable from the VISA/SICL library. And it is used for the following applications as examples via LAN using the socket service. See Figure 6-1.

- To control EasyEXPERT by using a program which runs on an external computer (Controller A)
- To control EasyEXPERT by using a program which runs on the B1500
- To control EasyEXPERT which runs on a computer (Controller B) by using a program on Controller A
- To control EasyEXPERT on Controller B by using a program on Controller B

Figure 6-1  Image of EasyEXPERT Remote Control
Remote Control Interface
Introduction

Supported Operations
The EasyEXPERT remote control interface provides the subsystem commands listed below. Operations supported by these commands are shown in Figure 6-2.

• WORKspace Subsystem
  Opening/closing workspace
• BENCH Subsystem
  Performing test setup and measurement
• RESULT Subsystem
  Getting test result data
• CALibration Subsystem
  Using offset current cancel function
• STANDby Subsystem
  Using standby function
• SYSTem Subsystem
  Checking errors

NOTE To start remote control, the workspace selection screen must be displayed by EasyEXPERT.
Remote Control Interface
Introduction

**Operations Supported by EasyEXPERT Remote Control Interface**

- Power ON → Start EasyEXPERT
- To open workspace
- To set test setup
- To change test parameters (for Application Test)
- To execute measurement (Single execution)
- To get test results
- To close workspace
- Exit EasyEXPERT

### Preparation for Communication

Communication between a computer and EasyEXPERT can be made as follows.

- Confirm the firewall of Windows for the communication between the computer and EasyEXPERT is set appropriately. See “Checking Windows Firewall Setting”.

- Prepare a computer installed with VISA/SICL library. They are included in Keysight IO Libraries Suite.

- Connect the computer to a LAN. And connect the B1500, or the computer installed with EasyEXPERT, to the same LAN. See Figure 6-1 for example.

- Make a communication between the computer and EasyEXPERT using the socket service. Only one EasyEXPERT can be connected.

  If you use Keysight IO Libraries Suite, launch the Connection Expert software and click the Add Instrument button to find and connect EasyEXPERT.
Checking Windows Firewall Setting

Click [Control Panel] > [System and Security] > [All a program through Windows Firewall]. Allowed programs are listed on the screen. Make sure that the EasyEXPERT is allowed.

If the list does not have the EasyEXPERT, allow it as follows:

1. As the administrator privileges, click the Change settings button.
2. Click the Allow another program... button.
   A dialog box opens.
3. Click the Browse... button, and specify the path of the EasyEXPERT execution file.
   The EasyEXPERT is added to the program list in the dialog box.
4. Click EasyEXPERT in the program list, and then click the Add button.
   The EasyEXPERT is added to the list of the “Allowed programs and features”.
5. Click the check box of the EasyEXPERT with setting the properties, and then click the OK button.
# Notational Convention and Command Summary

## Table 6-1

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital letters</td>
<td>Capital letters are the minimally required letters of the command or query program header. Lowercase letters are the long form (complete spelling), which you can omit if desired.</td>
</tr>
<tr>
<td>Vertical bar</td>
<td>Vertical bars separate alternative parameters. For example, ON</td>
</tr>
<tr>
<td>Square brackets [ ]</td>
<td>Items within square brackets are optional. The representation [:BENCh]:APPLication:SESelect means that :BENCh may be omitted.</td>
</tr>
<tr>
<td>NR1</td>
<td>Digits with an implied decimal point assumed at the right of the least-significant digit. Example: 273</td>
</tr>
<tr>
<td>NR2</td>
<td>Digits with an explicit decimal point. Example: 27.3</td>
</tr>
<tr>
<td>NR3</td>
<td>Digits with an explicit decimal point and an exponent. Example: 2.73E+02</td>
</tr>
<tr>
<td>NRf</td>
<td>Extended format that includes NR1, NR2, and NR3. Examples: 273, 27.3, 2.73E+02</td>
</tr>
<tr>
<td>Bool</td>
<td>Boolean data. Can be numeric (0, 1), or named (OFF, ON).</td>
</tr>
<tr>
<td>SPD</td>
<td>String program data. Programs string parameters enclosed in single or double quotes.</td>
</tr>
<tr>
<td>CPD</td>
<td>Character program data. Programs discrete parameters. Accepts both short form and long form.</td>
</tr>
<tr>
<td>SRD</td>
<td>String Query response data. Returns string parameters enclosed in single or double quotes.</td>
</tr>
</tbody>
</table>
Remote Control Interface
Notational Convention and Command Summary

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRD</td>
<td>Character Query response data. Returns discrete parameters. Only the short form of the parameter is returned.</td>
</tr>
<tr>
<td>AARD</td>
<td>Arbitrary ASCII Query response data. Permits the return of un-delimited 7-bit ASCII. This data type has an implied message terminator.</td>
</tr>
<tr>
<td>Block</td>
<td>Definite length arbitrary binary data</td>
</tr>
</tbody>
</table>

Table 6-2 Subsystem Command Summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORKspace subsystem</td>
<td></td>
</tr>
<tr>
<td>:WORKspace:CLOSE</td>
<td>Closes the workspace now opened.</td>
</tr>
<tr>
<td>:WORKspace:OPEN &quot;name&quot;</td>
<td>Opens the specified workspace.</td>
</tr>
<tr>
<td></td>
<td>name=Workspace name</td>
</tr>
<tr>
<td>:WORKspace[:SELECTed]:NAME?</td>
<td>Returns the name of the workspace now opened.</td>
</tr>
<tr>
<td>:WORKspace:STATe?</td>
<td>Returns the status of the workspace.</td>
</tr>
<tr>
<td>BENCh subsystem</td>
<td></td>
</tr>
<tr>
<td>[:BENCh]:APPLICATION:CATalog?</td>
<td>Returns catalog of the application test definitions.</td>
</tr>
<tr>
<td>[:BENCh]:APPLICATION:SELECT &quot;name&quot;</td>
<td>Opens the specified application test definition.</td>
</tr>
<tr>
<td></td>
<td>name=Name of an application test definition</td>
</tr>
<tr>
<td>[:BENCh]:COUNT count</td>
<td>Sets or returns the value of the Count field.</td>
</tr>
<tr>
<td>[:BENCh]:COUNT?</td>
<td>count=Value of the Count field</td>
</tr>
<tr>
<td>[:BENCh]:COUNT:RESET</td>
<td>Clears the value of the Count field.</td>
</tr>
<tr>
<td>[:BENCh]:LOAD[:SETup] setup</td>
<td>Loads and sets the test setup information included in the XTS or XTR data.</td>
</tr>
<tr>
<td></td>
<td>setup=Test setup information, Block data</td>
</tr>
</tbody>
</table>
### Remote Control Interface

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>[:BENCH]:PRESet:OPEN &quot;name&quot;</td>
<td>Opens the specified preset group (My Favorites).</td>
</tr>
<tr>
<td></td>
<td>name=Preset group name</td>
</tr>
<tr>
<td>[:BENCH]:PRESet:OPEN &quot;name&quot;</td>
<td>Opens the specified preset group (My Favorites).</td>
</tr>
<tr>
<td></td>
<td>name=Preset group name</td>
</tr>
<tr>
<td>[:BENCH]:PRESet:SETup:CATalog?</td>
<td>Returns catalog of the test setup included in the preset group (My Favorites) now opened.</td>
</tr>
<tr>
<td>[:BENCH]:PRESet:SETup:SELECT &quot;name&quot;</td>
<td>Opens the specified test setup included in the preset group (My Favorites) now opened.</td>
</tr>
<tr>
<td></td>
<td>name=Test setup name</td>
</tr>
<tr>
<td>[:BENCH][:SELECTed]:ABORT</td>
<td>Aborts the single measurement now in progress.</td>
</tr>
<tr>
<td>[:BENCH][:SELECTed]:NAME &quot;name&quot; [:BENCH][:SELECTed]:NAME?</td>
<td>Sets or returns the value of the Setup Name field of the test setup now opened.</td>
</tr>
<tr>
<td></td>
<td>name=Value of the Setup Name field</td>
</tr>
<tr>
<td>[:BENCH][:SELECTed]:NUMBER &quot;name&quot;, value [:BENCH][:SELECTed]:NUMBER? &quot;name&quot;</td>
<td>Sets or returns the value of the specified numeric parameter defined in the application test now opened.</td>
</tr>
<tr>
<td></td>
<td>name=Parameter name</td>
</tr>
<tr>
<td></td>
<td>value=Value of the parameter</td>
</tr>
<tr>
<td>[:BENCH][:SELECTed]:RUN[:SINGLE]</td>
<td>Starts the single measurement of the test now opened.</td>
</tr>
<tr>
<td>[:BENCH][:SELECTed]:STRING &quot;name&quot;,&quot;value&quot; [:BENCH][:SELECTed]:STRING? &quot;name&quot;</td>
<td>Sets or returns the value of the specified string parameter defined in the application test now opened.</td>
</tr>
<tr>
<td></td>
<td>name=Parameter name</td>
</tr>
<tr>
<td></td>
<td>value=Value of the parameter</td>
</tr>
<tr>
<td>[:BENCH]:TAG &quot;deviceid&quot; [:BENCH]:TAG?</td>
<td>Sets or returns the value of the Device ID field.</td>
</tr>
<tr>
<td></td>
<td>deviceid=Value of the Device ID field</td>
</tr>
</tbody>
</table>

**RESult subsystem**

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>:RESult:FETch[:LATest]?</td>
<td>Returns the latest test result data.</td>
</tr>
</tbody>
</table>
Remote Control Interface
Notational Convention and Command Summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>:RESult:FETch[:LATest]:SIBLings?</td>
<td>Returns the latest test result data. For the application test result, this command returns the result data for all included tests.</td>
</tr>
<tr>
<td>:RESult:FORMat mode</td>
<td>Sets or returns the output format of the test result data.</td>
</tr>
<tr>
<td>:RESult:FORMat?</td>
<td>mode=TEXT</td>
</tr>
<tr>
<td>:RESult:FORMat:ESCAPE mode</td>
<td>Sets or returns the newline character type used in the test result data.</td>
</tr>
<tr>
<td>:RESult:FORMat:ESCAPE?</td>
<td>mode=0</td>
</tr>
<tr>
<td>:RESult:RECycle:ALL</td>
<td>Adds all test result data to the Delete group.</td>
</tr>
<tr>
<td>:RESult:RECycle[:LATest]</td>
<td>Adds the latest test result data to the Delete group.</td>
</tr>
</tbody>
</table>

STANDby subsystem

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>:STANDby:STATe mode</td>
<td>Sets or returns the SMU standby function ON/OFF status.</td>
</tr>
<tr>
<td>:STANDby:STATe?</td>
<td>mode=0</td>
</tr>
</tbody>
</table>

SYSTem subsystem

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>:SYSTem:ERRor[:NEXT]?</td>
<td>Returns the top code and message in the error queue.</td>
</tr>
</tbody>
</table>

CALibration subsystem

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>:CALibration[:SMU]:ZERO:FULLrange &quot;module&quot;, mode</td>
<td>Sets or returns the full range measurement ON/OFF status for the specified SMU+ASU.</td>
</tr>
<tr>
<td>:CALibration[:SMU]:ZERO:FULLrange? &quot;module&quot;</td>
<td>mode=Identifier of the SMU</td>
</tr>
<tr>
<td>:CALibration[:SMU]:ZERO:MEASure[:CURRENT]</td>
<td>Starts the offset current measurement for the SMU set to the offset current cancel function ON. Or returns the offset current measurement data of the specified SMU.</td>
</tr>
<tr>
<td>:CALibration[:SMU]:ZERO:MEASure[:CURRENT]? &quot;module&quot;</td>
<td>mode=Identifier of the SMU</td>
</tr>
<tr>
<td>:CALibration[:SMU]:ZERO:OFF:ALL</td>
<td>Sets the all SMU to the offset current cancel function OFF.</td>
</tr>
</tbody>
</table>
### Remote Control Interface

#### Notational Convention and Command Summary

<table>
<thead>
<tr>
<th>Command</th>
<th>Summary</th>
</tr>
</thead>
</table>
| :CALibration[:SMU]:ZERO[:ON] "module1","module2",..."module"] | Sets the specified SMU to the offset current cancel function ON. Or returns the identifier of the SMU set to the offset current cancel function ON. 

\( \text{module} = \text{Identifier of the SMU to be set to the offset current cancel function ON} \) |
| :CALibration[:SMU]:ZERO[:ON]? | Sets the all SMU to the offset current cancel function ON. |
| :CALibration[:SMU]:ZERO:PLC "module",plc | Sets or returns the integration time used for the offset current measurement of the specified SMU. 

\( \text{module} = \text{Identifier of the SMU} \) 

\( \text{plc} = 1|2|5|10|16|25|50|100 \) |
| :CALibration[:SMU]:ZERO:STATe? | Returns the present status of the offset current cancel function ON/OFF. |
Common Commands

Describes common commands provided by the EasyEXPERT remote control interface.

*CLS
Clears the error queue.

Syntax
*CLS

*IDN?
Returns the EasyEXPERT identification string which contains four comma-separated fields.

Syntax
*IDN?

Query response
Agilent Technologies, Agilent EasyEXPERT, hostname, revision <newline>

hostname Host name of the computer which EasyEXPERT is running
revision EasyEXPERT revision number

Data type is AARD.

*OPC?
Starts to monitor run state of the commands sent before this command, and returns 1 if the instrument completes all pending operations.
Other commands cannot be executed until 1 is returned.

Syntax
*OPC?

Query response
1 <newline>

Data type is NR1.
BENCh Subsystem

Describes BENCh subsystem commands used for test setup and measurement.

[:BENCh]:application:CATalog?

Returns catalog of the application test definitions. Returns all application test definitions regardless of the Category selection.

**Syntax**

[:BENCh]:APPlication:CATalog?

**Query response**

"app def1","app def2", ... "app def"]

Data type is SRD.

**Example**

:APP:CAT?

[:BENCh]:APPlication:SELect

Opens the specified application test definition.

**Syntax**

[:BENCh]:APPlication:SELect "name"

**Parameter**

name Name of an application test definition. Data type is SPD.

**Example**

:APP:SEL "Bvcbo"

[:BENCh]:COUNt

Sets or returns the value of the Count field.

**Syntax**

[:BENCh]:COUNt count

[:BENCh]:COUNt?

**Parameter**

count Value of the Count field. Data type is NR1.

**Query response**

count

Data type is NR1.
Remote Control Interface
BENCh Subsystem

Example

[:BENCH]:COUNt:RESet
Cleans the value of the Count field.

Syntax
[:BENCH]:COUNt:RESet

Example
[:COUN]:RES

[:BENCH]:LOAD[:SETup]
Loads and sets the test setup information included in the XTS or XTR data. If the XTR data contains multiple setup information, only the first setup information is loaded.

Syntax
[:BENCH]:LOAD[:SETup] setup

Parameter
setup
Test setup information. Data type is Block.

Example
:LOAD #32229876543210 ... 987654321098
In this example, #3222 is followed by 222-byte length binary data.

[:BENCH]:PRESet:CATalog?
Returns catalog of the preset group (My Favorite).

Syntax
[:BENCH]:PRESet:CATalog?

Query response
"preset1","preset2", ... "preset"
Data type is SRD.

Example
:PRES:CAT?

[:BENCH]:PRESet:OPEN
Opens the specified preset group (My Favorites).

Syntax
[:BENCH]:PRESet:OPEN "name"
**Parameter**  
*name*  
Preset group name. Data type is SPD.

**Example**  
>PRES:OPEN "BJT Tests"

```
[:BENCH]:PRES[[:SELeected]][:NAME]?
```

Returns the name of the preset group (My Favorites) now opened.

**Syntax**  
[:BENCH]:PRES[:SELeected]:NAME?

**Query response**  
"name"

Data type is SRD.

**Example**  
>PRES:NAME?  

```
[:BENCH]:PRES:SET:CAT?
```

Returns catalog of the test setup included in the preset group (My Favorites) now opened.

**Syntax**  
[:BENCH]:PRES:SET:CATalog?

**Query response**  
"setup1","setup2", ...

Data type is SRD.

**Example**  
>PRES:SET:CAT?

```
[:BENCH]:PRES:SET:SEL"name"
```

Opens the specified test setup included in the preset group (My Favorites) now opened.

**Syntax**  
[:BENCH]:PRES:SET:SELect "name"

<table>
<thead>
<tr>
<th>Parameter</th>
<th>name</th>
<th>Test setup name. Data type is SPD.</th>
</tr>
</thead>
</table>

**Example**  
>PRES:SET:SEL "BC Diode Fwd"
Remote Control Interface
BENCh Subsystem

[:BENCH][:SELECTed]:ABORT
Aborts the single measurement now in progress.

Syntax
[:BENCH][:SELECTed]:ABORT

Example
:ABOR

[:BENCH][:SELECTed]:NAME
Sets or returns the value of the Setup Name field of the test setup now opened.

Syntax
[:BENCH][:SELECTed]:NAME "name"
[:BENCH][:SELECTed]:NAME?

Parameter
name Value of the Setup Name field. Data type is SPD.

Query response
"name"<newline>
Data type is SRD.

Example
:NAME "BC Diode Fwd (Device A)"
:NAME?

[:BENCH][:SELECTed]:NUMBer
Sets or returns the value of the specified numeric parameter defined in the application test now opened.

Syntax
[:BENCH][:SELECTed]:NUMBer "param_name", nvalue
[:BENCH][:SELECTed]:NUMBer? "param_name"

Parameter
param_name Parameter name. Data type is SPD.
nvalue Value of the parameter. Data type is NRf.

Query response
nvalue<newline>
Data type is NRf.

Example
:NUMB "VcStep", 0.1
:NUMB? "VcStep"
\textbf{[:BENCH][:SELECTed]:RUN[:SINGLE]}\protect\\jump

Starts the single measurement of the test now opened. Use the *OPC? command to confirm the completion of the single measurement.

**Syntax**

[:BENCH][:SELECTed]:RUN[:SINGLE]

**Example**

:RUN

\textbf{[:BENCH][:SELECTed]:STRING}\protect\\jump

Sets or returns the value of the specified string parameter defined in the application test now opened.

**Syntax**

[:BENCH][:SELECTed]:STRING "param_name", "svalue"

[:BENCH][:SELECTed]:STRING? "param_name"

**Parameter**

\textit{param\_name} Parameter name. Data type is SPD.

\textit{svalue} Value of the parameter. Data type is SPD.

**Query response**

"svalue"<newline>

Data type is SRD.

**Example**

:STR "Base", "SMU1:HP"

:STR? "Base"
Remote Control Interface
BENCh Subsystem

[:BENCh]:TAG
Sets or returns the value of the Device ID field.

**Syntax**
[:BENCh]:TAG "deviceid"
[:BENCh]:TAG?

**Parameter**
deviceid Value of the Device ID field. Data type is SPD.

**Query response**
"deviceid"\nData type is SRD.

**Example**
:TAG "Device A"
:TAG?
CALibration Subsystem

Describes CALibration subsystem commands used for the offset current cancel function.

:`CALibration[:SMU]:ZERO:FULLrange`

Sets or returns the full range measurement ON/OFF status for the specified SMU+ASU.

**Syntax**

:`CALibration[:SMU]:ZERO:FULLrange "module", mode`

:`CALibration[:SMU]:ZERO:FULLrange? "module"`

**Parameter**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module</td>
<td>Identifier of the SMU. Data type is SPD.</td>
</tr>
<tr>
<td>mode</td>
<td>Full range measurement ON or OFF, 0 (OFF)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

**Query response**

`mode<newline>`

0 (OFF) or 1 (ON) is returned. Data type is Bool.

**Example**

:`CAL:ZERO:FULL "SMU4:HR/AS", 1`

:`CAL:ZERO:FULL? "SMU4:HR/AS"`

:`CALibration[:SMU]:ZERO:MEASure[:CURRent]`

Starts the offset current measurement for the SMU set to the offset current cancel function ON. Or returns the offset current measurement data of the specified SMU. Use the *OPC? command to confirm the completion of the measurement.

**Syntax**

:`CALibration[:SMU]:ZERO:MEASure[:CURRent]`

:`CALibration[:SMU]:ZERO:MEASure[:CURRent]? "module"`

**Parameter**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module</td>
<td>Identifier of the SMU. Data type is SPD.</td>
</tr>
</tbody>
</table>
Remote Control Interface
CALibration Subsystem

Query response  
\textit{current1}, \textit{current2}, \textit{current3}, \textit{current4}  
Data type is NRf.

\textit{current1}: Offset current measurement data for the 1 nA range  
\textit{current2}: Offset current measurement data for the 100 pA range  
\textit{current3}: Offset current measurement data for the 10 pA range  
\textit{current4}: Offset current measurement data for the 1 pA range

Example  
:CAL:ZERO:MEAS
:CAL:ZERO:MEAS? "SMU4:HR/AS"

\textbf{:CALibration[:SMU]:ZERO:OFF:ALL}  
Sets the all SMU to the offset current cancel function OFF.

Syntax  
:CALibration[:SMU]:ZERO:OFF:ALL

Example  
:CAL:ZERO:OFF:ALL

\textbf{:CALibration[:SMU]:ZERO[:ON]}  
Sets the specified SMU to the offset current cancel function ON. Or returns the identifier of the SMU set to the offset current cancel function ON.

Syntax  
:CALibration[:SMU]:ZERO[:ON] "\textit{module1}\[,"\textit{module2}\[, ... "\textit{module}\]]"

:CALibration[:SMU]:ZERO[:ON]?

Parameter  
\textit{module}  
Identifier of the SMU to be set to the offset current cancel function ON. Data type is SPD.

Query response  
"\textit{module1}\[,"\textit{module2}\[, ... "\textit{module}\]]<newline>  
Identifier of the SMU set to the offset current cancel function ON. Data type is SRD.

Example  
:CAL:ZERO "SMU1:HP", "SMU2:MP", "SMU3:MP"

:CAL:ZERO?
**:CALibration[:SMU]:ZERO[:ON]:ALL**

Sets the all SMU to the offset current cancel function ON.

**Syntax**

:CALibration[:SMU]:ZERO[:ON]:ALL

**Example**

:CAL:ZERO:ALL

**:CALibration[:SMU]:ZERO:PLC**

Sets or returns the integration time used for the offset current measurement of the specified SMU.

**Syntax**

:CALibration[:SMU]:ZERO:PLC "module", plc

:CALibration[:SMU]:ZERO:PLC? "module"

**Parameter**

- **module**: Identifier of the SMU. Data type is SPD.
- **plc**: Integration time, 1|2|5|10|16|25|50|100. This is the number of power line cycles (PLC). If the invalid value is specified, the maximum allowable value less than the specified value is set automatically. Data type is NR1

**Query response**

`plc
`<newline>

Data type is NR1.

**Example**

:CAL:ZERO:PLC "SMU4:HR/AS", 25

:CAL:ZERO:PLC? "SMU4:HR/AS"

**:CALibration[:SMU]:ZERO:STATe?**

Returns the present status of the offset current cancel function ON/OFF.

**Syntax**

:CALibration[:SMU]:ZERO:STATe?

**Query response**

`mode
`<newline>

0 (OFF) or 1 (ON) is returned. Data type is Bool.

**Example**

:CAL:ZERO:STAT?
**RESult Subsystem**

Describes RESult subsystem commands used for getting/deleting the test result data, and so on.

**:RESult:FETch[:LATest]?**

Returns the latest test result data.

**Syntax**

**:RESult:FETch[:LATest]?**

**Query response**

`data<newline>`

Data type is Block.

Example: #32569876543210 ... 987654<newline>

In this example, #3256 is followed by 256-byte length binary data.

**Example**

**:RES:FET?**

**:RESult:FETch[:LATest]:SIBLings?**

Returns the latest test result data. For the application test result, this command returns the result data for all included tests.

**Syntax**

**:RESult:FETch[:LATest]:SIBLings?**

**Query response**

`data<newline>`

Data type is Block.

Example: #39639876543210 ... 9876543210987<newline>

In this example, #3963 is followed by 963-byte length binary data.

**Example**

**:RES:FET:SIBL?**
:RESult:FORMat
Sets or returns the output format of the test result data.

Syntax
:RESult:FORMat mode
:RESult:FORMat?

Parameter
mode
Output format, TEXT|XTR. Data type is CPD.
TEXT: Text format, initial setting
XTR: EasyEXPERT test result data format

Query response
mode
TEXT or XTR is returned. Data type is CRD.

Example
:RES:FORM XTR
:RES:FORM?

:RESult:FORMat:ESCape
Sets or returns the newline character type used in the test result data.

Syntax
:RESult:FORMat:ESCape mode
:RESult:FORMat:ESCape?

Parameter
mode
Type, 0|OFF|1|ON. Data type is Bool.
0 | OFF: ASCII code 0x0D (CR) and 0x0A (LF), initial setting
1 | ON: \r (CR) and \n (LF)

Query response
mode
0 (OFF) or 1 (ON) is returned. Data type is Bool.

Example
:RES:FORM:ESC ON
:RES:FORM:ESC?
Remote Control Interface
RESult Subsystem

**:RESult:RECycle:ALL**
Adds all test result data to the Delete group.

**Syntax**
:RESult:RECycle:ALL

**Example**
:RES:REC:ALL

**:RESult:RECycle[:LATEST]**
Adds the latest test result data to the Delete group. For the application test result, the result data for all included tests is subject.

**Syntax**
:RESult:RECycle[:LATEST]

**Example**
:RES:REC
STANDby Subsystem

Describes STANDby subsystem command used for the standby function.

**:STANDby:STATe**

Sets or returns the SMU standby function ON/OFF status.

**Syntax**

```
:STANDby:STATe mode
:STANDby:STATe?
```

**Parameter**

`mode`  
Standby function ON or OFF, 0|OFF|1|ON. Data type is Bool.

- 0 | OFF: Standby function OFF
- 1 | ON: Standby function ON

**Query response**

```
mode
```

0 (OFF) or 1 (ON) is returned. Data type is Bool.

**Example**

```
:STAND:STAT ON
:STAND:STAT?
```
SYSTem Subsystem

Describes SYSTem subsystem command provided by the EasyEXPERT remote control interface.

:SYSTem:ERRor[:NEXT]?

Reads and removes the top item in the error queue, and returns the top code and message.

Syntax
:SYSTem:ERRor[:NEXT]?

Query response

response<newline>
response: code,"message"

- code: Error code. Data type is NR1.
- message: Error message. Data type is SRD.

Multiple responses are listed in the FIFO (first-in-first-out) order, separated by a comma.

If the queue is empty, the response is +0,"No error".

Example
:SYST:ERR?
WORKspace Subsystem

Describes WORKspace subsystem commands used for opening/closing workspace, and so on.

:WORKspace:CATalog?

Returns catalog of your own workspace and the Public workspace.

Syntax

:WORKspace:CATalog?

Query response

"workspace1","workspace2", ... "workspace"]<newline>

Data type is SRD.

Example

:WORK:CAT?

:WORKspace:CLOSe

Closes the workspace now opened. Use the *OPC? command to confirm the completion of close operation.

Syntax

:WORKspace:CLOSe

Example

:WORK:CLOS

:WORKspace:OPEN

Opens the specified workspace. Use the *OPC? command to confirm the completion of open operation.

Syntax

:WORKspace:OPEN "name"

Parameter

name

Workspace name. Data type is SPD.

Example

:WORK:OPEN "my workspace1"
Remote Control Interface
WORKspace Subsystem

:WORKspace[:SELected]:NAME?

Returns the name of the workspace now opened.

**Syntax**

:WORKspace[:SELected]:NAME?

**Query response**

"name"

Data type is SRD.

**Example**

:WORK:NAME?

:WORKspace:STATe?

Returns the status of the workspace.

**Syntax**

:WORKspace:STATe?

**Query response**

status

OPEN or CLOS is returned. Data type is CRD.

OPEN: Workspace is now opened.

CLOS: Workspace is now closed. Or open/close operation is in progress.

**Example**

:WORK:STAT?
## Error Messages

### 0

No Error

### 101

EasyEXPERT Error; Message ID: `code / message`

Error occurs in EasyEXPERT remote operation. *code* and *message* are as follows.

- *code*: Error code sent by EasyEXPERT
- *message*: Error message sent by EasyEXPERT

See “Keysight EasyEXPERT Operation Error” on page 11-3.

### 201

Remote Control Error; *message*

Error occurs in EasyEXPERT remote control library. *message* is as follows.

- Application Test definition does not exist; name: *A*
- Exporting as Text Format failed.
  
  Could not convert the test result data to the text format.
- Expression is not a resource; expression: *A*
- Expression is not numeric; expression: *A*
- Parameter is not numeric; Parameter: *A*
- Preset Group does not exist; Preset Group: *A*
- Parameter does not exist; parameter name: *A*
- Test is being executed.
  
  Measurement is now in progress.
- Test Setup does not exist in My Favorite; Test setup name: *A*
  
  Test setup *A* is not found in the preset group (My Favorite) now opened.
- There is no test result.
- SMU is not found; name: *A*
- Smu Zero Cancel function is not supported.
  
  Offset current cancel function is not supported.
Remote Control Interface
Error Messages

• Working setup is empty.
  Test setup has not been selected.
• Working test setup is not an Application Test.
  This test setup is not application test setup.
• Workspace does not exist; workspace name: A
• Workspace is already open. Close before opening workspace.
• Workspace is not ready.
• There is no workspace.
7 Using EasyEXPERT on External PC
This chapter explains how to run EasyEXPERT on an external PC.

- System Requirements
- To Install EasyEXPERT in External PC
- Before Starting EasyEXPERT
- To Start EasyEXPERT on Your PC
- To Change Execution Mode and GPIB Settings
- Using 4155B/4156B/4155C/4156C
- Using E5260A/E5262A/E5263A/E5270B
- Using B2900A

**NOTE**

About privilege to use EasyEXPERT

The revision 3.2 or later does not require the administrator privilege. However, if the software is updated from a previous revision to the revision 3.2 or later, it still requires the administrator privilege.
System Requirements

Table 7-1 shows the minimum requirements to run the EasyEXPERT software. They are effective as of March 2019. For the latest information, go to www.keysight.com/find/easyexpert.

<table>
<thead>
<tr>
<th>Operating system and service pack</th>
<th>Microsoft Windows Vista Business SP2 or later (32 bit)</th>
<th>Microsoft Windows 7 Professional SP1 or later (32 bit/64 bit)</th>
<th>Microsoft Windows 8.1 Professional or later (32 bit/64 bit)</th>
<th>Microsoft Windows 10 Pro or later (32bit/64bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Vista certified PC</td>
<td>Windows 7 certified PC</td>
<td>Windows 8.1 certified PC</td>
<td>Windows 10 certified PC</td>
</tr>
<tr>
<td>Language</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td></td>
<td></td>
<td></td>
<td>2 GB</td>
</tr>
<tr>
<td>Display</td>
<td></td>
<td></td>
<td></td>
<td>XGA 1024×768 (SXGA 1280×1024 recommended)</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td></td>
<td></td>
<td>1 GB free space on the C drive, 30 GB free space on a drive for test setup/result data storage is recommended.</td>
</tr>
<tr>
<td>.NET Framework</td>
<td></td>
<td></td>
<td></td>
<td>Microsoft .NET Framework 3.5 SP1</td>
</tr>
<tr>
<td>IO Libraries</td>
<td>Keysight IO Libraries Suite 16.2, 16.3, 17.1 update 1 or later (for the Online execution mode)</td>
<td>Keysight IO Libraries Suite 17.1 update 1 or later (for the Online execution mode)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Recommended GPIB Interface

For the GPIB connection of the instrument, use an GPIB interface, Keysight 82350B/C (for PCI bus), Keysight 82351A/B (for PCIe bus), Keysight 82357A/B (USB/GPIB), or National Instrument GPIB-USB-HS. See Table 7-2.

Table 7-2  Recommended GPIB Interface

<table>
<thead>
<tr>
<th>Interface</th>
<th>B1500A</th>
<th>E5270B</th>
<th>E5260A</th>
<th>E5262A</th>
<th>E5263A</th>
<th>B2901A</th>
<th>B2902A</th>
<th>B2911A</th>
<th>B2912A</th>
<th>4155B/C</th>
<th>4156B/C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keysight 82350B/C</td>
<td>PCI</td>
<td>YES a</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keysight 82351A/B</td>
<td>PCIe</td>
<td>YES a</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keysight 82357A/B</td>
<td>USB</td>
<td>YES b</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES b</td>
<td>YES b</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>National Instruments</td>
<td>GPIB-USB-HS</td>
<td>USB</td>
<td>YES b</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td>YES b</td>
<td>YES b</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. A PCI or PCIe card is highly recommended because of stability and speed.
b. USB GPIB interfaces might cause serial poll error intermittently due to the intrinsic communication scheme differences. It is reported that using an even GPIB address sometimes significantly decreases the chance of the error. The NI GPIB-USB-HS is recommended for stability, and the Keysight 82357A/B is recommended for speed.
c. EasyEXPERT software prohibits to set the odd GPIB address to prevent the issue above. If using an odd GPIB address for Keysight 82357A/B, the address is detected and an error occurs when starting up. For NI GPIB-USB-HS, note that an odd address is not checked when starting up.
.NET Framework

As shown in Table 7-1, the Microsoft .NET 3.5 Framework SP1 is required for the EasyEXPERT software.

Before installing the EasyEXPERT software, make sure that the Microsoft .NET Framework is installed and activated. On Windows 8.1 or later, it is not installed as default. Follow the procedure below if it is not installed.

- Installation through Internet:
  1. Click [Control Panel] > [Programs] > [Turn Windows features on or off].
  2. Check the “.Net 3.5 framework” box, and then click “OK”.
  3. Reboot the PC.
- Installation by using the Microsoft Windows DVD:
  1. Insert the media to the DVD drive.
  2. Go to the below folder:
     E:\sources\sxs (in the case DVD drive is set to “E” drive)
  3. As the administrator, open the “Command Prompt” window.
  4. From the “Command Prompt” window, type in the following command and press the Enter key.
     Dism.exe /online /enable-feature /featurename:NetFX3 /All /Source:E:\sources\sxs /LimitAccess

IO Library

As shown in Table 7-1, the Keysight IO Libraries Suite is required for the EasyEXPERT software. You can download a proper version of the IO Libraries Suite from the Keysight website (http:\\www.keysight.com\).
To Install EasyEXPERT in External PC

- Prepare the EasyEXPERT software installation package.
- Prepare a computer which satisfies the system requirements shown in Table 7-1. For the accurate information for each revision, see README file included in the installation package.
- If you install the EasyEXPERT revision 5.5 or later, prepare the license file for EasyEXPERT.
  
  If you do not have the license file, prepare the Software Entitlement Certificate sheet provided with the option SWS. And get the license file as described in this sheet.
- Install the EasyEXPERT software in your external PC by following the procedure described in the README file.

**NOTE**

To set the same module configuration as B1500

The module configuration of the B1500 can be set to the EasyEXPERT in the offline mode. Copy the following file on the B1500 internal solid state drive (SSD) to the \<user configuration folder> on the PC which the EasyEXPERT runs.

For B1500A: \<offline configuration folder>\UnitConfigB1500A.xml

For B1505A: \<offline configuration folder>\UnitConfigB1505A.xml
Before Starting EasyEXPERT

Note the following when you use EasyEXPERT on your PC.

- When using the Offline mode, use the data import/export function to transfer your test setup data files and test result records.

- When using the Online mode, do not send a control command to the instrument (B1500A, B1505A or other supported model) by using a programming environment except for EasyEXPERT.

- Do not send a control command to the analyzer by using the GPIB IO statement in the application test definitions.

- To control the B1500 from the external PC, exit EasyEXPERT on the B1500. The Start EasyEXPERT window (button) must be displayed or be minimized to the Windows task bar on the B1500 screen.
**To Start EasyEXPERT on Your PC**

To launch EasyEXPERT on your PC, follow the procedure below.

1. Click Start > All Programs > Keysight EasyEXPERT > EasyEXPERT.

2. If the Execution Mode dialog box is not opened, click Option > Execution Mode on the Start EasyEXPERT window.

3. On the Execution Mode dialog box, select the execution mode, Online or Offline. If you select the Online mode, set the GPIB configuration. See *EasyEXPERT User’s Guide Vol. 1* for more detail on the Execution Mode dialog box.

4. Click the OK button on the Execution Mode dialog box.

5. Click the Start EasyEXPERT button to launch EasyEXPERT.
To Change Execution Mode and GPIB Settings

To change the EasyEXPERT execution mode or the GPIB configuration, follow the procedure below.

1. Launch Start EasyEXPERT.
   
   If the Execution Mode dialog box is not opened, click Option > Execution Mode on the Start EasyEXPERT window.

   If EasyEXPERT is running, exit it. And click Option > Execution Mode on the Start EasyEXPERT window.

2. Select the execution mode, Online or Offline.
   
   If you select the Online mode, set the GPIB configuration. See EasyEXPERT User’s Guide Vol.1 for more detail on the Execution Mode dialog box.

3. Click the OK button to set the changes.
   
   Click the Cancel button to cancel the setup changes.
Using 4155B/4156B/4155C/4156C

This section describes the notices for controlling the 4155/4156.

### 4155/4156 Firmware Revision

4155/4156 firmware revision supported by the EasyEXPERT
- HOSTC: 03.08 or later
- SMUC: 04.08 or later

### 4155/4156 Functions

4155/4156 functions unsupported by the EasyEXPERT
- Log sampling measurement and Thinned out sampling measurement
- Functions using R Box
- Differential voltage measurement using VMU (Voltage Monitor Unit)
- DC bias output using PGU (Pulse Generator Unit)
- Other functions unavailable for the B1500

### EasyEXPERT

Classic tests available for 4155/4156
- I/V Sweep, I/V-t Sampling, and Switching Matrix Control for 4155C/4156C
- I/V Sweep and Switching Matrix Control for 4155B/4156B

EasyEXPERT functions unavailable for 4155/4156
- Tracer Test
- Functions using SMU Series Resistor
- Functions using ASU (Atto Sense Unit)
- Functions using SCUU (SMU CMU Unify Unit)
- Functions using CMU (Capacitance Measurement Unit)
- Functions using SPGU (Semiconductor Pulse Generator Unit)

PGU can be used instead of SPGU for the I/V Sweep and I/V-t Sampling classic tests. The Load Z function and the ALWG output are not supported. The Output Impedance dialog box is available to set the output impedance of the PGU.
- Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and RSU (Remote-sense and Switch Unit)
**Calibration**

Differences on Calibration window
- Calibration window provides Module Self Calibration screen only.
- Module Self Calibration screen provides Enable Auto Calibration only.

**Configuration, Main Frame**

Differences on Configuration window Main Frame screen
- Line Frequency just displays the setting of 4155/4156.
- Firmware Rev. displays as follows.
  
  `[HOSTC Rev.]:[SMUC Rev.]:[ADC Rev.]`

- Main Frame Diagnosis is not supplied.

**Configuration, Module**

Differences on Configuration window Module screen
- Self-test cannot be performed.
- Status, SCUU, and Notes columns are not supplied.
- Start Self Test and Recover Module buttons are not supplied.
- Accessory Configuration is not supplied.

**I/V Sweep**

Differences on I/V Sweep Classic Test
- Time Stamp Name field is not supplied for 4155B/4156B.
- Number of sweep steps must be 1 to 1001 for VAR1.
- SMU Pulse Period and Width value must satisfy `Period ≥ Width + 4 ms`.

**I/V-t Sampling**

Differences on I/V-t Sampling Classic Test
- Log sampling is not supported.
- Sampling interval must be 60 μs to 65.535 s.
- Number of samples must be 1 to 10001.
- Base hold time must be 0 sec.

**ADC and Integration Time**

Differences on A/D Converter & Integration Time Setup
- ADC always shows HR ADC.
- High Resolution ADC is set as shown in Table 7-3.
  
  Integration Time is ignored for the sampling measurement of Interval < 2 ms.
Using EasyEXPERT on External PC
Using 4155B/4156B/4155C/4156C

Advanced Setup

Differences on Advanced Setup

- Series R always shows NONE.
- Wait Time Control is not supplied.

Table 7-3 Setting of High Resolution ADC

<table>
<thead>
<tr>
<th>Mode</th>
<th>Factor</th>
<th>Setting of 4155/4156</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>–</td>
<td>MEDIUM</td>
</tr>
<tr>
<td>MANUAL</td>
<td>(1 \leq N \leq 127)</td>
<td>SHORT, TIME=80 (\mu s \times N)</td>
</tr>
<tr>
<td>PLC</td>
<td>1</td>
<td>MEDIUM</td>
</tr>
<tr>
<td>(N \geq 2)</td>
<td></td>
<td>LONG, NPLC=(N)</td>
</tr>
</tbody>
</table>

NOTE

To reuse the test setup for B1500A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition *Set Analyzer*=`B1500A`.
2. Export the test setups to be reused. And exit EasyEXPERT.
3. Launch EasyEXPERT with the condition *Set Analyzer*=4155B, 4156B, 4155C, or 4156C.
4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse the test setup created for the 4155/4156.
Using E5260A/E5262A/E5263A/E5270B

This section describes the notices for controlling the E5260A/E5262A/E5263A/E5270B.

**Firmware Revision**
- B.01.10 or later

**EasyEXPERT**
- Classic tests available for E5260A/E5262A/E5263A/E5270B
  - I/V Sweep, Multi Channel I/V Sweep, I/V List Sweep, and Switching Matrix
- EasyEXPERT functions unavailable for E5260A/E5262A/E5263A/E5270B
  - I/V-t Sampling
  - Direct Control
  - Tracer Test
  - Functions using SCUU (SMU CMU Unify Unit)
  - Functions using CMU (Capacitance Measurement Unit)
  - Functions using SPGU (Semiconductor Pulse Generator Unit)
  - Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and RSU (Remote-sense and Switch Unit)

**Calibration**
- Differences on Calibration window
  - Calibration window provides Module Self Calibration screen only.
  - Module Self Calibration screen provides Enable Auto Calibration only.

**Configuration, Main Frame**
- Differences on Configuration window Main Frame screen
  - Line Frequency just displays the setting of E5260A/E5262A/E5263A/E5270B.
  - Main Frame Diagnosis is not supplied.

**Configuration, Module**
- Differences on Configuration window Module screen
  - Self-test cannot be performed.
  - Status, SCUU, and Notes columns are not supplied.
• Start Self Test and Recover Module buttons are not supplied.
• Accessory Configuration is not supplied.

I/V Sweep

Differences on I/V Sweep Classic Test
• Time Stamp Name field is not supplied for E5260A/E5262A/E5263A/E5270B.
• Number of sweep steps must be 1 to 1001 for VAR1.
• SMU Pulse Period and Width value must satisfy as:
  • Period ≥ Width + 2 ms. (for width ≤ 100 ms)
  • Period ≥ Width + 10 ms. (for width > 100 ms)

NOTE

To reuse the test setup for B1500A
Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit EasyEXPERT.
3. Launch EasyEXPERT with the condition Set Analyzer=E5260A, E5262A, E5263A, or E5270B.
4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse the test setup created for the E5260A/E5262A/E5263A/E5270B.
Using B2900A

This section describes the notices for controlling the B2900A.

**NOTE**

**Using Multiple B2900A Units**

To use the multiple B2900A units (maximum 4 units), each of the multiple B2900A units are connected together by using the N1294A opt.032 Digital I/O Trigger Cable for Multiple Unit Control. This cable has one connector for a master unit and three connectors for slave units. The connector for a master unit is stacking connector also for general use such as interlock connection. Use only one cable for master/slave connections.

1. Connect the Master connector of trigger cable to the Digital I/O terminal of Master B2900A.
2. Connect the Slave connector of trigger cable to the Digital I/O terminal of Slave B2900A.
   - If the multiple slave units are configured, connect all slave units.
3. Connect all B2900 units to your PC using GPIB cables.
4. Launch EasyEXPERT.
5. Select Options > Execution Mode... on the Start EasyEXPERT window to open the Execution Mode dialog box, and set up VISA interface ID of GPIB interface installed in your computer and GPIB addresses on multiple B2900A units. See “Recommended GPIB Interface”.

[Diagram showing connectivity and configuration example of 3 units]
Using EasyEXPERT on External PC
Using B2900A

**EasyEXPERT**

The following EasyEXPERT functions are available for B2900A

- I/V Sweep, Multi Channel I/V Sweep, I/V List Sweep, I/V-t Sampling, and Switching Matrix
- Tracer Test

EasyEXPERT functions unavailable for B2900A

- Direct Control
- Functions using SCUU (SMU CMU Unify Unit)
- Functions using CMU (Capacitance Measurement Unit)
- Functions using SPGU (Semiconductor Pulse Generator Unit)
- Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and RSU (Remote-sense and Switch Unit)

**Calibration**

Differences on Calibration window

- Calibration window provides Module Self Calibration screen only.
- Module Self Calibration screen does not provide Full Range Calibration and Enable Auto Calibration.

**Configuration, Main Frame**

Differences on Configuration window Main Frame screen

- If the multiple B2900A configuration, the information of master B2900A is displayed on Main Frame screen. The information of all B2900As are displayed at the bottom of the window.
- If you change the Line Frequency setting, the line frequency of all B2900As are changed.
- The diagnosis function for the trigger cable is provided on B2900A Diagnosis.

**Configuration, Modules**

Differences on Configuration window Module screen

- SCUU is not supported but the SCUU column exists.
- Recover Module button is not supplied.
- Accessory Configuration is not supplied.
## I/V Sweep, Multi-Channel I/V Sweep

Differences on I/V Sweep and Multi-Channel Classic Test

- Differences on Channel Definition

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>B2901A</td>
</tr>
<tr>
<td></td>
<td>B2902A</td>
</tr>
<tr>
<td></td>
<td>B2911A</td>
</tr>
<tr>
<td></td>
<td>B2912A</td>
</tr>
<tr>
<td>Model</td>
<td>V/I/VPULSE/IPULSE</td>
</tr>
<tr>
<td>Function</td>
<td>VAR1/VAR2/CONST</td>
</tr>
</tbody>
</table>

- Differences on Measurement

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear/Log</td>
<td>LINEAR/LOG10</td>
</tr>
<tr>
<td>No. of Steps</td>
<td>VAR1 1 to 2500</td>
</tr>
<tr>
<td></td>
<td>VAR2 1 to 1001</td>
</tr>
<tr>
<td>Power Compliance</td>
<td>Unsupported</td>
</tr>
<tr>
<td>SMU Pulse: Base</td>
<td>Supports DC region</td>
</tr>
<tr>
<td>SMU Pulse: Period</td>
<td>50 μs to 100000 s</td>
</tr>
<tr>
<td>SMU Pulse: Width</td>
<td>50 μs to 99999.9 s</td>
</tr>
<tr>
<td>Timing: Hold</td>
<td>0 to 100000 s</td>
</tr>
<tr>
<td>Timing: Delay</td>
<td>0 to 100000 s</td>
</tr>
<tr>
<td></td>
<td>If Pulse measurement, calculated as follows:</td>
</tr>
<tr>
<td></td>
<td>Delay = Pulse end time − Integration Time (minimum value:0)</td>
</tr>
<tr>
<td></td>
<td>If Integration Time: Mode is AUTO, Integration Time=2 ms</td>
</tr>
<tr>
<td>Sweep status</td>
<td>The output switch is OFF when the sweep is aborted.</td>
</tr>
</tbody>
</table>
Using EasyEXPERT on External PC
Using B2900A

### I/V List Sweep

Differences on I/V List Classic Test.

Same as I/V Sweep Classic Test except the followings.

- Differences on Measurement

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/D Converter Integration Setup</td>
<td>A/D Converter (HS ADC only)</td>
</tr>
<tr>
<td>Integration Time Setup</td>
<td>AUTO: 0.1 PLC or 1 PLC MANUAL: 1 to 40000 (1 Factor=50 μs) PLC: 1 to 100</td>
</tr>
<tr>
<td>Advanced Setup: Channel Settings</td>
<td>Series R is unavailable</td>
</tr>
<tr>
<td>Low Terminal</td>
<td>Low terminal setting. GROUNDED/FLOATING</td>
</tr>
<tr>
<td>High Cap.</td>
<td>High capacitance mode setting. ON/OFF</td>
</tr>
<tr>
<td>Advanced Setup: Wait Time Control</td>
<td>State (ON/OFF)</td>
</tr>
<tr>
<td>Factor</td>
<td>0 to 100</td>
</tr>
<tr>
<td>Advanced Setup: After Measurement Settings</td>
<td>Output value after measurement (START/STOP)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Length</td>
<td>VAR1 1 to 1001</td>
</tr>
<tr>
<td>VAR2</td>
<td>1 to 1001</td>
</tr>
</tbody>
</table>
I/V-t Sampling

Differences on I/V-t Sampling Classic Test.

- Differences on Channel Definition

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>B2901A</td>
</tr>
<tr>
<td></td>
<td>SMUn.B290X</td>
</tr>
<tr>
<td></td>
<td>B2902A</td>
</tr>
<tr>
<td></td>
<td>B2911A</td>
</tr>
<tr>
<td></td>
<td>SMUn.B291X</td>
</tr>
<tr>
<td>Mode</td>
<td>V/I</td>
</tr>
</tbody>
</table>

- Differences on Measurement

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear/Log</td>
<td>LINEAR only</td>
</tr>
<tr>
<td>Interval</td>
<td>10 μs to 100000 s</td>
</tr>
<tr>
<td></td>
<td>If SMUn.B290X exists, the setting of 20 μs or below is set to 20 μs.</td>
</tr>
<tr>
<td>No. of Samples</td>
<td>1 to 100000 (Total of all measurement channels)</td>
</tr>
<tr>
<td>Hold Time</td>
<td>0 to 100000 s</td>
</tr>
<tr>
<td>Base Hold Time</td>
<td>0 to 100000 s</td>
</tr>
<tr>
<td>A/D Converter</td>
<td>A/D Converter</td>
</tr>
<tr>
<td>Integration Setup</td>
<td>HS ADC only</td>
</tr>
<tr>
<td>Integration Time Setup</td>
<td>AUTO: 0.1 PLC or 1 PLC</td>
</tr>
<tr>
<td></td>
<td>MANUAL: 1 to 40000 (1 Factor=50 μs)</td>
</tr>
<tr>
<td></td>
<td>PLC: 1 to 100</td>
</tr>
<tr>
<td>Advanced Setup: Channel Settings</td>
<td>Series R is not available</td>
</tr>
<tr>
<td>Low Terminal</td>
<td>Low terminal setting.</td>
</tr>
<tr>
<td></td>
<td>GROUNDED/FLOATING</td>
</tr>
<tr>
<td>High Cap.</td>
<td>High capacitance mode setting. ON/OFF</td>
</tr>
</tbody>
</table>
## Using EasyEXPERT on External PC

### Using B2900A

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Setup: Wait Time Control</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td>ON/OFF</td>
</tr>
<tr>
<td></td>
<td>Factor</td>
</tr>
<tr>
<td></td>
<td>0 to 100</td>
</tr>
<tr>
<td>Advanced Setup: After Measurement</td>
<td>Output value after</td>
</tr>
<tr>
<td></td>
<td>measurement</td>
</tr>
<tr>
<td></td>
<td>START only</td>
</tr>
</tbody>
</table>

### Tracer Test

**Differences on Tracer Test**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR1</td>
<td>No. of Steps 1 to 2500</td>
</tr>
<tr>
<td></td>
<td>Power Comp. unsupported</td>
</tr>
<tr>
<td></td>
<td>Pulse Delay 0 s to 99999.9 s</td>
</tr>
<tr>
<td></td>
<td>Pulse Width 50 μs to 100000 s</td>
</tr>
<tr>
<td></td>
<td>Hold Time 0 s to 100000 s</td>
</tr>
<tr>
<td>VAR2</td>
<td>No. of Steps 1 to 2500</td>
</tr>
<tr>
<td></td>
<td>Power Comp. unsupported</td>
</tr>
<tr>
<td></td>
<td>Hold Time 0 s to 100000 s</td>
</tr>
<tr>
<td>Meas. Delay</td>
<td>2 μs to 4.99 s</td>
</tr>
<tr>
<td>Meas. Time</td>
<td>8 μs to 20 ms</td>
</tr>
<tr>
<td>Step Time</td>
<td>500 μs to 5 s</td>
</tr>
<tr>
<td>Pulse Period</td>
<td>5 ms to 5 s</td>
</tr>
</tbody>
</table>
NOTE

To reuse the test setup for B1500A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit EasyEXPERT.
3. Launch EasyEXPERT with the condition Set Analyzer=B2901A, B2902A, B2911A, or B2912A.
4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse the test setup created for the B2901A/B2902A/B2911A/B2912A.
Using EasyEXPERT on External PC
Using B2900A
Utilities

This chapter introduces the utility programs included in Keysight B1500 and EasyEXPERT.

- “System Requirement”
- “License Management Tool”
- “Setup File Converter”
- “MDM File Converter”
- “Utility Programs”

**NOTE**
The following conventions are used in this chapter.

- For Windows 7/8.1/10 64 bit version
  
  <program folder>: <system drive>:\Program Files (x86)
  
  <offline configuration folder>: <system drive>:\ProgramData\Agilent\EasyEXPERT\Service\OfflineConfiguration
  
  <user configuration folder>: <system drive>:\Users\<your account>\AppData\Roaming\Agilent\EasyEXPERT\Service\OfflineConfiguration

- For Windows Vista, 7/8.1/10 32 bit version
  
  <program folder>: <system drive>:\Program Files
  
  <offline configuration folder>: <system drive>:\ProgramData\Agilent\EasyEXPERT\Service\OfflineConfiguration
  
  <user configuration folder>: <system drive>:\Users\<your account>\AppData\Roaming\Agilent\EasyEXPERT\Service\OfflineConfiguration

- For Windows XP
  
  <program folder>: <system drive>:\Program Files
  
  <offline configuration folder>: <system drive>:\Documents and Settings\All Users\Application Data\Agilent\EasyEXPERT\Service\OfflineConfiguration
  
  <user configuration folder>: <system drive>:\Documents and Settings\All Users\Application Data\Agilent\EasyEXPERT\Service\OfflineConfiguration

  <system drive>: Drive the EasyEXPERT has been installed
  
  <your account>: Your Windows login account
System Requirement

Table 8-1 shows the minimum requirements to run the EasyEXPERT software and the programs furnished with the B1500. They are effective as of March 2019. For the latest information, go to www.keysight.com/find/easyexpert.

<table>
<thead>
<tr>
<th>Table 8-1</th>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system and service pack</strong></td>
<td>Microsoft Windows Vista Business SP2 or later (32 bit)</td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td>Vista certified PC</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>English (US)</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>2 GB</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>XGA 1024×768 (SXGA 1280×1024 recommended)</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>1 GB free space on the C drive, 30 GB free space on a drive for test setup/result data storage is recommended.</td>
</tr>
<tr>
<td><strong>.NET Framework</strong></td>
<td>Microsoft .NET Framework 3.5 SP1</td>
</tr>
<tr>
<td><strong>IO Libraries</strong></td>
<td>Keysight IO Libraries Suite 16.2, 16.3, 17.1 update 1 or later (for the Online execution mode)</td>
</tr>
</tbody>
</table>
License Management Tool

The licence management tool is the program used to install the license of the software listed below. This program is also used to confirm the licenses already installed and the host ID of the B1500 or the computer for EasyEXPERT.

- B1500A-SWS EasyEXPERT Extension
- B1500AU-SWS EasyEXPERT Extension
- B1505A-SWS EasyEXPERT Extension
- B1505AU-SWS EasyEXPERT Extension
- B1506A-SWS EasyEXPERT Extension
- B1507A-SWS EasyEXPERT Extension
- B2901AU EasyEXPERT Extension
- B2902AU EasyEXPERT Extension
- B2911AU EasyEXPERT Extension
- B2912AU EasyEXPERT Extension
- E5260A-SWS EasyEXPERT Extension
- E5260AU-SWS EasyEXPERT Extension
- E5270B-SWS EasyEXPERT Extension
- E5270BU-SWS EasyEXPERT Extension

**To launch program**  
Click Start > All Programs > (Keysight EasyEXPERT >) Licence Management Tool.

**To check licenses already installed**  
Click Installed Licenses tab on the Licence Management Tool. The installed licenses will be displayed.

**To check host ID**  
Click Information tab on the Licence Management Tool. The host ID of the B1500 or the computer will be displayed.
To install license

The following procedure installs the license.

1. Click Install icon, or click File > Install License File to open a dialog box.
2. Specify the license file (.lic file).
3. Click Open.

License Management Tool GUI

File menu
- Install License File
  Opens a dialog box used to specify the license file.
- Exit
  Closes the License Management Tool.

Help menu
- About
  Opens the About dialog box.

Install icon
Opens a dialog box used to specify the license file.

Installed Licenses
Displays the license already installed.

Information tab
Displays the host ID of the B1500 or the computer for EasyEXPERT.
Utilities
Setup File Converter

**Setup File Converter**

The setup file converter is the program which converts the Keysight 4155A/4156A/4155B/4156B/4155C/4156C setup file (extension: DAT or MES) and creates the EasyEXPERT setup file (extension: XTS). This program can convert the setup information but cannot convert the test result data.

**Execution environment**

EasyEXPERT execution environment

To execute this program, the SetupFileConverter.exe, SetupFileConverterW.exe, and SetupFileConverterW.exe.config files must be stored in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\

**To launch program**

Click Start > All Programs > Agilent B1500A EasyEXPERT > 4155,4156 Setup File Converter.

**To create XTS file**

The following procedure converts the 4155/4156 setup file (.DAT or .MES) and creates the .XTS file in the folder the setup file is stored.

1. Click Select icon, or click File > Select Files to open the Select 4155/4156 MES Files or DAT Files dialog box.
2. Specify the 4155/4156 setup file to convert. Multiple files can be selected.
3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.
4. Click Convert icon, or click File > Convert Files.

Instead of the step 1 to 3, you can use the drag and drop operation from Explorer to the Selected Files area on the Setup File Converter.

**To read XTS file**

Use the import function to read the created .XTS file on the EasyEXPERT.

Open the Import Test Setup window by clicking File > Import Test Setup... on the Classic Test screen. Specify the .XTS file to be imported, and click Open.

**Conversion results**

For details about the conversion results, see “SetupFileConverter.exe” on page 8-24.
# Setup File Converter GUI

The setup file converter provides the following GUI.

<table>
<thead>
<tr>
<th>File menu</th>
<th>Select Files</th>
<th>Opens the Select 4155/4156 MES Files or DAT Files dialog box used to specify the 4155/4156 setup files to convert.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Convert Files</td>
<td>Performs conversion and creates XTS file. This program overwrites the file of the same name.</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td>Clears the Selected Files area and the Log area.</td>
</tr>
<tr>
<td></td>
<td>Quit</td>
<td>Closes the setup file converter.</td>
</tr>
<tr>
<td>Help menu</td>
<td>About</td>
<td>Opens the About dialog box.</td>
</tr>
<tr>
<td>Icons</td>
<td>Select</td>
<td>Opens the Select 4155/4156 MES Files or DAT Files dialog box used for specifying the 4155/4156 setup files to convert.</td>
</tr>
<tr>
<td></td>
<td>Convert</td>
<td>Performs conversion and creates XTS file. This program overwrites the file of the same name.</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td>Clears the Selected Files area and the Log area.</td>
</tr>
<tr>
<td>Create XTS for</td>
<td>B1500A</td>
<td>XTS file for the B1500</td>
</tr>
<tr>
<td></td>
<td>4155B/C</td>
<td>XTS file for the 4155A/B/C</td>
</tr>
<tr>
<td></td>
<td>4155B/C with HPSMU</td>
<td>XTS file for the 4155A/B/C. The HPSMU in the MES/DAT file is converted to SMU5: HP.</td>
</tr>
<tr>
<td></td>
<td>4156B/C</td>
<td>XTS file for the 4156A/B/C</td>
</tr>
<tr>
<td></td>
<td>4156B/C with HPSMU</td>
<td>XTS file for the 4155A/B/C. The HPSMU in the MES/DAT file is converted to SMU5: HP.</td>
</tr>
<tr>
<td>Selected Files</td>
<td></td>
<td>Lists the 4155/4156 setup files to convert. Drag and drop operation is allowed.</td>
</tr>
<tr>
<td>Log</td>
<td></td>
<td>Displays the execution log.</td>
</tr>
</tbody>
</table>
MDM File Converter

The MDM file converter is the program which converts the EasyEXPERT test result data file (extension: xtr or ztr) and creates the Keysight IC-CAP model data manager file (extension: mdm).

Supported data
The MDM file converter supports the test result data of the following Classic Tests.

- I/V Sweep
- Multi Channel I/V Sweep
- C-V Sweep

The Application Test result data is not supported.

Execution environment
EasyEXPERT execution environment

To execute this program, the MdmFileConverter.exe and MdmFileConverterW.exe files must be stored in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support\MDM\n
To launch program
Click Start > All Programs > Agilent B1500A EasyEXPERT > IC-CAP MDM File Converter.

To create MDM file
The following procedure converts the xtr/ztr file and creates the mdm file with the same name as the xtr/ztr file in the folder which the xtr/ztr file has been stored.

1. Click Browse... to open the Please select Test Result File dialog box.
2. Select the xtr/ztr file to convert. Multiple files can be selected.
3. Click Convert, or click Action > Convert.

Instead of the step 1 to 2, you can use the drag and drop operation from Explorer to the Input Files area on the MDM file converter.

NOTE
If a mdm file of the same name already exists, “(N)” is added to the file name. For example, if the abc.mdm file already exists when converting the abc.xtr file, the abc(1).mdm file is created.
MDM File Converter GUI

The MDM file converter provides the following GUI.

**File menu**

**Exit**
Closes the MDM file converter.

**Action menu**

**Convert**
Performs conversion of the files listed in Input Files and creates mdm files.

**Help menu**

**About**
Opens the About dialog box.

**Input Files**

Lists the xtr/ztr file.

**Browse...**
Opens the Please select Test Result File dialog box used for selecting the xtr/ztr files to convert. The selected files are listed in Input Files.

**Remove**
Removes the highlighted files from Input Files.

**Convert**
Performs conversion of the files listed in Input Files and creates mdm files.

**Cancel**
Cancels the file conversion.

**Options**

The following optional functions are available.

- **Append Test Setup Title to Mdm File Name**
  Check this box if you want to append the test setup title to the mdm file name. If the xtr/ztr file name is “abc” and the test setup title is “title”, the mdm file name will be “abc-title”.

- **Specified Output Folder**
  Check this box if you want to specify the folder used for storing the mdm files which are the conversion results. This enables the entry field and the Browse... button. The folder can be specified by entering a folder name to this field directly or by selecting a folder on the dialog box opened by clicking the Browse... button.

**Log**
Displays the execution log.
Utility Programs

The following useful programs are stored in the following folder. Remember that they are just sample programs.

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\

- “User Account Management Tool”
- “Offline Configuration Tool”
- “Software Configuration Tool”
- “Prober Control”
- “sleep.exe”
- “XSLT”

<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\

- “SetupFileConverter.exe”

<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support\MDM\

- “MdmFileConverter.exe”

User Account Management Tool

User Account Management Tool sets the passwords to the user level of the EasyEXPERT and assigns the user level of the EasyEXPERT to the Windows accounts.

To launch program

Click Start > All Programs > Keysight EasyEXPERT > Tools > User Account Management.

NOTE

This program requires administrator privileges.

For details, see “User Level Setting” section in EasyEXPERT User’s Guide Vol.1.
Offline Configuration Tool

Offline Configuration Tool sets the configuration of B1500 or E5270B for the offline mode.

To launch program
Click Start > All Programs > Keysight EasyEXPERT > Tools > Offline Configuration.

Offline Configuration Tool provides the following GUI.

File menu
- **New**  Creates new offline configuration.
- **Load**  Loads the offline configuration file. You can select Common for all user or User for personal.
- **Import**  Import the offline configuration from the exported offline configuration file (Arbitrary file) or the instrument (from Equipment).
- **Save**  Saves the current configuration to the file. You can select As Common for all user or As User for personal use.
- **Export**  Exports the current configuration as the offline configuration file with the specified name.
- **Delete**  Deletes the configuration file.
- **Exit**  Closes the Offline Configuration Tool.

Modules
- **Slot**  Slot number
- **Module Type**  Selects the module in the corresponding slot.
- **Name**  Module name.

Main Frame
Shows the information of the mainframe.
Software Configuration Tool

Software Configuration Tool sets the auto start programs at Windows startup.

To launch program

Click Start > All Programs > Keysight EasyEXPERT > Tools > Software Configuration.

NOTE

This program requires administrator privileges.

Software Configuration Tool provides the following GUI.

File menu

Exit

Closes Software Configuration Tool.

Edit menu

Cancel all

Clears all programs in the Startup Programs.

Reset to the factory default

Resets to the setting at factory shipment.

Startup

The programs listed in the Startup Programs will automatically start at Windows startup.

1. Selects the program to auto start from the Programs.

2. Click the right-arrow to move the selected program to the Startup Programs.

3. To delete the program in the Startup Programs, select it and click Delete button.
**Prober Control**

The `<program folder>\Agilent\B1500\EasyEXPERT\Utilities\ProberControl` folder stores the execution files used to control the following probers.

- Cascade Microtech Summit 12000/S300 (Nucleus)
- Cascade Microtech (Suss MicroTec) PA200 or PA300
- Vector Semiconductor VX-2000 or VX-3000

You can use the execution files when you perform a repeat measurement by using EasyEXPERT and a prober listed above. The execution files control the prober chuck movement (down, move, and up) by defining them in the Repeat Measurement Setup window. See “Remote Measurement Setup” in Chapter 1, User’s Guide Vol. 1.

This folder also stores the source files and the document files. See the pdf files in the ProberControl\xxxx\doc folder for more details or if you create your own prober control script by referring to the source code; xxxx is cascade, suss, or vector.

And also, the prober information file “prober_info.ini” is stored in the `<AllUsersProfile>\Agilent\EasyEXPERT\Utilities\ProberControl` folder, where `<AllUsersProfile>` is C:\Documents and Settings\All Users on Windows XP and C:\Program Data on Windows Vista/7/8.1/10. For details, see “Prober_info.ini”.

See the following sections for how to use the prober control script.

**Prober Control Script**

Prober control script is sample program used for semi-automatic prober control. The EasyEXPERT can call the script by using the Repeat Measurement Setup window.

- See “Repeat Measurements” to call the script and perform repeat measurement.
- See “Prober_info.ini” for the prober information file.

The prober control script can be used for Start Procedure, After Measurement Procedure, and Final Procedure on the Repeat Measurement Setup dialog box. And use the Subsite move test setup in your quick test to control sub die move. The Subsite move setup uses the subsite procedure for moving wafer chuck to the next subsite. See “Subsite_xxxx.exe”, “Subsite move Test Setup”, and “To Use Subsite move”.
Repeat Measurements

Figure 8-1 Flow of Repeat Measurement Setup

The repeat measurement is performed as shown in this flowchart. The status is a response returned by each procedure. The Count is the accumulated number of test executions. They are the stop condition of the repeat measurement.

The repeat measurement stop function is enabled by the following check boxes.

- Counter reaching to
- Procedure return condition

If the first box is checked and the limit value is specified, the repeat measurement will be stopped if Count >= limit. To perform the repeat measurement, set the limit value more than the number of devices under test or remove check from this box.

If the second box is checked, the repeat measurement will be stopped if status = True.
When the second box is checked, the device ID automatic setup function is available and is enabled/disabled by using the following check box. The function enters the device_id value to the Device ID of the test result record. The device_id is a response returned by each procedure.

• Automatically fill in Device ID

The Repeat Measurement Setup dialog box provides the following action buttons.

Run: Starts repeat measurement.

Abort: Stops repeat measurement immediately.

Cancel: Closes the Repeat Measurement Setup dialog box.

Start/Before Measurement/After Measurement/Abort/Final Procedure:
Enter the full path name of the procedure. For example, enter as follows.

C:\Program Files\Agilent\B1500\EasyEXPERT\Utilities\ProberControl\suss\Start_suss.exe

Arguments:
Enter the options of the procedure. See the following sections for the options. For example, enter as follows.

–a GPIB0::5::INSTR –l C:\temp\prb.log

If you use the subsite procedure, the flowchart must be changed below.

Replace the box A shown in Figure 8-1 with the block A shown as follows.

![Flowchart](image)
**Prober_info.ini**

The prober information file is necessary to execute the prober control script. Before starting tests, open this file, edit it as you want, and overwrite it. The name must be prober_info.ini.

![Figure 8-2 Prober_info.ini](image)

The prober_info.ini file stores the information shown below.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>GPIB address of prober</td>
</tr>
<tr>
<td>LogMode</td>
<td>Log file creation mode; True or False</td>
</tr>
<tr>
<td>LogName</td>
<td>Log file name (full path)</td>
</tr>
<tr>
<td>UseID</td>
<td>Device ID creation mode; True or False</td>
</tr>
<tr>
<td>SubsiteInfo</td>
<td>Set always False. This is just a place holder.</td>
</tr>
<tr>
<td>WaferInfo</td>
<td>Set always False. This is just a place holder.</td>
</tr>
</tbody>
</table>

If the procedures specify the –a option, the Address value is not used.

If the procedures specify the –l option, the LogName value is not used.

To create a log file, set LogMode=True.

To use the prefix:coordinate format for the device_id value, set UseID=True. If UseID=False, the device_id value will be coordinate, not prefix:coordinate. The prefix will be the value entered in the Device ID Entry dialog box that is opened by Start_xxxx.exe. This function is available when the Automatically fill in Device ID check box is checked.
**Start_xxxx.exe**

This script can be used for Start Procedure. It must be specified by the full path name.

**Figure 8-3 Start_xxxx.exe**

- **Arguments:** `-a GPIB_address`  
  `-l log_file_name`

  **Example:**  
  `-a GPIB0::5::INSTR -l C:\temp\prb.log`

- **Response:** XML format data

  ```xml
  <Response>
  <Break>status</Break>
  <Target>device_id</Target>
  </Response>
  ```

  **Example:**  
  ```xml
  <Response>
  <Break>False</Break>
  <Target>wafla:3 1</Target>
  </Response>
  ```

After the repeat measurement is started, this procedure displays the Device ID Entry dialog box and waits for your input. On the dialog box, enter a string used for the prefix of device_id. After that, you will see the Start Confirmation dialog box that is used to confirm your wafer setup status. Load wafer and perform wafer alignment, then click OK on the dialog box. The procedure moves wafer chuck to the first probing position, checks the prober status, gets the X-Y coordinate of the probing position, and sets the wafer chuck to the UP position. At last, the procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat measurement will be stopped if status = True.

The device_id is a string for the Device ID of the test result record. When the Automatically fill in Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed below.
Utilities
Utility Programs

Insert the box B shown as follows to the position B shown in Figure 8-3.

NOTE
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.

**Iterator_xxxx.exe**

This script can be used for After Measurement Procedure. It must be specified by the full path name.

**Figure 8-4**  
Iterator_xxxx.exe

- **Arguments:** `-a GPIB_address -l log_file_name`
  
  **Example:**
  ```
  -a GPIB0::5::INSTR -l C:\temp\prb.log
  ```

- **Response:** XML format data

  ```
  <Response>
  <Break>status</Break>
  <Target>device_id</Target>
  </Response>
  ```

  **status:** True (error) or False  
  **device_id:** prefix:coordinate

  **Example:**
  ```
  <Response>
  <Break>False</Break>
  <Target>waf1a:4 1</Target>
  </Response>
  ```

The procedure is called after the measurement is completed for a die. This procedure sets wafer chuck to the DOWN position, moves it to the next probing position, checks the prober status, gets the X-Y coordinate of the probing position, and sets the wafer chuck to the UP position. At last, the procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat measurement will be stopped if status = True.
The device_id is a string for the Device ID of the test result record. When the Automatically fill in Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed below.

Insert the box B shown as follows to the position B shown in Figure 8-3.

```
NOTE
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
```

**Final_xxxx.exe**

This script can be used for Final Procedure. It must be specified by the full path name.

**Figure 8-5**

**Final_xxxx.exe**

- Arguments: -a GPIB_address
  -l log_file_name

  Example:
  -a GPIB0::5::INSTR -l C:¥temp¥prb.log

- Response: none

The procedure is called after one of the stop condition is detected. This procedure sets wafer chuck to the DOWN position.
NOTE
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.

Subsite xxxx.exe
To realize sub die move operation, you need to define Subsite xxxx.exe in your test definition and create your application test setup. However, you do not need to take care of this procedure by using the Subsite move test setup included in the application library. The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the prober, and sets it to the Device ID of the test result record.

Figure 8-6 Subsite xxxx.exe

- Arguments: -a GPIB_address
  -l log_file_name
  Example:
  –a GPIB0::5::INSTR –l C:\temp\prb.log
- Response: XML format data
  Example:
  <Response>
  <Break>status</Break>
  <Target>device_id</Target>
  </Response>
  status: True (error) or False
  device_id: prefix:coordinate
  Example:
  <Response>
  <Break>False</Break>
  <Target>waf1a:3 1</Target>
  </Response>

Open the Subsite move test setup and save it as a setup in your preset group (My Favorite Setup). Then you can use the setup for your quick test.

NOTE
To use the Subsite move setup, set the GPIB address and log file name in the prober_info.ini. And ignore the Arguments for Subsite xxxx.exe.

NOTE
If you use a Suss prober, the number of Subsite move setups used in your quick test (die test) is important. It must be N-1; N is the number of subsites defined in the prober.
The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat measurement will be stopped if status = True.

The device_id is a string for the Device ID of the test result record.

**Subsite move Test Setup**

Click Application Test tab and open the Subsite move test setup in the Utility category. On the Subsite move setup screen, specify ProberType (Cascade, Suss, or Vector) or driver for your prober in CustomerProber, and save it as a setup in your preset group (My Favorite Setup). Then you can use the setup for your quick test. See “To Use Subsite move”.

![Figure 8-7 Subsite move Test Setup](image)

The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the prober, and sets it to the Device ID of the test result record.

For more details of the test setup, open the Test Definition window.
Utilities
Utility Programs

In the Subsite move test definition, an execution file callProbeDvr.exe is used. This file is used to send Subsite_xxxx.exe to the prober specified by the prober_info.ini file and receive the response; status and device_id. The callProberDvr.exe has the following input/output parameters.

Input: Full path of Subsite_xxxx.exe
Output: status; True (error) or False (no error)
Output: device_id

NOTE
The callProberDvr.exe refers to the prober_info.ini file for the GPIB address and log file name. Do not set the Arguments of Subsite_xxxx.exe.

To Use Subsite move

Figure 8-8 To Use Subsite move
To perform the test with the sub die move operation, do as follows.

1. Add the Subsite move test setup to your preset group (My Favorite setup).
2. Set your preset group and test setups in the Quick Test tab screen.
3. Open the Repeat Measurement Setup dialog box.
4. Specify the procedures and the repeat measurement condition.
5. Start repeat measurement.

The Subsite move setup must be entered after measurements for a sub die.
Utilities
Utility Programs

**SetupFileConverter.exe**

This program is the script version of the setup file converter. This program converts the 4155A/4156A/4155B/4156B/4155C/4156C setup file (.DAT or .MES) and creates the EasyEXPERT setup file (.XTS). This program can convert the setup information but cannot convert the test result data.

**Execution environment**

EasyEXPERT execution environment

**Syntax**

```bash
SetupFileConverter.exe [option] [file]
```

**Parameter**

- `option`: Execution options. See Table 8-2. Multiple options can be set. Both /4155 and /4156 cannot be set for one execution.
- `file`: 4155/4156 setup file name

You can specify multiple files by using a space as the separator. Also wildcard can be used.

If no parameter is specified, the Usage message is displayed.

**Execution examples**

- `C:\415xConvert>SetupFileConverter.exe MOS1.MES`
- `C:\415xConvert>SetupFileConverter.exe MOS*.DAT MOS*.MES`
- `C:\415xConvert>SetupFileConverter.exe /4156 /HP *.MES`

**Table 8-2 Option Parameter**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(no option)</td>
<td>Performs normal operation.</td>
</tr>
<tr>
<td>/4155</td>
<td>Creates the XTS file for the 4155, not for the B1500.</td>
</tr>
<tr>
<td>/4156</td>
<td>Creates the XTS file for the 4156, not for the B1500.</td>
</tr>
<tr>
<td>/HP</td>
<td>Converts HP SMU in the MES/DAT file to SMU5: HP. For creating the XTS file for the 4155/4156.</td>
</tr>
<tr>
<td>/S</td>
<td>Leaves <em>Command Prompt</em> open after execution.</td>
</tr>
</tbody>
</table>
**XTS file creation example 1**

The .XTS file can be created by using *Command Prompt* as shown below.

1. Create your working folder (for example, C:\415xConvert\).
2. Copy the 4155/4156 setup files to convert and the SetupFileConverter.exe file, and paste them to the working folder.
3. Open *Command Prompt*.
4. On *Command Prompt*, execute SetupFileConverter.exe as shown below. This creates the .XTS file in the working folder and displays the message as follows.

   ```
   C:\415xConvert>SetupFileConverter.exe IDVG.MES
   SetupFileConverter.exe : Version A.02.10
   Start Conversion : IDVG.MES
   ExportFile : IDVG.xts
   SetupVersion : HP4155_C03.06
   Conversion successfully completed.
   ```

**XTS file creation example 2**

The .XTS file can be created by using a shortcut on the Desktop. The shortcut should be created by the following conditions.

- Name: SetupFileConverter
- Target file:

  ```
  "<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\SetupFileConverter.exe" /S
  ```

If you want to make the .XTS file for the 4155/4156, insert /4155 or /4156 before /S.
If you want to add /HP option, insert /HP before /S.

1. Create your working folder (for example, C:\415xConvert\).
2. Copy the 4155/4156 setup files to convert, and paste them to the working folder.
3. Drag the files and drop them on the SetupFileConverter icon. This creates the .XTS files in the working folder.

**To read XTS file**

Use the import function to read the created .XTS file on the EasyEXPERT.

Open the Import Test Setup window by clicking File > Import Test Setup... on the Classic Test screen. Specify the .XTS file to be imported, and click Open.
About conversion results

The setup file conversion is not complete. The following are the expected differences. When you use the .XTS file, you will see differences in the operation, performance, measurement result data, and so on.

- Channel number may be changed. For example, the HPSMU channel number is 5 for the 4155/4156 but 1 for the B1500.
- Setup value is changed to the value available for the B1500 and EasyEXPERT.
- Voltage Source and Monitor Unit (two channels of VSU and two channels of VMU) is converted to four channels of MPSMU.
- Pulse Generator Unit (PGU) setup is deleted.
- Unused module information is deleted.
- Functions only for the 4155/4156 are deleted.
- For converting the setup data which satisfies the following two conditions, SMU5 is converted to HPSMU. Else, SMU5 is converted to MPSMU.
  1. SMU6 information is not included in the setup data.
  2. SMU5 information contains the value available only for the HPSMU.

If an inconvertible setup parameter is found during the setup file conversion, a message will be displayed. If an inconvertible setup file is specified, the file conversion is not performed for the file and a message will be displayed.

About conversion results with option /4155 or /4156

If the /4155 or /4156 option is specified, there are the following differences between the conversion results.

- Channel number is not changed.
- Setup value will be changed to the value available for the 4155/4156 and EasyEXPERT.
- VSU/VMU is converted to VSU/VMU respectively.
**MdmFileConverter.exe**

This program is the script version of the MDM file converter. This program converts the EasyEXPERT test result data file (extension: xtr or ztr) and creates the Keysight IC-CAP model data manager file (extension: mdm).

**Execution environment**

EasyEXPERT execution environment

**Syntax**

MdmFileConverter.exe [option] [file]

**Parameter**

*option* : Execution options. See Table 8-3. Multiple options can be set.

*file* : xtr/ztr file name

You can specify multiple files by using a space as the separator. Also wildcard can be used.

If no parameter is specified, the MDM file converter is launched.

**Execution examples**

C:\MdmFileConvert>MdmFileConverter.exe MOS.xtr
C:\MdmFileConvert>MdmFileConverter.exe *.xtr *.ztr
C:\MdmFileConvert>MdmFileConverter.exe /o MOS1 MOS.xtr
C:\MdmFileConvert>MdmFileConverter.exe /d folder1 *.xtr *.ztr

**Table 8-3**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(no option)</td>
<td>Performs normal operation.</td>
</tr>
<tr>
<td>/o outfile</td>
<td>Specifies the mdm file name. Only one xtr/ztr file can be specified.</td>
</tr>
<tr>
<td>/d outfold</td>
<td>Specifies the folder used for storing the mdm files.</td>
</tr>
<tr>
<td>/l log</td>
<td>Specifies the file for recording the conversion log.</td>
</tr>
<tr>
<td>/s</td>
<td>Does not record the conversion log.</td>
</tr>
<tr>
<td>/t</td>
<td>Appends the test setup title to the mdm file name. If the xtr/ztr file name is “abc” and the test setup title is “title”, the mdm file name will be “abc-title”.</td>
</tr>
</tbody>
</table>
The mdm file can be created by using Command Prompt as shown below.

1. Create your working folder (for example, C:\MdmConversion\).

2. Copy the xtr/ztr files to convert and the MdmFileConverter.exe file, and paste them to the working folder.

3. Open Command Prompt.

4. On Command Prompt, execute MdmFileConverter.exe as shown below. This creates the mdm file in the working folder and displays the message as follows.

   C:\MdmConversion>MdmFileConverter.exe Idvd.xtr
   Starting at 2013/03/27 18:11:15
   Reading 'Idvd.xtr' ...
   Converting 'Idvd' ...
   Writing 'Idvd.mdm' ...
   Completed successfully.

The mdm file can be created by using a shortcut on the Desktop. The shortcut should be created by the following conditions.

- Name: MdmFileConverter
- Target file: "<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support \MDM\MdmFileConverter.exe" /t

Add or delete the option as you want. See Table 8-3 for the available options.

1. Create your working folder (for example, C:\MdmConversion\).

2. Copy the xtr/ztr files to convert, and paste them to the working folder.

3. Drag the files and drop them on the MdmFileConverter icon. This creates the mdm files in the working folder.
mdm file name and folder

• Without the /d option, the mdm file is created in the folder which the xtr/ztr file has been stored.

• With the /d option, the mdm file is created in the specified folder.

• Without the /o option, the mdm file name is same as the xtr/ztr file name.
  Example: MdmFileConverter.exe abc.xtr creates the abc.mdm file.

• With the /o option, the mdm file is created with the specified name.
  Example: MdmFileConverter.exe /o xyz abc.xtr creates the xyz.mdm file.

• If the xtr/ztr file includes multiple test data, “(N)” is added to the file name.
  Example: If the xtr/ztr file includes three test data, MdmFileConverter.exe abc.xtr creates the abc.mdm, abc(1).mdm, and abc(2).mdm files.

• With the /t option, the title of the test setup is added to the file name.
  Example: If the title is “title”, MdmFileConverter.exe /t abc.xtr creates the abc-title.mdm file.

• If a mdm file of the same name already exists, “(N)” is added to the file name.
  Example: If the abc.mdm file already exists, MdmFileConverter.exe abc.xtr creates the abc(1).mdm file.
sleep.exe

This execution file is used to put a wait time in the test execution flow of an application test.

**Execution environment**

EasyEXPERT application test execution environment

**File Name**

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\sleep.exe

**Parameters**

The following parameters are available for this file. To use sleep.exe, the parameters must be defined in the Local Variables Definition statement of the Test Contents tab in the Test Definition window.

- **WAIT**: List input parameter. Vector variable (1 × 1) to store the data passed to sleep.exe. Enter a wait time in ms.
- **PassFail**: Value output parameter. Numeric variable to store the execution result. 0 is always returned.
- **ReturnValue**: Value output parameter. Numeric variable to store the data returned by executing sleep.exe. 1 is returned after execution.

**Setup examples**

To execute sleep.exe, the following setup should be done in the Command Execution element, Miscellaneous component, Test Contents tab in the Test Definition window.

<table>
<thead>
<tr>
<th>Windows Command Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Filename: C:\Program Files\Agilent\B1500\EasyEXPERT\Utilities\sleep.exe</td>
</tr>
<tr>
<td>Argument:</td>
</tr>
<tr>
<td>Write Type:</td>
</tr>
<tr>
<td>Read Type:</td>
</tr>
<tr>
<td><strong>Write List</strong></td>
</tr>
<tr>
<td>Values: WAIT</td>
</tr>
<tr>
<td>Format:</td>
</tr>
<tr>
<td><strong>Read Value</strong></td>
</tr>
<tr>
<td>Result: PassFail Value: ReturnValue</td>
</tr>
</tbody>
</table>
XSLT

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation) filter files are used to export test records. The fifteen filter files listed below are stored in the `<program folder>`\Agilent\B1500\EasyEXPERT\Utilities\XSLT folder. See Table 8-4.

Filter files that contain `csv` in the file name export test record in the format that uses a comma (,) as data separator.

Filter files that contain `tab-sv` in the file name export test record in the format that uses a tab as data separator.

Filter files that contain `xmlss` in the file name export test record in the XML Spread Sheet format.

**To export test record**

Test record can be exported by the following procedure.

1. Open the Export in My Format dialog box by clicking Results > Transport Data > Export in My Format....
2. Enter the XSLT filter file name, and click the Export As... button.
3. On the Export As dialog box, specify the file name and file type for the export data, and click Save.

**To read export result**

The exported data file can be opened and read with a spreadsheet software. The procedure for opening the export data with a spreadsheet software is as follows.

- For data separated by a comma
  Specify the data separated by a comma for the original data format.
- For data separated by a tab
  Specify the data separated by a tab for the original data format.
- For data in the XML Spread Sheet format
  Specify the XML file for the file type.

After reading the file, all data in the file will be entered into independent cells on the spreadsheet software.
### Table 8-4  XSLT Filter Files

<table>
<thead>
<tr>
<th>Group</th>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | • meas-csv.xsl  
       • meas-tab-sv.xsl  
       • meas-xmlss.xsl   | Filter files for exporting the measurement data only  
Classic test record export example is shown in Table 8-5.                                                        |
| 2     | • meas-index-csv.xsl  
       • meas-index-tab-sv.xsl  
       • meas-index-xmlss.xsl   | Filter files for exporting the measurement data with the index  
Classic test record export example is shown in Table 8-6.                                                        |
| 3     | • meas-meta-csv.xsl  
       • meas-meta-tab-sv.xsl  
       • meas-meta-xmlss.xsl   | Filter Files for exporting the measurement data with the meta data  
The meta data contains the test name, the setup name, the record time of the test results, the device ID, the counter number, the flag of the test results, and the remarks on the test results.  
Classic test record export example is shown in Table 8-7.                                                        |
| 4     | • meas-index-meta-csv.xsl  
       • meas-index-meta-tab-sv.xsl  
       • meas-index-meta-xmlss.xsl   | Filter files for exporting the measurement data with the index and the meta data  
The meta data contains the test name, the setup name, the record time of the test results, the device ID, the counter number, the flag of the test results, and the remarks on the test results.  
Classic test record export example is shown in Table 8-8.                                                        |
| 5     | • csv.xsl  
       • tab-sv.xsl  
       • xmlss.xsl   | Filter files for exporting all data including the test setup  
Application test record export example is shown in Table 8-9.  
Data in the first cell is the label for the data components in that row. The following cells are the data corresponding to the label. Table 8-12 and Table 8-13 list the components available for the exported data file. |
Table 8-5  Example of the data exported by using the XSLT Filter File Group 1

<table>
<thead>
<tr>
<th>Vd</th>
<th>Vg</th>
<th>Index</th>
<th>Time</th>
<th>Id</th>
<th>ABS_ID</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00264</td>
<td>-0.00012</td>
<td>0.00012</td>
<td>0.004346</td>
</tr>
<tr>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01265</td>
<td>0.000398</td>
<td>0.000398</td>
<td>0.004346</td>
</tr>
<tr>
<td>0.12</td>
<td>1</td>
<td>3</td>
<td>0.02265</td>
<td>0.000902</td>
<td>0.000902</td>
<td>0.004346</td>
</tr>
</tbody>
</table>

Table 8-6  Example of the data exported by using the XSLT Filter File Group 2

<table>
<thead>
<tr>
<th>No.</th>
<th>Vd</th>
<th>Vg</th>
<th>Index</th>
<th>Time</th>
<th>Id</th>
<th>ABS_ID</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00264</td>
<td>-0.00012</td>
<td>0.00012</td>
<td>0.004346</td>
</tr>
<tr>
<td>2</td>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01265</td>
<td>0.000398</td>
<td>0.000398</td>
<td>0.004346</td>
</tr>
<tr>
<td>3</td>
<td>0.12</td>
<td>1</td>
<td>3</td>
<td>0.02265</td>
<td>0.000902</td>
<td>0.000902</td>
<td>0.004346</td>
</tr>
</tbody>
</table>

Table 8-7  Example of the data exported by using the XSLT Filter File Group 3

<table>
<thead>
<tr>
<th>I/V Sweep</th>
<th>Trng Id-Vd</th>
<th>Record Time</th>
<th>04/04/2007 08:36:42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device ID</td>
<td>Count 2</td>
<td>Flag</td>
<td>Remarks</td>
</tr>
<tr>
<td>Vd</td>
<td>Vg</td>
<td>Index</td>
<td>Time</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00264</td>
</tr>
<tr>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01265</td>
</tr>
<tr>
<td>0.12</td>
<td>1</td>
<td>3</td>
<td>0.02265</td>
</tr>
</tbody>
</table>


Table 8-8  Example of the data exported by using the XSLT Filter File Group 4

<table>
<thead>
<tr>
<th>I/V Sweep</th>
<th>Trng Id-Vd</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>04/04/2007</td>
<td>08:36:42</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flag</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remarks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Vd</td>
<td>Vg</td>
<td>Index</td>
<td>Time</td>
<td>Id</td>
<td>ABS_ID</td>
<td>Slope</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00264</td>
<td>-0.00012</td>
<td>0.00012</td>
<td>0.004346</td>
</tr>
<tr>
<td>2</td>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01265</td>
<td>0.000398</td>
<td>0.000398</td>
<td>0.004346</td>
</tr>
<tr>
<td>3</td>
<td>0.12</td>
<td>1</td>
<td>3</td>
<td>0.02265</td>
<td>0.000902</td>
<td>0.000902</td>
<td>0.004346</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Filter File Modification Example

This section explains the modification example of a filter file. In this example, a filter file of group 5 is used.

The group 5 filter files will export the data that contains the test setup information. To obtain the data without the setup information, modify the filter file as shown below, also see Figure 8-9, and export data by using the filter file after modification.

The data will not contain the TestParameter, DutParameter, MetaData, and AnalysisSetup of the Application test result record, and the TestParameter, MetaData, and AnalysisSetup of the Classic test result record.

1. Modify the following template elements for sta:TestParameterList to sta:TerminalList as shown below.

   <xsl:template match="sta:TestParameterList">
     </xsl:template>
   </xsl:template>
   <xsl:template match="sta:DutParameterList">
     </xsl:template>
   </xsl:template>
   <xsl:template match="sta:AnalysisParameterList">
     </xsl:template>
   </xsl:template>
   <xsl:template match="sta:MetaData/sta:ParameterList">
     </xsl:template>
   </xsl:template>
   <xsl:template match="sta:TerminalList">
     <xsl:apply-templates />
   </xsl:template>

2. Comment out the whole of the following template element.

   <!--
   <xsl:template match="sta:Parameter">
   </xsl:template>
   -->

Exported data examples of Classic test result record are shown in Table 8-9 and Table 8-10.

Table 8-11 explains the reference name used in the filter file and shows the relation to the parameter name used in the data file exported by using the filter file.
### Table 8-9  Example of the data exported by using the filter file before modification

<table>
<thead>
<tr>
<th>SetupTitle</th>
<th>Trng Id-Vd</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PrimitiveTest</td>
<td>I/V Sweep</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TestParameter</td>
<td>Channel.Unit</td>
<td>SMU1:HP</td>
<td>SMU2:HP</td>
<td>SMU3:HR</td>
<td>SMU4:HR</td>
</tr>
<tr>
<td>TestParameter</td>
<td>Channel.IName</td>
<td>Id</td>
<td>Ig</td>
<td>Is</td>
<td>Isub</td>
</tr>
<tr>
<td>TestParameter</td>
<td>Channel.VName</td>
<td>Vd</td>
<td>Vg</td>
<td>Vs</td>
<td>Vsub</td>
</tr>
<tr>
<td>MetaData</td>
<td>TestRecord.Entr</td>
<td>true</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AnalysisSetup</td>
<td>Analysis.Setup.</td>
<td>true</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimension1</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
</tr>
<tr>
<td>Dimension2</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>DataName</td>
<td>Vd</td>
<td>Vg</td>
<td>Index</td>
<td>Time</td>
<td>Id</td>
</tr>
<tr>
<td>DataValue</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00251</td>
<td>0</td>
</tr>
<tr>
<td>DataValue</td>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01251</td>
<td>3.35E-05</td>
</tr>
</tbody>
</table>

### Table 8-10  Example of the data exported by using the filter file after modification

<table>
<thead>
<tr>
<th>SetupTitle</th>
<th>Trng Id-Vd</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PrimitiveTest</td>
<td>I/V Sweep</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimension1</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
</tr>
<tr>
<td>Dimension2</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>DataName</td>
<td>Vd</td>
<td>Vg</td>
<td>Index</td>
<td>Time</td>
<td>Id</td>
</tr>
<tr>
<td>DataValue</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0.00251</td>
<td>0</td>
</tr>
<tr>
<td>DataValue</td>
<td>0.06</td>
<td>1</td>
<td>2</td>
<td>0.01251</td>
<td>3.35E-05</td>
</tr>
</tbody>
</table>
### Table 8-11  
**Filter File Reference Name**

<table>
<thead>
<tr>
<th>Reference name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sta:TestData</td>
<td>Indicates a test result data saved in an EasyEXPERT test result record</td>
</tr>
<tr>
<td>sta:MeasurementData</td>
<td>Indicates a measurement result data saved in a test result data</td>
</tr>
<tr>
<td>sta:DataVectorSet</td>
<td>Indicates a set of vector data saved in a measurement result data</td>
</tr>
<tr>
<td>sta:TestSetup</td>
<td>Indicates a test setup data saved in a test result data</td>
</tr>
<tr>
<td>sta:Title</td>
<td>Indicates test setup name, SetupTitle in export data</td>
</tr>
<tr>
<td>sta:PrimitiveTest</td>
<td>Indicates a classic test data set, PrimitiveTest in export data</td>
</tr>
<tr>
<td>sta:ApplicationTest</td>
<td>Indicates an application test data set, ApplicationTest in export data</td>
</tr>
<tr>
<td>sta:TestParameterList</td>
<td>Indicates a set of Test Parameters definitions, TestParameter in export data</td>
</tr>
<tr>
<td>sta:DutParameterList</td>
<td>Indicates a set of Device Parameters definitions, DutParameter in export data</td>
</tr>
<tr>
<td>sta:AnalysisParameterList</td>
<td>Indicates a set of display and analysis data, AnalysisSetup in export data</td>
</tr>
<tr>
<td>sta:MetaData/sta:ParameterList</td>
<td>Indicates a set of system data, MetaData in export data</td>
</tr>
<tr>
<td>sta:TerminalList</td>
<td>Indicates a set of terminal information</td>
</tr>
<tr>
<td>sta:Parameter</td>
<td>Indicates a parameter</td>
</tr>
<tr>
<td>sta:Parameter</td>
<td>Indicates an integer data</td>
</tr>
<tr>
<td>sta:Channel</td>
<td>Indicates a channel information</td>
</tr>
<tr>
<td>sta:Parameter</td>
<td>Indicates a terminal information</td>
</tr>
<tr>
<td>sta:Port</td>
<td>Indicates a port information</td>
</tr>
</tbody>
</table>
## Table 8-12  Export Data Components for Classic Test Result

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
<th>Example (csv output)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetupTitle</td>
<td>Title of this test setup</td>
<td>Trng_Id_Vd</td>
</tr>
<tr>
<td>PrimitiveTest</td>
<td>Setup name of this classic test</td>
<td>I/V Sweep</td>
</tr>
<tr>
<td>MetaData</td>
<td>Data for system use. Test record entry point, record time, test target, iteration index, preservation, flag, remarks, and link key.</td>
<td>TestRecord.EntryPoint, true</td>
</tr>
<tr>
<td>AnalysisSetup</td>
<td>Parameter name and setup value of the data display and analysis setup. Data file contains a lot of rows for AnalysisParameter. One setup item per row.</td>
<td>Analysis.Setup.Vector.Graph.Enabled, true</td>
</tr>
<tr>
<td>Dimension1</td>
<td>Size of data variable. For dimension 1. Order sensitive. 51 for all data variables in Example.</td>
<td>51, 51, 51, 51, 51</td>
</tr>
<tr>
<td>Dimension2</td>
<td>Size of data variable. For dimension 2. Order sensitive. 1 for all data variables in Example.</td>
<td>3, 3, 3, 3, 3</td>
</tr>
<tr>
<td>DataName</td>
<td>Measurement parameter names or data variable names. Order sensitive. For example, Vgate=-0.5 in Example.</td>
<td>Vd, Vg, Index, Time, Id</td>
</tr>
<tr>
<td>DataValue</td>
<td>Measurement result data. Order sensitive. For example, Vgate=-0.5 in Example. Data file contains a lot of rows for DataValue. One data set per row.</td>
<td>0, 1, 1, 0.00251, 0</td>
</tr>
</tbody>
</table>
Table 8-13  **Export Data Components for Application Test Result**

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
<th>Example (csv output)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetupTitle</td>
<td>Title of this test setup</td>
<td>Trng_Id_Vd</td>
</tr>
<tr>
<td>ApplicationTest</td>
<td>Setup name of this application test</td>
<td>Trng_Id_Vd, Public</td>
</tr>
</tbody>
</table>
| TestParameter    | Two rows. The upside is for the test parameter names. The downside is for the test parameter values. Order sensitive. For example, Vd=0.1 in Example.                                                            | Name, VdStart, VdStop, VdStep, VgStart, VgStop, VgStep, Vs  
|                  |                                                                                                                                                                                                          | Value, 0, 3, 0.06, 1, 2, 0.5, 0           |
| DutParameter     | Two rows. The upside is for the device parameter names. The downside is for the device parameter values. Order sensitive. For example, Temp=25 in Example.                                                                 | Name, Polarity, Lg, Wg, Temp, IdMax      |  
|                  |                                                                                                                                                                                                          | Value, 1, 1.00E-07, 1.00E-05, 25, 0.005    |
| MetaData         | Data for system use. Test record entry point, record time, test target, iteration index, preservation, flag, remarks, and link key.                                                                       | TestRecord.EntryPoint, true              |
| AnalysisSetup    | Parameter name and setup value of the data display and analysis setup.                                                                                                                                     | Analysis.Setup.Vector.Graph.Enabled, true |
| Dimension1       | Size of data variable. For dimension 1. Order sensitive. 51 for all data variables in Example.                                                                                                               | 51, 51, 51, 51, 51                       |
| Dimension2       | Size of data variable. For dimension 2. Order sensitive. 1 for all data variables in Example.                                                                                                               | 3, 3, 3, 3, 3                           |
| DataName         | Measurement parameter names or data variable names. Order sensitive. For example, Vgate=-0.5 in Example.                                                                                                   | Vd, Vg, Index, Time, Id                 |
| DataValue        | Measurement result data. Order sensitive. For example, Vgate=-0.5 in Example.                                                                                                                           | 0, 1, 1, 0.00251, 0                      |
|                  | Data file contains a lot of rows for DataValue. One data set per row.                                                                                                                                   |                                           |
9 Application Library
Application Library

This chapter lists the application tests provided by EasyEXPERT. This chapter also describes the maximum measurement value and accuracy for the result data measured by using the QSCV[2] application test.

• “Application Test Definitions”
• “QSCV Maximum Measurement Value and Accuracy”
Application Test Definitions

Keysight EasyEXPERT software contains the application library which supports the several characteristic measurements listed in Table 9-1. They are classified into the following categories.

• BJT
• CMOS
• Discrete
• GenericTest
• MCSMU_IV
• Memory
• MixedSignal
• NanoTech
• Organic
• PwrDevice
• Reliability
• Sample
• Solar Cell
• SPGU_PLSDIV
• Structure
• TFT
• Utility
• WGFMU
• WGFMU Utility
• WGFMU_IV
• GaN Diode
• GaN FET
• IGBT
Application Library
Application Test Definitions

- Interconnection
- MISCAP
- PMIC
- PowerBJT
- PowerDiode
- PowerMOSFET
- SiC
- GateCharge
- GateChargeUtilities
- N1272A
- N1274A
- Thermal
- MultiHVSMU
- Advanced NVM
- Utility (NVM)
- Thyristor

NOTE All test definitions are just sample. If the samples damage your devices, Keysight Technologies is NOT LIABLE for the damage.

NOTE If you delete a test definition
Application library should be recovered. Import the test definition by using the Import Test Definition... function of the Library button. The original test definitions are stored in the following folders.

<program folder>\Agilent\B1500\EasyEXPERT\Application Tests

<program folder>\Agilent\B1500\EasyEXPERT\Contribution\Application Tests
### Table 9-1 Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BC Diode Fwd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BC diode Rev [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BVcebo [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BVceo [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BVebo [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CS Diode Fwd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CS Diode Rev [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Ctc-Freq Log</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Ctc-Vc</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Ctc-Ve</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cts</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>EB Diode Fwd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>EB Diode Rev [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>G-Plot ConstVce Pulse</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td></td>
<td>G-Plot ConstVce Pulse [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>G-Plot ConstVce</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>G-Plot ConstVce [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>G-Plot Vbc=0V Pulse</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>G-Plot Vbc=0V Pulse [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>G-Plot Vbc=0V</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>G-Plot Vbc=0V [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>hfe-Vbe ConstVce</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>hfe-Vbe Vbc=0V</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Ib</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Ib [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Pulse Ib</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Pulse Ib [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Pulse Vb</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Pulse Vb [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Vb</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>BJT</td>
<td>Ic-Vc Vb [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Rb</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Rb [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Re+Re</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Re</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Simple Gummel Plot [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Vbe-Le</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4, B2200A/B2201A 1</td>
</tr>
<tr>
<td></td>
<td>Vbe-We</td>
<td></td>
<td>SMU 4, B2200A/B2201A 1</td>
</tr>
<tr>
<td>CMOS</td>
<td>BVdss</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>BVdss [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BVgso [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Cgb-AC Level</td>
<td>B1500A</td>
<td>MFCMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgb-Freq Log</td>
<td></td>
<td>MFCMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgb-Vg HighVoltage</td>
<td></td>
<td>MFCMU 1, SMU 3, SCUU 1, GSWU 1</td>
</tr>
<tr>
<td></td>
<td>Cgb-Vg</td>
<td></td>
<td>MFCMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgc-Freq Log</td>
<td></td>
<td>MFCMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgc-Vg</td>
<td></td>
<td>MFCMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgg-Freq Linear</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgg-Freq Log</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgg-Vg 2Freq</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgg-Vg</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>IdRdsGds</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Id-Vd pulse</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>IdRdsGds [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Id-Vd pulse [2HL]</td>
<td>B1500A, E5260A, E5263A, E5270B</td>
<td>SMU x2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Id-Vd</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
</tbody>
</table>
## Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Id-Vd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Id-Vg pulse</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>IonIoffSlope</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>IonIoffSlope [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Isub-Vg</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Simple Cgb</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Simple Vth</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Simple Vth [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Vth Const Id</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Vth Const Id [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Vth gmMax</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Vth gmMax [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Vth gmMax and Id</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>VthAndCgg-Vg ASU</td>
<td>B1500A</td>
<td>MFCMU 1, SMU 1, ASU+SMU 2</td>
</tr>
<tr>
<td></td>
<td>VthAndCgg-Vg SCUU</td>
<td>MFCMU 1, SMU 3, SCUU 1, GSWU 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vth-Lg</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4, B2200A/B2201A 1</td>
</tr>
<tr>
<td></td>
<td>Vth-Wg</td>
<td>SMU 4, B2200A/B2201A 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BJT Ic-Vc Ib</td>
<td>B1500A, E5260A, E5262A, E5263A, E5270B</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>BJT Ic-Vc Ib [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Diode IV Fwd [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------</td>
<td>---------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Diode IV Rev [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>FET Id-Vd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>FET Id-Vg</td>
<td>B1500A, E5260A, E5262A, E5263A, E5270B</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>FET Id-Vg [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td>GenericTest</td>
<td>Generic C-f</td>
<td>B1500A, B1505A, B1506A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Generic C-t</td>
<td>B1500A, B1506A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td>Memory</td>
<td>Flash Ccf-V</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Flash Cgg-Vg</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Flash Cfb-V</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Endurance</td>
<td></td>
<td>SMU 3, B2200A/B2201A 1, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Endurance 3devices</td>
<td></td>
<td>ASU+SMU 3, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 IV-Erase-IV</td>
<td></td>
<td>SMU 1, ASU+SMU 2, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 IV-Write-IV</td>
<td></td>
<td>SMU 2, ASU+SMU 1, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Retention(ErasedCell)</td>
<td></td>
<td>SMU 1, ASU+SMU 2, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Retention(WrittenCell)</td>
<td></td>
<td>SMU 2, ASU+SMU 1, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Vth(ErasingTimeDependence)</td>
<td></td>
<td>SMU 1, ASU+SMU 2, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 Vth(WritingTimeDependence)</td>
<td></td>
<td>SMU 2, ASU+SMU 1, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 WordDisturb(ErasedCell)</td>
<td></td>
<td>ASU+SMU 3, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash2 WordDisturb(WrittenCell)</td>
<td></td>
<td>SMU 2, ASU+SMU 1, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 Endurance</td>
<td></td>
<td>[SPGU 1, ASU+SMU 3] or [SPGU 1, SMU 3, 16440A/16445A 2]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 IV-Erase-IV</td>
<td></td>
<td>[SPGU 1, SMU 1, ASU+SMU 2] or [SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
</tbody>
</table>
### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>NandFlash3 IV-Write-IV</td>
<td>B1500A</td>
<td>[SPGU 1, SMU 2, ASU+SMU 1] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 Retention(ErasedCell)</td>
<td></td>
<td>[SPGU 1, SMU 1, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 Retention(WrittenCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 1] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 Vth(ErasingTimeDependence)</td>
<td></td>
<td>[SPGU 1, SMU 1, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 Vth(WritingTimeDependence)</td>
<td></td>
<td>[SPGU 1, ASU+SMU 3] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 2]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 WordDisturb(ErasedCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 1] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NandFlash3 WordDisturb(WrittenCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 1] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 3, 16440A/16445A 1]</td>
</tr>
<tr>
<td>NorFlash Endurance</td>
<td></td>
<td></td>
<td>[SPGU 2, SMU 1, ASU+SMU 3] or</td>
</tr>
<tr>
<td></td>
<td>NorFlash IV-Erase-IV</td>
<td></td>
<td>[SPGU 2, SMU 4, 16440A/16445A 2]</td>
</tr>
<tr>
<td></td>
<td>NorFlash IV-Write-IV</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash Retention(ErasedCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash Retention(WrittenCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash Vth(ErasingTimeDependence)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash Vth(WritingTimeDependence)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash WordDisturb(ErasedCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash WordDisturb(WrittenCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td></td>
<td>NorFlash DataDisturb(ErasedCell)</td>
<td></td>
<td>[SPGU 2, SMU 1, ASU+SMU 3] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 2, SMU 4, 16440A/16445A 2]</td>
</tr>
<tr>
<td></td>
<td>NorFlash DataDisturb(WrittenCell)</td>
<td></td>
<td>[SPGU 1, SMU 2, ASU+SMU 2] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[SPGU 1, SMU 4, 16440A/16445A 1]</td>
</tr>
<tr>
<td>MixedSignal</td>
<td>BJT Varactor CV Mismatch</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>DiFF-R Mismatch</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 8</td>
</tr>
<tr>
<td></td>
<td>Diode IV Rev Mismatch</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 3</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>MixedSignal</td>
<td>G-Plot ConstVce Mismatch</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 6</td>
</tr>
<tr>
<td></td>
<td>G-Plot ConstVce Mismatch[3]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>G-Plot Vbc=0V Mismatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Ib Mismatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Ib Mismatch[3]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Vb Mismatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ic-Vc Vb Mismatch[3]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vd Mismatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vd Mismatch[3]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vg Mismatch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vg Mismatch[3]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MIM CV Mismatch</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>MOS Varactor CV Mismatch</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Poly-R Mismatch</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 7</td>
</tr>
<tr>
<td>NanoTech</td>
<td>CNT Differential R[AC]</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>CNT Gate Leak [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>CNT Id-Time</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>CNT Id-Time [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CNT Id_Vd</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>CNT Id_Vd [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CNT Id_Vg</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>CNT Id_Vg [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CNT Id-Vg-Time</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>CNT Id-Vg-Time [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>CNT IV Sweep [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
</tbody>
</table>
## Application Library

### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CNT R-V Kelvin 2SMU</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>CNT Vth gmMax</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>CNT Vth gmMax [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMUx2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>BVgso[3] PwrDevice</td>
<td>SMU 2</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>Id-Vd pulse[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Id-Vd[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Id-Vg pulse[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Id-Vg[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Vth Const Id[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Vth gmMax[3] PwrDevice</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td>Reliability</td>
<td>BJT EB RevStress 3devices</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 6, B2200A/B2201A 1</td>
</tr>
<tr>
<td></td>
<td>BJT EB RevStress</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>BJT EB RevStress2[3]</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>BTI 3devices</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 5, B2200A/B2201A 1</td>
</tr>
<tr>
<td></td>
<td>BTI 3devices[3]</td>
<td>SMU 5, B2200A/B2201A 1</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>BTI</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>BTI2</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>BTI2[3]</td>
<td>SMU 3</td>
<td>SMU 3</td>
</tr>
<tr>
<td></td>
<td>Charge Pumping</td>
<td>B1500A</td>
<td>SMU 2, 81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>Charge Pumping2</td>
<td>SMU 2, SPGU 1</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>EM Istress</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>EM Istress2</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>EM Vstress</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>EM Vstress2</td>
<td>SMU 4</td>
<td>SMU 4</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td></td>
<td>HCI 3devices</td>
<td></td>
<td>SMU 8</td>
</tr>
<tr>
<td></td>
<td>HCI</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>HCI2</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>TDDDB Istress 3devices</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>TDDDB Istress2 3devices</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>TDDDB Istress2</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>TDDDB Vstress 3devices</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>TDDDB Vstress2 3devices</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>TDDDB Vstress2</td>
<td></td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Timing On-the-fly NBTI</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Timing On-the-fly NBTI-Mch</td>
<td>B1500A</td>
<td>SMU 4 or SMU 7</td>
</tr>
<tr>
<td></td>
<td>TZDB</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>V-Ramp</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>BVgb ThinOx [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>BVgb [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Cgb-Freq[2] Log</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgb-Vg 2Freq</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgb-Vg[2]</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cj-Freq Log</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cj-V</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Diode BVAndCj-V ASU</td>
<td></td>
<td>MFCMU 1, ASU+SMU 2</td>
</tr>
<tr>
<td></td>
<td>Diode BVAndCj-V SCUU</td>
<td></td>
<td>MFCMU 1, SMU 2, SCUU 1, GSWU 1</td>
</tr>
</tbody>
</table>
### Application Library

#### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ig-Vg Iforce [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Ig-Vg Vforce</td>
<td>B1500A, E5260A, E5262A, E5263A, E5270B</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>Ig-Vg Vforce [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Interconnect CouplingCap</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Interconnect OverlapCap</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Junction BV [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Junction DcParam [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Junction IV Fwd [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Junction IV Rev [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>QSCV C Offset Meas</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>Rdiff-I kelvin</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 5</td>
</tr>
<tr>
<td></td>
<td>Rdiff-I [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Rdiff-V [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Rdiff-V kelvin</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 5</td>
</tr>
</tbody>
</table>
## Application Library

### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>R-I kelvin</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>R-I kelvin [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>R-I [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>R-V kelvin</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>R-V kelvin [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>R-V [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU</td>
</tr>
<tr>
<td></td>
<td>VanDerPauw Square</td>
<td>B1500A, E5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>VanDerPauw Square [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td></td>
<td>Van Der Pau NonUniform</td>
<td>B1500A</td>
<td>SMU 4</td>
</tr>
<tr>
<td>Utility (Auxiliary)</td>
<td>Van Der Pau NonUniform Child Calc Rs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TFT Id-Vg</td>
<td></td>
<td>SMU 3</td>
</tr>
<tr>
<td>Utility</td>
<td>CV Curve Parameter Calculator</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CVSweep4284_a</td>
<td></td>
<td>4284A 1 or E4980A 1</td>
</tr>
<tr>
<td></td>
<td>ForcePG1</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>ForcePG2</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>ForcePG2P</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>ForcePG12</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>ForcePG</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>ForcePGC</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>Measure Diff-V</td>
<td></td>
<td>3458A 1</td>
</tr>
<tr>
<td></td>
<td>QSCV C Offset Meas</td>
<td>B1500A, B1505A</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>ResetPG</td>
<td></td>
<td>81110A (2 outputs) 1</td>
</tr>
<tr>
<td></td>
<td>Subsite move</td>
<td></td>
<td>Wafer prober 1</td>
</tr>
<tr>
<td></td>
<td>TSet_T2420</td>
<td></td>
<td>Thermonics T-2420</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
<td>----------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Power MOSFET</td>
<td>Vds-Vgs</td>
<td>B1505A, B1506A</td>
<td>HCSMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Id-Vgs for Expanders</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TDBB Constant V</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ciss (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coss (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Crss (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cgs (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cds (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cgd (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rg(N1272A) for PowerMOSFET</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ciss-Vgs (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IDSS (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IGSS (N1272A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MCSMU_IV</td>
<td>Id-Vds MCSMU</td>
<td>B1500A</td>
<td>[[MCSMU 1 and MP/HP/HRSMU 1] or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MCSMU 2] and [MP/HP/HRSMU 2 or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[MP/HP/HRSMU 1 and GNDU]]</td>
</tr>
<tr>
<td></td>
<td>Id-Vgs MCSMU</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vgs MCSMU 2-stage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organic</td>
<td>2-terminal dual Vsweep</td>
<td>B1500A</td>
<td>[SMU 1 and GNDU] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>2-terminal dual Vsweep [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td>Sample</td>
<td>Vth gmMax and Id</td>
<td>B1500A, B5260A, E5270B</td>
<td>SMU 4</td>
</tr>
<tr>
<td></td>
<td>Vth gmMax and Id [2HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×2. See Figure 2.</td>
</tr>
<tr>
<td>Solar Cell</td>
<td>Solar Cell IV</td>
<td>B1500A</td>
<td>[SMU 1 and GNDU] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Solar Cell IV [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Solar Cell IV Fwd</td>
<td>B1500A</td>
<td>[SMU 1 and GNDU] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Solar Cell IV Fwd [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td></td>
<td>Solar Cell IV Rev</td>
<td>B1500A</td>
<td>[SMU 1 and GNDU] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Solar Cell IV Rev [1HL]</td>
<td>B2901A, B2902A, B2911A, B2912A</td>
<td>SMU×1. See Figure 1.</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Solar Cell</td>
<td>Solar Cell Cp-V</td>
<td>B1500A</td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Solar Cell Nc-W</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Solar Cell Cp-Freq Log</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Solar Cell Nyquist Plot</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Solar Cell Cp-AC Level</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Solar Cell DLCP</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td>SPGU PLSDIV</td>
<td>SPGU PLSDIV</td>
<td>B1500A</td>
<td>SPGU 1</td>
</tr>
<tr>
<td></td>
<td>SPGU PLSDIV Id-Vd</td>
<td></td>
<td>SPGU 1</td>
</tr>
<tr>
<td></td>
<td>SPGU PLSDIV Id-Vg</td>
<td></td>
<td>SPGU 1</td>
</tr>
<tr>
<td>WGFMU (needs test definitions of WGFMU Utility)</td>
<td>Fast BTI(ACstress Id-Sampling)</td>
<td>B1500A</td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI(DCstress Id-Sampling)</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI(ACstress Id-Vg)</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI(DCstress Id-Vg)</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>TRANSIV DC IdVd</td>
<td></td>
<td>SMU 2, WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>TRANSIV DC IdVg</td>
<td></td>
<td>SMU 2, WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU Pattern Editor</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td>WGFMU Utility*</td>
<td>Fast BTI Id-Sampling child</td>
<td>B1500A</td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI Id-Sampling child2</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI Id-Vg child</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI Id-Vg child2</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>Fast BTI Pattern Editor Child DataDisplay</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td>WGFMU IV</td>
<td>WGFMU DCIV</td>
<td>B1500A</td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU PLSDIV</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU Id-Vd (DC)</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU Id-Vg (DC)</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU Id-Vd pulse</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>WGFMU Id-Vg pulse</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td>GaN Diode</td>
<td>Diode Current Collapse IV-t Sampling</td>
<td>B1505A</td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 1</td>
</tr>
<tr>
<td></td>
<td>Diode Current Collapse Signal Monitor</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 1</td>
</tr>
</tbody>
</table>
### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GaN FET</td>
<td>FET Current Collapse IV-t Sampling (I Force)</td>
<td>B1505A</td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>FET Current Collapse IV-t Sampling</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>FET Current Collapse Signal Monitor (I Force)</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>FET Current Collapse Signal Monitor</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Id-Vds Current Collapse</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Id-Vds Current Collapse (Pulse)</td>
<td></td>
<td>N1267A 1, HVSMU 1, HCSMU 1, MCSMU 2, SMU 1</td>
</tr>
<tr>
<td>IGBT</td>
<td>Cce</td>
<td>B1505A, B1506A</td>
<td>MFCMU 1, HVSMU 1, Bias-T 1</td>
</tr>
<tr>
<td></td>
<td>Cgc</td>
<td></td>
<td>MFCMU 1, HVSMU 1, Bias-T 1</td>
</tr>
<tr>
<td></td>
<td>Cge</td>
<td></td>
<td>MFCMU 1, Bias-T 1 or N1259A with 020</td>
</tr>
<tr>
<td></td>
<td>Cge-Vge</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Ic(0ff)-Vce</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>Ic-Vce</td>
<td></td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Ic-Vge</td>
<td></td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Vth Vge(off)</td>
<td></td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
</tr>
<tr>
<td></td>
<td>Vce-Vge</td>
<td></td>
<td>HCSMU 1, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Ic-Vge for Expanders</td>
<td></td>
<td>N1265A 1, MC/HCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Cies (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Coes (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cres (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cge (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cce (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cgc (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Cies-Vge (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Rg (N1272A) for IGBT</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>ICES (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>IGES (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Interconnection Residual R</td>
<td>B1505A, B1506A</td>
<td>HCSMU 1 or SMU 1</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>MISCAP</td>
<td>BV</td>
<td>B1505A, B1506A</td>
<td>SMU 1</td>
</tr>
<tr>
<td></td>
<td>C(MISCAP)</td>
<td></td>
<td>MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>Ileak-V</td>
<td></td>
<td>SMU 1</td>
</tr>
<tr>
<td>PowerBJT</td>
<td>Ic-Vcbo</td>
<td>B1505A, B1506A</td>
<td>SMU 1</td>
</tr>
<tr>
<td></td>
<td>Ic-Vc(PowerBJT)</td>
<td></td>
<td>[HCSMU 1 and SMU 1] or SMU/HCSMU 2</td>
</tr>
<tr>
<td></td>
<td>Ic-Vceo</td>
<td></td>
<td>SMU 1</td>
</tr>
<tr>
<td></td>
<td>Ic-Vces</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>Ie-Webo</td>
<td></td>
<td>SMU 1</td>
</tr>
<tr>
<td></td>
<td>Vce(sat)-Ic</td>
<td></td>
<td>[HCSMU 1 and SMU 1] or SMU/HCSMU 2</td>
</tr>
<tr>
<td></td>
<td>G-Plot for Expanders</td>
<td></td>
<td>N1265A 1, MC/HCSMU 2, SMU 1</td>
</tr>
<tr>
<td></td>
<td>Ic-Ib for Expanders</td>
<td></td>
<td>N1265A 1, MC/HCSMU 2, SMU 1</td>
</tr>
<tr>
<td>PowerDiode</td>
<td>Cj-Vr</td>
<td>B1505A, B1506A</td>
<td>MFCMU 1, HVSMU 1, Bias-T 1</td>
</tr>
<tr>
<td></td>
<td>If-Vf</td>
<td></td>
<td>HCSMU 1 or SMU 1</td>
</tr>
<tr>
<td></td>
<td>Ir-Vr</td>
<td></td>
<td>SMU 1</td>
</tr>
<tr>
<td></td>
<td>Vf</td>
<td></td>
<td>HCSMU 1 or SMU 1</td>
</tr>
<tr>
<td></td>
<td>CT (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1, MFCMU 1</td>
</tr>
<tr>
<td></td>
<td>IR (N1272A)</td>
<td></td>
<td>MPSMU 1, HVSMU 1</td>
</tr>
<tr>
<td>GateCharge</td>
<td>Qg(High Id Switching)</td>
<td>B1505A, B1506A</td>
<td>UHCU/HCSMU 1, MCMU 2</td>
</tr>
<tr>
<td>Utilities^a</td>
<td>Qg(High Vds Switching)</td>
<td></td>
<td>MCSMU 1, HVSMU 1</td>
</tr>
<tr>
<td></td>
<td>Qg(High Ic Switching)</td>
<td></td>
<td>UHCU/HCSMU 1, MCMU 2</td>
</tr>
<tr>
<td></td>
<td>Qg(High Vce Switching)</td>
<td></td>
<td>MCSMU 2, HVSMU 1</td>
</tr>
<tr>
<td>N1272A</td>
<td>N1272ACheckBreakdown^a</td>
<td>B1505A, B1506A</td>
<td>N1272A, MPSMU 1, HVSMU 1</td>
</tr>
<tr>
<td></td>
<td>IV Path (N1272A)</td>
<td></td>
<td>N1272A</td>
</tr>
<tr>
<td>N1274A</td>
<td>IV Path (N1274A)</td>
<td>B1505A</td>
<td>N1274A</td>
</tr>
<tr>
<td>Thermal</td>
<td>N1265A WaitTemperature</td>
<td>B1505A, B1506A</td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream ControlTemperature</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream DefineParameters</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream FlowOff</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream Initialize</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream ReadTemperature</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream WaitReady</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermoStream WaitTemperature</td>
<td></td>
<td>ThermoStream</td>
</tr>
<tr>
<td></td>
<td>ThermalPlate Initialize</td>
<td></td>
<td>Thermal Plate</td>
</tr>
<tr>
<td></td>
<td>ThermalPlate DefineParameters</td>
<td></td>
<td>Thermal Plate</td>
</tr>
</tbody>
</table>

^a Indicates that an additional module, expansion module, or option is required for compatibility.
### Application Library

#### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal</td>
<td>ThermalPlate ControlTemperature</td>
<td>B1505A, B1506A</td>
<td>Thermal Plate</td>
</tr>
<tr>
<td></td>
<td>ThermalPlate WaitTemperature</td>
<td></td>
<td>Thermal Plate</td>
</tr>
<tr>
<td></td>
<td>ThermalPlate ReadTemperature</td>
<td></td>
<td>Thermal Plate</td>
</tr>
<tr>
<td>MultiHVSMU</td>
<td>Switch HVSMU Output Mode</td>
<td>B1505A</td>
<td>HVSMU</td>
</tr>
<tr>
<td>Advanced NVM</td>
<td>FERAM Hysteresis</td>
<td>B1500A</td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>FERAM PUND</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>FERAM Endurance</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>ReRAM IV-Butterfly</td>
<td></td>
<td>SMU 2 (3 for current limit control option), WGFMU 1, RSU 2, GNDU</td>
</tr>
<tr>
<td></td>
<td>ReRAM FORM</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM Set ResetV-Loop</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM Reset SetV-Loop</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM Reset-Set</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM Endurance</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>PCRAM Reset-Set</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>PCRAM ResetV-Loop</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>PCRAM SetV-Loop</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>PCRAM Endurance</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td>Utility (NVM)</td>
<td>FERAM Psw Qsw Graph</td>
<td>B1500A</td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>FERAM PUND Stress</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>FERAM PUND Sub</td>
<td></td>
<td>WGFMU 1, RSU 2</td>
</tr>
<tr>
<td></td>
<td>ReRAM RESET Graph</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM_Endurance_Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM_Reset_Set_Endurance_Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>ReRAM_Reset_Set_Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>PCRAM_Reset_Set_Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td></td>
<td>PCRAM_Reset_Set_Sub (=SetV loop)</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>PCRAM_Reset_Set_Loop-Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>PCRAM_Rm_Sub</td>
<td></td>
<td>WGFMU 1, RSU 2, SPGU 1</td>
</tr>
<tr>
<td></td>
<td>WGFMU Pattern Editor NoRead</td>
<td></td>
<td>WGFMU 1, RSU 2, SMU 1 (Optional)</td>
</tr>
<tr>
<td>Thyristor</td>
<td>Ia-Vak (PULSE)</td>
<td>B1505A, B1506A</td>
<td>HCSMU/UHCU/HVMCU, HP/HR/MPSMU</td>
</tr>
<tr>
<td></td>
<td>Ia-Vak</td>
<td></td>
<td>SMU 2</td>
</tr>
<tr>
<td>Category</td>
<td>Test definition name</td>
<td>Supported instrument</td>
<td>Required equipment and quantity</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Thyristor</td>
<td>IGT, VGT_Ia-Ig</td>
<td>B1505A, B1506A</td>
<td>SMU 2</td>
</tr>
<tr>
<td></td>
<td>IH_Ia-Va</td>
<td>SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IH_Va-Ia</td>
<td>SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IL_Va-Ia</td>
<td>SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off_Ia-Va (PULSE)</td>
<td>HVMCU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off_Ia-Va</td>
<td>HVSMU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R_Ia-Va (PULSE)</td>
<td>HVMCU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R_Ia-Va</td>
<td>HVSMU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VGD, IGD_Ia-Ia-Vgk (PULSE)</td>
<td>HVSMU/HVMCU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VGD, IGD_Ia-Vgk</td>
<td>HVSMU, HP/HR/MPSMU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TM_Ia-Va</td>
<td>HCSMU, HP/HR/MPSMU</td>
<td></td>
</tr>
</tbody>
</table>

See Note 1

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cds</td>
<td>B1505A, B1506A</td>
<td>MFCMU 1, HVSMU 1, Bias-T 1</td>
</tr>
<tr>
<td></td>
<td>Cgd</td>
<td>MFCMU 1, HVSMU 1, Bias-T 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cgs</td>
<td>MFCMU 1, Bias-T 1 or N1259A with 020</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cgs-Vgs</td>
<td>MFCMU 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id(off)-Vds</td>
<td>SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vds</td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Id-Vgs</td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rds-Id</td>
<td>[HCSMU 1 and SMU 1] or SMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vth Vgs(off)</td>
<td>[HCSMU 1 and SMU 1] or SMU/HCSMU 2</td>
<td></td>
</tr>
</tbody>
</table>

See Note 2

See Note 3

See Note 3 (needs test definitions of GateCharge Utilities)

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Qg(High Ic + High Vce + JESD24-2)</td>
<td>B1505A, B1506A</td>
<td>UHCU/HCSMU 1, MCSMU 2, HVSMU 1</td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Ic + High Vce + JESD24-2)</td>
<td>B1505A, B1506A</td>
<td>UHCU/HCSMU 1, MCSMU 2, HVSMU 1</td>
</tr>
<tr>
<td></td>
<td>Qg(High Ic + High Vce)</td>
<td>UHCU/HCSMU 1, MCSMU 2, HVSMU 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Ic + High Vce)</td>
<td>UHCU/HCSMU 1, MCSMU 2, HVSMU 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Ic + JESD24-2)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Ic + JESD24-2)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Ic)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Ic)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Vce + JESD24-2)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Vce)</td>
<td>UHCU/HCSMU 1, MCSMU 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(JESD24-2 High Ic + JESD24-2 High Vce)</td>
<td>MCSMU 2, HVSMU 1</td>
<td></td>
</tr>
</tbody>
</table>

See Note 3 (needs test definitions of GateCharge Utilities)
### Application Library
### Application Test Definitions

<table>
<thead>
<tr>
<th>Category</th>
<th>Test definition name</th>
<th>Supported instrument</th>
<th>Required equipment and quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>See Note 4 (needs test definitions of GateCharge Utilities)</td>
<td>Qg(High Id + High Vds + JESD24-2)</td>
<td>B1505A, B1506A</td>
<td>UHCU/HCSMU 1, MCSMU 2, HVSMU 1</td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Id + High Vds + JESD24-2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Id + High Vds)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Id + High Vds)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Id + JESD24-2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Id + JESD24-2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Id)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(R Load High Id)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Vds + JESD24-2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(High Vds)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Qg(JESD24-2 High Id + JESD24-2 High Vds)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. This test definition cannot be executed individually. It is called from other test definitions.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note 1
These test definitions belong to the categories PMIC, PowerMOSFET, and SiC.

### Note 2
This test definition belongs to the categories IGBT, MISCAP, PMIC, PowerMOSFET, and SiC.

### Note 3
These test definitions belong to the categories IGBT and GateCharge.

### Note 4
These test definitions belong to the categories PowerMOSFET and GateCharge.
Figure 1  
DUT connections for using B2900 test definitions [1HL]

Figure 2  
DUT connections for using B2900 test definitions [2HL]
QSCV Maximum Measurement Value and Accuracy

This section describes the maximum measurement value and accuracy for the result data measured by using the QSCV[2] application test. These values do not guarantee the measurement performance. They are just the supplemental information.

- “Maximum Measurement Value”
- “Measurement Accuracy”

NOTE
To obtain stable measurement results, use two source monitor units (SMU). Assign the current meter and the voltage sweep source to the individual SMU.

Maximum Measurement Value

NOTE
The maximum measurement value is not the specifications but the supplemental data.

Even if the capacitance is within this range, measurement may not be completed due to influences on the measurement path such as extension cables, etc. The maximum measurement value will be smaller depending on the leakage current.

The maximum measurement value depends on the settings of the current measurement range, the QSCV measurement voltage, and the integration time. See Figure 9-1 to Figure 9-5. Each figure shows the characteristics of the capacitance value vs. the QSCV measurement voltage by the integration time setting. Each line in the graph specifies the maximum measurement value for each integration time setting.

The graph data is applied to the measurement when the QSCV integration time is set to the same value as the LEAK integration time.
**Figure 9-1**  
Maximum Measurement Value Using 10 pA and 100 pA Range: HRSMU, ASU+SMU

**Figure 9-2**  
Maximum Measurement Value Using 1 nA Range: HPSMU, MPSMU, HRSMU, ASU+SMU
Figure 9-3  Maximum Measurement Value Using 10 nA Range: HPSMU, MPSMU, HRSMU, ASU+SMU

![Graph showing maximum measurement value using 10 nA range for QSCV measurement voltage and capacitance.](image)

Figure 9-4  Maximum Measurement Value Using 100 nA Range: HPSMU, MPSMU, HRSMU, ASU+SMU

![Graph showing maximum measurement value using 100 nA range for QSCV measurement voltage and capacitance.](image)
Figure 9-5  Maximum Measurement Value Using 1 μA Range: HPSMU, MPSMU, HRSMU, ASU+SMU

![Graph showing the relationship between QSCV Measurement Voltage (V) and Capacitance (F) for different integration times. The graph includes data points for 2s, 1s, 500ms, 300ms, 100ms, 50ms, and 30ms integration times.](image-url)
**Measurement Accuracy**

The measurement accuracy is not the specifications but the supplemental data. Applicable conditions for supplemental data: Leak current compensation function ON, Offset cancel function ON, QSO mode OFF

The measurement accuracy can be calculated by the following formula:

\[
\text{Measurement accuracy} = A \% + B (F)
\]

\(A\): Reading accuracy. % accuracy of the measured value.

\(B\): Offset accuracy.

\[
A = A_p + \frac{B_p + C_p \times T_{integ} + D_p \times \frac{T_{integ}}{T_{leak}}}{V_{step}}
\]

\[
B = \frac{A_o}{R_{dut}} + \frac{B_o \times C_g + (C_o + C_{oc} \times C_g) \times T_{integ} + (D_o + D_{oc} \times C_g) \times \frac{T_{integ}}{T_{leak}}}{V_{step}}
\]

where,

- \(T_{integ}\): Integration time for the capacitance measurement, in seconds
- \(T_{leak}\): Integration time for the leakage current measurement, in seconds
- \(V_{step}\): QSCV measurement voltage, in V
- \(R_{dut}\): Equivalent parallel resistance of DUT, in \(\Omega\)
- \(C_g\): Guard capacitance of the measurement path, in F

Ax, Bx, Cx, and Dx values are the constant. For the values, see Table 9-2 to Table 9-4.

Calculation examples of the measurement accuracy are shown in Figure 9-6 through Figure 9-30. Conditions of the calculation are shown in Table 9-5.

**NOTE**

Settings for the QSCV Measurement Mode

The measurement mode should be selected based on the measurement conditions. Normal mode is effective for large leakage currents. The 4155C/4156C compatible mode is effective if the leakage current is low, or the QSCV measurement voltage is low.
### Table 9-2 Constant Value for Calculating the Measurement Accuracy: HRSMU, ASU+SMU

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Constant</th>
<th>Voltage Output Range</th>
<th>QSCV Operating Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.5 V</td>
<td>2 V</td>
</tr>
<tr>
<td>10 pA</td>
<td>Ap</td>
<td>0.47</td>
<td>0.47</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.013</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.04</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.07</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>1.3E-16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>1.1E-05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>5.4E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>2.4E-05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>1.3E-16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>1.1E-05</td>
<td></td>
</tr>
<tr>
<td>100 pA</td>
<td>Ap</td>
<td>0.31</td>
<td>0.31</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.009</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.002</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.071</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>4.7E-16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>3.5E-05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>1.3E-14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>9.8E-05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>4.7E-16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>3.5E-05</td>
<td></td>
</tr>
</tbody>
</table>
### Application Library

#### QSCV Maximum Measurement Value and Accuracy

**Table 9-3**  
Constant Value for Calculating the Measurement Accuracy: MPSMU, HRSMU, ASU+SMU

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Constant</th>
<th>Voltage Output Range</th>
<th>QSCV Operating Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.5 V</td>
<td>2 V</td>
</tr>
<tr>
<td>1 nA</td>
<td>Ap</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.026</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.014</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>1.3E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>5.9E-14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>4.5E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>1.3E-04</td>
<td></td>
</tr>
<tr>
<td>10 nA</td>
<td>Ap</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.031</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.015</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>7.3E-05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>3.9E-14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>1.9E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>7.3E-05</td>
<td></td>
</tr>
</tbody>
</table>
## Application Library
### QSCV Maximum Measurement Value and Accuracy

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Constant</th>
<th>Voltage Output Range</th>
<th>QSCV Operating Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.5 V</td>
<td>2 V</td>
</tr>
<tr>
<td>100 nA</td>
<td>Ap</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 μA</td>
<td>Ap</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.014</td>
<td>0.029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.009</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Table 9-4  Constant Value for Calculating the Measurement Accuracy: HPSMU

<table>
<thead>
<tr>
<th>Measurement Range</th>
<th>Constant</th>
<th>Voltage Output Range</th>
<th>QSCV Operating Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>2 V</td>
<td>20 V</td>
</tr>
<tr>
<td>1 nA</td>
<td>Ap</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.033</td>
<td>0.149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0100</td>
<td>0.03</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.026</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.014</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 nA</td>
<td>Ap</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.033</td>
<td>0.149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0100</td>
<td>0.03</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td>0.031</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td>0.015</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td>0.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>1.3.0E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>5.9E-14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>4.5.0E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>1.3.0E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td>1.3.0E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td>3.9E-14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td>1.9.0E-04</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td>1.7E-15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td>7.3E-05</td>
<td></td>
</tr>
<tr>
<td>Measurement Range</td>
<td>Constant</td>
<td>Voltage Output Range</td>
<td>QSCV Operating Mode</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 V</td>
<td>20 V</td>
</tr>
<tr>
<td>100 nA</td>
<td>Ap</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.033</td>
<td>0.149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0100</td>
<td>0.03</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td></td>
<td>0.209</td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td></td>
<td>0.023</td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td></td>
<td>0.01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.04</td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td></td>
<td>2.4E-15</td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td></td>
<td>2.0E-04</td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td></td>
<td>8.7E-12</td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td></td>
<td>4.6E-04</td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td></td>
<td>2.4E-15</td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td></td>
<td>2.0E-04</td>
</tr>
<tr>
<td>1 µA</td>
<td>Ap</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td></td>
<td>Bp</td>
<td>0.033</td>
<td>0.149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0100</td>
<td>0.03</td>
</tr>
<tr>
<td></td>
<td>Cp</td>
<td></td>
<td>0.125</td>
</tr>
<tr>
<td></td>
<td>Dp</td>
<td></td>
<td>0.021</td>
</tr>
<tr>
<td></td>
<td>Ao</td>
<td></td>
<td>0.01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.04</td>
</tr>
<tr>
<td></td>
<td>Bo</td>
<td></td>
<td>1.1E-14</td>
</tr>
<tr>
<td></td>
<td>Boc</td>
<td></td>
<td>4.0E-05</td>
</tr>
<tr>
<td></td>
<td>Co</td>
<td></td>
<td>3.1E-12</td>
</tr>
<tr>
<td></td>
<td>Coc</td>
<td></td>
<td>3.5E-04</td>
</tr>
<tr>
<td></td>
<td>Do</td>
<td></td>
<td>1.1E-14</td>
</tr>
<tr>
<td></td>
<td>Doc</td>
<td></td>
<td>4.0E-05</td>
</tr>
</tbody>
</table>
Table 9-5  Conditions for Calculating Measurement Accuracy

<table>
<thead>
<tr>
<th>Measurement range</th>
<th>QSCV operating mode</th>
<th>Output range</th>
<th>Equivalent parallel resistance of DUT</th>
<th>Guard capacitance of measurement path</th>
<th>Measurement accuracy calculation result</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 pA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-6</td>
</tr>
<tr>
<td>100 pA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-7</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-8</td>
</tr>
<tr>
<td>1 nA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-9</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-11</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 GΩ</td>
<td>200 pF</td>
<td>Figure 9-12</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>1 GΩ</td>
<td>200 pF</td>
<td>Figure 9-13</td>
</tr>
<tr>
<td>10 nA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-14</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 GΩ</td>
<td>200 pF</td>
<td>Figure 9-15</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>1 GΩ</td>
<td>200 pF</td>
<td>Figure 9-16</td>
</tr>
<tr>
<td>100 nA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-17</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>1 GΩ</td>
<td>200 pF</td>
<td>Figure 9-18</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>100 MΩ</td>
<td>200 pF</td>
<td>Figure 9-19</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 MΩ</td>
<td>200 pF</td>
<td>Figure 9-20</td>
</tr>
<tr>
<td>1 μA</td>
<td>Normal</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-21</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>1 GΩ</td>
<td>200 pF</td>
<td>Figure 9-22</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>100 MΩ</td>
<td>200 pF</td>
<td>Figure 9-23</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>20 V</td>
<td>10 MΩ</td>
<td>200 pF</td>
<td>Figure 9-24</td>
</tr>
<tr>
<td>10 pA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-25</td>
</tr>
<tr>
<td>100 pA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-26</td>
</tr>
<tr>
<td>1 nA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-27</td>
</tr>
<tr>
<td>10 nA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-28</td>
</tr>
<tr>
<td>100 nA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-29</td>
</tr>
<tr>
<td>1 μA</td>
<td>4155C/4156C compatible</td>
<td>20 V</td>
<td>10 TΩ</td>
<td>200 pF</td>
<td>Figure 9-30</td>
</tr>
</tbody>
</table>

Calculation example data shown in Figure 9-6 through Figure 9-30 is applied to the measurement data when the QSCV integration time $T_{integ}$ is equal to the LEAK integration time $T_{leak}$. 
Conditions:

QSCV Operating Mode: Normal
Measurement Range: 10 pA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Application Library
QSCV Maximum Measurement Value and Accuracy

Figure 9-7
Calculation Example of Measurement Accuracy: HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 100 pA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
**Figure 9-8** Calculation Example of Measurement Accuracy: HRSMU, ASU+SMU

Conditions:
- **QSCV Operating Mode**: Normal
- **Measurement Range**: 100 pA
- **Output Range**: 20 V
- **Integration Time**: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
- **Equivalent Parallel Resistance of DUT**: 10 TΩ
- **Guard Capacitance of Measurement Path**: 1 nF
Figure 9-9  Calculation Example of Measurement Accuracy: HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 100 pA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 100 GΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-10  
Calculating Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:

QSCV Operating Mode: Normal  
Measurement Range: 1 nA  
Output Range: 20 V  
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom  
Equivalent Parallel Resistance of DUT: 10 TΩ  
Guard Capacitance of Measurement Path: 200 pF
Application Library
QSCV Maximum Measurement Value and Accuracy

**Figure 9-11** Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

<table>
<thead>
<tr>
<th>QSCV Measurement Voltage (V)</th>
<th>Reading Accuracy (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.001</td>
<td>1.0E-14</td>
</tr>
<tr>
<td>0.01</td>
<td>1.0E-13</td>
</tr>
<tr>
<td>0.1</td>
<td>1.0E-12</td>
</tr>
<tr>
<td>1</td>
<td>1.0E-11</td>
</tr>
<tr>
<td>10</td>
<td>0.001</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>QSCV Measurement Voltage (V)</th>
<th>Offset Accuracy (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.001</td>
<td>1.0E-14</td>
</tr>
<tr>
<td>0.01</td>
<td>1.0E-13</td>
</tr>
<tr>
<td>0.1</td>
<td>1.0E-12</td>
</tr>
<tr>
<td>1</td>
<td>1.0E-11</td>
</tr>
<tr>
<td>10</td>
<td>1.0E-10</td>
</tr>
</tbody>
</table>

Conditions:
- QSCV Operating Mode: Normal
- Measurement Range: 1 nA
- Output Range: 20 V
- Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
- Equivalent Parallel Resistance of DUT: 10 TΩ
- Guard Capacitance of Measurement Path: 1 nF
**Figure 9-12**

**Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU**

<table>
<thead>
<tr>
<th>Reading Accuracy (%)</th>
<th>QSCV Measurement Voltage (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.E-14</td>
<td>0.001</td>
</tr>
<tr>
<td>1.E-13</td>
<td>0.01</td>
</tr>
<tr>
<td>1.E-12</td>
<td>0.1</td>
</tr>
<tr>
<td>1.E-11</td>
<td>1</td>
</tr>
<tr>
<td>1.E-10</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Offset Accuracy (F)</th>
<th>QSCV Measurement Voltage (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.E-14</td>
<td>0.001</td>
</tr>
<tr>
<td>1.E-13</td>
<td>0.01</td>
</tr>
<tr>
<td>1.E-12</td>
<td>0.1</td>
</tr>
<tr>
<td>1.E-11</td>
<td>1</td>
</tr>
<tr>
<td>1.E-10</td>
<td>10</td>
</tr>
</tbody>
</table>

**Conditions:**

- QSCV Operating Mode: Normal
- Measurement Range: 1 nA
- Output Range: 20 V
- Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
- Equivalent Parallel Resistance of DUT: 10 GΩ
- Guard Capacitance of Measurement Path: 200 pF
Figure 9-13  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 1 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 1 GΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-14  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:

QSCV Operating Mode: Normal
Measurement Range: 10 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
**Conditions:**

- **QSCV Operating Mode:** Normal
- **Measurement Range:** 10 nA
- **Output Range:** 20 V
- **Integration Time:** 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
- **Equivalent Parallel Resistance of DUT:** 10 GΩ
- **Guard Capacitance of Measurement Path:** 200 pF
Figure 9-16  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 10 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 1 GΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-17 Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 100 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-18  

Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:

QSCV Operating Mode: Normal  
Measurement Range: 100 nA  
Output Range: 20 V  
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom  
Equivalent Parallel Resistance of DUT: 1 GΩ  
Guard Capacitance of Measurement Path: 200 pF
Conditions:

QSCV Operating Mode: Normal
Measurement Range: 100 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 100 MΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-20  

Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 100 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 MΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-21

Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 1 μA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-22  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:

QSCV Operating Mode: Normal
Measurement Range: 1 μA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 1 GΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-23
Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 1 μA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 100 MΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-24 Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: Normal
Measurement Range: 1 μA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 MΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-25  Calculation Example of Measurement Accuracy: HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 10 pA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-26  Calculation Example of Measurement Accuracy: HRSMU, ASU+SMU

Conditions:

QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 100 pA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-27  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 1 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Figure 9-28  Calculation Example of Measurement Accuracy: MP/HRSMU, ASU+SMU

Conditions:
QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 10 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Conditions:
QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 100 nA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Conditions:

QSCV Operating Mode: 4155C/4156C compatible
Measurement Range: 1 μA
Output Range: 20 V
Integration Time: 2, 1, 0.5, 0.3 s corresponding to the lines from top to bottom
Equivalent Parallel Resistance of DUT: 10 TΩ
Guard Capacitance of Measurement Path: 200 pF
Application Library
QSCV Maximum Measurement Value and Accuracy
If You Have a Problem

This chapter explains how to solve problems if you encounter some problems. This chapter consists of the following sections.

- “When You Operate B1500”
- “When You Perform Measurement”
- “Notice for Migrating from 4155/4156”
- “Before Shipping to Service Center”
- “Data Backup and Recovery”
- “Updating EasyEXPERT”
- “Performing a Clean Install of EasyEXPERT”
- “B1500 System Recovery”

If error occurs, find solutions in the following sections and solve problems. However, if problems still remain, perform self-test. Also see Chapter 11, “Error Message.”

If Keysight B1500 fails self-test, contact Keysight Technologies.

To get the latest firmware/software/manual/support information, go to www.keysight.com/find/easyexpert.

NOTE

This manual uses the following conventions.

- For Windows 7/8.1/10 64 bit version
  <program folder>: <system drive>:\Program Files (x86)
  <common data folder>: <system drive>:\ProgramData

- For Windows Vista, 7/8.1/10 32 bit version
  <program folder>: <system drive>:\Program Files
  <common data folder>: <system drive>:\ProgramData

- For Windows XP
  <program folder>: <system drive>:\Program Files
  <common data folder>:
  <system drive>:\Documents and Settings\All Users\Application Data

  <system drive>: Drive the EasyEXPERT has been installed
When You Operate B1500

This section covers the following basic problems that you may encounter when you install or operate the B1500, and the solutions.

- “Power On Trouble”
- “SCUU is not Detected”
- “ASU is not Detected”
- “N1265A/N1266A/N1268A is not Detected”
- “GPIB Devices are not Detected”
- “To Simplify the Connections”

To set up the B1500 built-in Windows, see Keysight B1500 User’s Guide.

If you need to reinstall Keysight EasyEXPERT software, see “Performing a Clean Install of EasyEXPERT” on page 10-21

Power On Trouble

- Connect the power cable to the instrument firmly.
- Connect the power cable to power outlet firmly.
- Open the measurement terminals, and set the Standby switch to the ON position.

NOTE

Open the measurement terminals at the device side when turning the B1500 on. Also disconnect the device from the measurement terminals and open the measurement terminals after the measurement. If you leave the connection with the device, the device may be damaged by unexpected operations or charge-up of measurement cables.

SCUU is not Detected

If EasyEXPERT cannot detect SCUU (SMU CMU unify unit), turn the instrument off, check the cable connection, and reboot it.

For the installation and connection of SCUU, see Keysight B1500A User’s Guide.
If You Have a Problem
When You Operate B1500

**ASU is not Detected**

If EasyEXPERT cannot detect ASU (atto sense/switch unit), turn the instrument off, check the cable connection, and reboot it.

For the installation and connection of ASU, see *User’s Guide* of the instrument.

**NOTE**

**Connect ASU to dedicated SMU**

The specifications are satisfied and guaranteed for the exclusive combination of the ASU and the SMU. So confirm the serial number of the ASU and connect it to the dedicated SMU properly.

**N1265A/N1266A/N1268A is not Detected**

If EasyEXPERT cannot detect any of the following fixtures, turn the instrument off, check the cable connection, and reboot it.

- N1265A Ultra High Current Expander/Fixture
- N1266A HVSMU Current Expander
- N1268A Ultra High Voltage Expander

For the installation and connection of these fixtures, see Keysight B1505A *User’s Guide* and *Configuration and Connection Guide*.

**GPIB Devices are not Detected**

If EasyEXPERT cannot detect the GPIB devices, turn the all GPIB devices off, check the GPIB cable connection, and reboot them.

**NOTE**

For GPIB connection between the instruments, use Keysight 82350B/C (for PCI bus), Keysight 82351A/B (for PCIe bus), Keysight 82357A/B (for USB/GPIB), or National Instrument GPIB-USB-HS.

When using the USB/GPIB interface, Keysight recommends to set the GPIB address of the instrument to even address. Error may occurs at serial polling due to the differences of internal communication system. It is reported that even GPIB address reduces the occurrence of this error remarkably.

If you control GPIB devices from the B1500, see the following consideration.

1. Confirm if the B1500 is set to the system controller. To enable the system controller, see Keysight B1500 *User’s Guide*.
2. If the problem still remains, confirm if the B1500 is connected to USB0. Open Keysight Connection Expert, check Instrument I/O on this PC. The USB0 in this area must show the information as shown below.

```
USB0
  + B1500A(USB0::xxxx::x::xxxx::x::INSTR)
  + agb1500a
  + UsbDevice1
```

If “agb1500A” and “UsbDevice1” are not listed, add them by using a dialog box which is opened by right-clicking on B1500A(USB0:: . . ::INSTR) and selecting “Add VISA Alias” from the menu. For more information, see Connectivity Guide opened from the Help menu on the Connection Expert window.

**To Simplify the Connections**

If you want to simplify the cable connections of the SMU such as Keysight B1500/ E5260/E5270 which has the Kelvin triaxial measurement terminals, use the triaxial cables instead of the Kelvin triaxial cables, and connect the triaxial cables between the Force terminals and the test fixture or the connector plate. Then the Sense terminals must be opened.

---

**NOTE**

Typical SMU has the Force and Sense terminals to make the Kelvin connection. And the Kelvin triaxial cables are effective to extend the measurement terminals near by the device under test. Connecting the Force and Sense lines together at the device terminals can minimize the measurement error caused by the residual resistance of the connection cables. The Kelvin connection is effective for the low resistance measurement and the high current measurement. Also it is one of the conditions to satisfy the measurement specifications of the SMU.
When You Perform Measurement

This section covers the following basic problems that you may encounter when you making a measurement, and the solutions.

- “Measurement Takes More Time than Specified”
- “Noise Affects the Measured Values”
- “Voltage Measurement Error is Large”
- “SMU Oscillates for High-Frequency Device Measurements”
- “SMU Oscillates for Negative Resistance Measurements”
- “Large Current Causes High Temperature (Thermal Drift)”
- “Measurement Damages the Device under Test”
- “Leaving Connections Damages Devices after Measurement”
- “Unexpected Sampling Measurement Data is Returned”
- “MFCMU Causes Unbalance Condition”

Measurement Takes More Time than Specified

If you set many measurement channels, auto ranging mode, or too long integration time, measurement takes a longer time.

To solve this problem:

Depending on your measurement requirements, perform following:

- Decreases measurement channels.
- Uses limited auto ranging mode.
- Uses fixed range.
- Decreases averaging samples of the high-speed A/D converter.
- Decreases integration time of the high-resolution A/D converter.
- Disables the ADC zero function.
Noise Affects the Measured Values

When you measure low current of a DUT, the measured values may not be stable.

To solve this problem:

- Set the power line frequency correctly. The value affects the integration time. So the wrong value causes the measurement error by the power line noise. You can set the power line frequency by using the Configuration window of the EasyEXPERT.

- Use guarding to reduce the leakage current between your prober and the B1500. Note that long wires cause oscillation because of their large inductance.

- If some high-power electric machines are operating around the instrument, turn off the machines, then perform the measurements. The machines affect the power line waveform.

- Shut the lid of test fixture or shield box to prevent effects of light.

- If these are vibrations due to nearby machines or due to air flow, put cushioning material under prober, cable, and the instrument; install stabilizer on the prober; and make the cables stable by taping.

- Wait several minutes after connecting cables or moving probe needles. Because these operations cause electromotive force.

- If you use only Force terminal and triaxial cables, connect an open cap to Sense terminal.

- Keep constant temperature in the room. Shift of 1 °C may shift the measurement values. Temperature change causes the following.
  - Offset current in the SMU.
  - Thermoelectromotive force in DUT, which causes low current.
  - Expansion and contraction of cables, which causes noise.
If You Have a Problem
When You Perform Measurement

**Voltage Measurement Error is Large**

Voltage measurement error may be large because of the effects of the cable resistance when forcing a large current.

To solve this problem:

- Use kelvin connections between SMUs and DUT. To cancel the effects of cable resistance, connect the sense line as close as possible to the terminal of the DUT.

**SMU Oscillates for High-Frequency Device Measurements**

When measuring parameters of high-frequency devices, such as GaAs MESFETs or high-frequency bipolar transistors, oscillation may cause measurement problems. Normal measurement cannot be performed because of oscillation.

To solve this problem:

- For FETs, add resistive ferrite beads as close as possible to the gate.
- For bipolar transistors, add resistive ferrite beads as close as possible to the base or emitter.
- Make connection cables as short as possible. Long wires cause oscillation because of their large inductance.
SMU Oscillates for Negative Resistance Measurements

If the DUT has negative resistance characteristics, SMUs may oscillate. Because the positive feedback may be configured by the DUT and the SMUs.

To solve this problem:

- For voltage controlled negative resistance device
  - Connect G in parallel with your DUT to cancel negative resistance. To obtain an output I-V curve, use the following equation.
    \[ I_Y = I - G \times V \]

- For current controlled negative resistance device
  - Connect R in series with your DUT to cancel negative resistance. To obtain an output I-V curve, use the following equation.
    \[ V_Z = V - R \times I \]
  - If the resistance of the DUT is less than 1 MΩ, you can use a series resistor built into the SMU.
Large Current Causes High Temperature (Thermal Drift)
If a large current is forced to a DUT, the temperature of the DUT may increase, which may cause characteristics to drift.
To solve this problem:
• Use the pulse output mode of the SMU.
  For large currents, the SMU should be set to pulse output mode. This decreases the average power output to prevent temperature rise of DUT.

Measurement Damages the Device under Test
When performing breakdown measurements, DUTs may be damaged.
When voltage is forced from an SMU, the current is limited by the compliance setting, which prevents the DUT from being damaged by a large current. But when the current rapidly increases, the current limiter in the SMU cannot follow the rapid current increase, so a large amount of current may flow through the DUT for a moment, which may damage the DUT.
To solve this problem:
• Insert a protecting resistor as close as possible to DUT. You can also use a series resistor built into the SMU.

Leaving Connections Damages Devices after Measurement
After the measurements, open the measurement terminals or disconnect the device under test from the measurement terminals. If you leave the connection with the device, the device may be damaged by unexpected operations.
Do not leave the connection over 30 minutes after the measurement if the auto calibration is set to ON. Then, the instrument performs the self-calibration automatically every 30 minutes after the measurement. The calibration requires to open the measurement terminals.

NOTE
Open the measurement terminals and never connect anything when the calibration is performed.
Unexpected Sampling Measurement Data is Returned

If sampling interval is set to a short time and if FILTER ON is set, you may get unwanted data. FILTER ON causes a slower rise time, so short initial interval will sample during this rise time.

To solve this problem:

• Set FILTER field to OFF if you set initial interval to a short time.

Some data may be skipped because measurement takes a long time. Measurement takes a long time if measurement is performed in a low current range, if many measurement channels are set up, or if analysis, such as moving a marker, is performed during measurements.

To solve this problem:

• Measure current using a fixed range that is more than 10 μA. For measurement ranges 10 μA or less, measurement takes longer than the specified integration time.

• Do not perform analysis operation during measurement state.

MFCMU Causes Unbalance Condition

Extending measurement cables may cause the unbalance condition of the MFCMU.

To solve this problem:


• The signal path from MFCMU to DUT must be as short as possible.

• Reduce stray capacitance and guard capacitance on the signal line.

Do not connect the Low (Lcur, Lpot) terminal to the wafer chuck. If the MFCMU must be connected to the wafer chuck, use the High (Hcur, Hpot) terminal to connect to the wafer chuck.
Notice for Migrating from 4155/4156

The measurement instruments have individual integration time settings depending on the hardware. It is called as Default Integration Time. When migrating from 4155/4156, consider the difference of the default integration time between the instruments shown in the following tables.

**Table 10-1** Instrument’s Default Integration Time for Current Measurement Using HR-ADC (N PLC, N≥2)

<table>
<thead>
<tr>
<th>Current Measurement Range</th>
<th>B1500A/E5270B (HR/MP/HPSMU)</th>
<th>4155/4156 (Long)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>HRSMU</td>
</tr>
<tr>
<td>1 pA</td>
<td>Setting × 1</td>
<td>N/A</td>
</tr>
<tr>
<td>10 pA</td>
<td>Setting × 1</td>
<td>Always 100 PLC</td>
</tr>
<tr>
<td>100 pA</td>
<td>Setting × 1</td>
<td>Setting × 10</td>
</tr>
<tr>
<td>1 nA</td>
<td>Setting × 1</td>
<td>Setting × 5</td>
</tr>
<tr>
<td>10 nA to 100 mA</td>
<td>Setting × 1</td>
<td></td>
</tr>
<tr>
<td>1 A</td>
<td>Setting × 1</td>
<td></td>
</tr>
</tbody>
</table>

**Table 10-2** Instrument’s Default Integration Time for Current Measurement Using HR-ADC (1 PLC)

<table>
<thead>
<tr>
<th>Current Measurement Range</th>
<th>B1500A/E5270B (HR/MP/HPSMU)</th>
<th>4155/4156 (Medium)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>HRSMU</td>
</tr>
<tr>
<td>1 pA</td>
<td>Setting × 1</td>
<td>N/A</td>
</tr>
<tr>
<td>10 pA</td>
<td>Setting × 1</td>
<td>50 PLC</td>
</tr>
<tr>
<td>100 pA</td>
<td>Setting × 1</td>
<td>10 PLC</td>
</tr>
<tr>
<td>1 nA</td>
<td>Setting × 1</td>
<td>5 PLC</td>
</tr>
<tr>
<td>10 nA to 100 mA</td>
<td>Setting × 1</td>
<td></td>
</tr>
<tr>
<td>1 A</td>
<td>Setting × 1</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Table 10-3  Instrument’s Default Integration Time for Current Measurement Using HR-ADC (Short/Auto)

<table>
<thead>
<tr>
<th>Current Measure-ment Range</th>
<th>Voltage Force Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B1500A/E5270B a (HR/MP/HP/SMU)</td>
</tr>
<tr>
<td></td>
<td>≤ 5 V</td>
</tr>
<tr>
<td>1 pA</td>
<td>16 samples</td>
</tr>
<tr>
<td>10 pA</td>
<td>16 samples</td>
</tr>
<tr>
<td>100 pA</td>
<td>8 samples</td>
</tr>
<tr>
<td>1 nA</td>
<td>4 samples</td>
</tr>
<tr>
<td>10 nA</td>
<td>4 samples</td>
</tr>
<tr>
<td>100 nA</td>
<td>10 samples</td>
</tr>
<tr>
<td>1 μA</td>
<td>1 sample</td>
</tr>
<tr>
<td>10 μA</td>
<td>2 samples</td>
</tr>
<tr>
<td>100 μA to 100 mA</td>
<td>1 sample</td>
</tr>
<tr>
<td>1 A</td>
<td>1 sample</td>
</tr>
</tbody>
</table>

a. 1 sample is 80 μs.
Before Shipping to Service Center

Before shipping Keysight B1500 to the Service Center, you have to do following:

• “To Make Backup”
• “To Check Module Slots”
• “To Check ASU/SMU Combination”
• “To Collect Equipment and Accessories”

To Make Backup

If the internal solid state drive (SSD) is failed, you will lose all data stored in the SSD. So it is important to make backup constantly.

Before shipping the B1500 to the service center, make backup of data in the SSD. And keep the backup media in trust. You may need to perform data recovery of the B1500 returned from the service center.

If the SSD is replaced, the B1500 will be returned with the latest revision of the software.

To Check Module Slots

Do not remove the plug-in module from the mainframe. The B1500 must be shipped with all modules. The module cannot be repaired without the mainframe. If a module is removed and installed by anyone who is not a service personnel of Keysight Technologies, the specifications are not guaranteed.

To Check ASU/SMU Combination

When you ship the B1500A used with the atto sense/switch unit (ASU), disconnect the ASU cable set (triaxial and Dsub) between the ASU and the SMU, and ship the mainframe, the ASU cable set, and the ASU. The ASU can be used with the exclusive SMU. To confirm the ASU/SMU combination, check the serial number. See “ASU” in “Configuration”, Chapter 1, User’s Guide Vol. 1.
To Collect Equipment and Accessories

All equipment and accessories used with Keysight B1500 are required for servicing and must be shipped to the Service Center. For details, contact the Service Center.

- B1500 mainframe with all plug-in modules installed
- Test fixture and system cable furnished with the B1506A/B1507A
- ASU and connection cable set between ASU and SMU
- RSU and connection cable set between RSU and WGFMU
- N1265A ultra high current expander/fixture and connection cables
- N1266A HVSMU current expander and connection cables
- N1267A HVSMU/HCSMU fast switch and connection cables
- N1268A ultra high voltage expander and connection cables

For returning ASU or RSU, do not forget to notify the combination of the unit, connection cable, and module channel.

The connection cable set between ASU and SMU means one of the following.

- E5288A-001 Triaxial and D-sub cables, 1.5 m
- E5288A-002 Triaxial and D-sub cables, 3 m

The connection cable set between RSU and WGFMU means one of the following.

- 16493R-003 3 m Cable between WGFMU and RSU
- 16493R-004 5 m Cable between WGFMU and RSU
- 16493R-006 1.5 m Cable between WGFMU and RSU
- 16493R-001 and 002 60 cm Cable and 2.4 m Cable between WGFMU and RSU
- 16493R-001 and 005 60 cm Cable a nd 4.4 m Cable between WGFMU and RSU

WARNING

To prevent electrical shock, turn off Keysight B1500 and remove the power cable before removing the connection cables.
Data Backup and Recovery

Unexpected trouble of SSD (solid state drive), operation mistake, or malfunction may cause elimination of valuable data. To avoid this kind of risk, make backup of data in the SSD as frequently as possible.

- “Folders to Backup”
- “To Make Database Backup”
- “To Restore Database Backup”
- “To Make Backup of Other Data”
- “To Restore Backup of Other Data”
- “To Move the EasyEXPERT Database”

NOTE

Drive for making backup

Make backup into the storage device that has large free space and can be accessed by the B1500 directly. The device may be the D drive, a USB memory, an external HDD with USB interface and such.

If you make backup into the B1500 internal SSD, C drive or D drive, make a copy of the backup into an external storage device or backup media, CD-ROM, CD-RW, USB memory and such.
Folders to Backup

Backup should be made for the following data areas.

- EasyEXPERT database and setup files
  See Table 10-4.
- Personal folders, below C:\Users
  Example: C:\Users\B1500user
- Folders that store the data exported by EasyEXPERT
- Other folders that store the data to be saved

Table 10-4 Location of EasyEXPERT Database and Setup Files

<table>
<thead>
<tr>
<th>Platform</th>
<th>Database</th>
<th>Setup Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1500 mainframe</td>
<td>D:\Agilent\EasyEXPERT\1</td>
<td>D:\Agilent\EasyEXPERT\User</td>
</tr>
<tr>
<td>External PC installed with Windows XP</td>
<td>C:\Program Files\Agilent\B1500 \EasyEXPERT\User\1</td>
<td>C:\Program Files\Agilent\B1500 \EasyEXPERT\Usera</td>
</tr>
<tr>
<td>External PC installed with Windows Vista, Windows 7/8.1/10</td>
<td>C:\ProgramData\Agilent \EasyEXPERT\User\Database\1</td>
<td>C:\ProgramData\Agilent \EasyEXPERTa</td>
</tr>
</tbody>
</table>

a. This folder contains the EasyEXPERT database.

To Make Database Backup

EasyEXPERT database backup can be made by the following procedure.

1. Launch Start EasyEXPERT.
2. Click Option > EasyEXPERT Database > Backup EasyEXPERT Database in the Start EasyEXPERT window.
3. Follow the EasyEXPERT Database Backup Creation wizard, and make backup into the D drive. The extension of the backup file is xdb.
4. Make a copy of the xdb file into an external storage device or backup media.
   Example: COPY EasyEXPERT_backup_1.xdb F:\
To Restore Database Backup

EasyEXPERT database can be restored by the following procedure.

1. Make a copy of the database backup file (xdb file) into the D drive.
2. Launch Start EasyEXPERT.
3. Click Option > EasyEXPERT Database > Restore EasyEXPERT Database in the Start EasyEXPERT window.
4. Follow the EasyEXPERT Database Restoration wizard, and restore the backup of EasyEXPERT database.

**NOTE**

*If the backup is not the xdb file*

The backup for recovery must be “a copy of the folder that contains the EasyEXPERT database image”. And it must be stored in the location other than the following folders.

- D:\Agilent folder
- EasyEXPERT database folder

For the compressed backup (zip file or other) or the Windows backup (bkf file), uncompress the backup file at the location other than the above folders. And launch the wizard after the uncompression is completed.

Also, for the Backup Type Selection of the wizard, select “A Copy of the folder that contains the EasyEXPERT database image” and follow the wizard.

To Make Backup of Other Data

Backup of the data other than the EasyEXPERT database can be made by the following procedure.

1. Connect an external storage device, USB memory, HDD with USB interface and such, to the B1500.
2. Make a copy of the folder into the external storage device.

   Example: XCOPY Folder_user_1 F:\Backup_user_1
To Restore Backup of Other Data

Data other than the EasyEXPERT database can be restored by the following procedure.

1. Connect the external storage device which stores the backup to the B1500.
2. Make a copy of the backup into the D drive.
   
   **Example:** `XCOPY F:\Backup_user_1 Backup_user_1`
3. Delete the original folder.
   
   **Example:** `RMDIR /S Folder_user_1`
4. Change the name of the backup to the original one.
   
   **Example:** `RENAME Backup_user_1 Folder_user_1`

To Move the EasyEXPERT Database

When the SDD (solid state drive) is full, add a humongous drive and move the EasyEXPERT database to it. To move the database, follow the procedure below. Required time depends on the database size.

1. Launch Start EasyEXPERT.
   
   If the Execution Mode dialog box is opened, click the Cancel button.
   
   If Easyexpert is running, exit it to open the Start EasyEXPERT window.
2. Click Option > EasyEXPERT Database > Move EasyEXPERT Database. The EasyEXPERT Database dialog box is displayed.
3. Enter the destination folder name into the Move To field. For example, enter `C:\EasyEXPERT_user_1\database`.
4. Click the OK button to start the database move operation.
   
   Click the Cancel button to cancel the move operation.
Updating EasyEXPERT

NOTE
The latest revision of the update package can be obtained from Keysight Technologies web site.

NOTE
The revision 3.2 or later does not require the administrator privilege. However, if the software is updated from a previous revision to the revision 3.2 or later, it still requires the administrator privilege.

Preparation
If you update the EasyEXPERT to the revision 5.5 or later, prepare the license file for EasyEXPERT.
If you do not have the license file, prepare the Software Entitlement Certificate sheet provided with the option SWS. And get the license file as described in this sheet.

Procedure
1. Confirm the current revision of EasyEXPERT and get the update package.
2. Make a backup of EasyEXPERT database. See “To Make Database Backup” on page 10-17.
3. Install the required software described in README file included in the update package. If it is already installed, go to the step 4.
4. Update the EasyEXPERT by following the procedure described in the README file.
5. After the update is completed, make a backup of EasyEXPERT database.

If update fails
If EasyEXPERT could recover to the revision before starting the update procedure, perform the following procedure.
2. Perform “Procedure” step 3 to 5.

If EasyEXPERT could not recover, see “Performing a Clean Install of EasyEXPERT” on page 10-21 and install EasyEXPERT of the revision before starting the update procedure. After that, perform “Procedure” step 3 to 5.
Performing a Clean Install of EasyEXPERT

This section explains how to clean install EasyEXPERT.

1. Confirm the current revision of EasyEXPERT and get the same revision of the EasyEXPERT software installation package.

2. Make a backup of the EasyEXPERT database. See “Data Backup and Recovery” on page 10-16 for the procedure.

3. Terminate the EasyEXPERT and logoff the Windows. And login again.

4. By using the Explorer of Windows, move the folder for EasyEXPERT setup files. For example, move it to the Temp folder. See Table 10-4 on page 10-17 for the location of the setup files.

5. By using the Control Panel of Windows, uninstall the EasyEXPERT software. If the multiple revisions have been installed, uninstall all revisions.

6. By using the Explorer, delete the EasyEXPERT program folder. See Table 10-5 for the location of the program folder.

7. Re-install the EasyEXPERT of the revision confirmed in the step 1.
   For more information, see “To Install EasyEXPERT in External PC” on page 7-6.

8. Confirm that the EasyEXPERT starts and works normally.

9. Restore the database from the backup.

10. If you need, restore your desired files from the folder moved in the step 4.

Table 10-5 Location of EasyEXPERT Program Folder

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP, Vista, 7/8.1/10 32 bit version</td>
<td>C:\Program Files\Agilent\B1500\EasyEXPERT</td>
</tr>
<tr>
<td>Windows 7/8.1/10 64 bit version</td>
<td>C:\Program Files (x86)\Agilent\B1500\EasyEXPERT</td>
</tr>
</tbody>
</table>
B1500 System Recovery

The system recovery is not required in normal situation. Perform it only if you would like to restore factory shipped condition in some reason or Keysight support engineer asks for the problem solving.

• “Before Performing System Recovery”
• “Preparation”
• “To Perform System Recovery”
• “To Initialize Database”
• “To Restore Database”

Before Performing System Recovery

The system recovery will restore the C drive to the factory shipped condition. Be aware of the followings before performing the system recovery.

• Before performing the system recovery, make a backup of the user data and store it in a device other than the C drive.

• The system recovery is not performed for the D drive, where the EasyEXPERT database is stored, and performed only for the C drive. If you would like to initialize the EasyEXPERT database, see “To Initialize Database” on page 10-26.

• If the EasyEXPERT has been updated after factory shipment, the factory shipped revision of EasyEXPERT may not be able to read the current database. To read the current database, update the EasyEXPERT to the current revision or the latest revision after the system recovery.
Preparation

1. Note the computer name of your B1500.
   This is required to set the same computer name again after System Recovery is completed. You can find it on System Properties displayed by Control Panel > System.

2. Note all user account if you added the accounts.
   This is required to add the same user accounts again after System Recovery is completed. You can check it on User Accounts displayed by Control Panel > User Accounts.

3. Make backup of data in the SSD. See “Data Backup and Recovery” on page 10-16.

4. Confirm the current revision of EasyEXPERT and prepare the same revision of the EasyEXPERT software installation package.

To Perform System Recovery

B1500 system recovery can be performed by the following procedure.

For Windows 10 based B1500

1. Set the B1500 Standby switch to the OFF position.

2. Disconnect all USB devices from the B1500.

3. Connect the USB keyboard to a USB port of the B1500.

4. Set the B1500 Standby switch to the ON position.

5. Before Windows boots up, press the F8 key to display the boot system selection menu. This step may not be needed.

6. On the boot system selection menu, select Instrument Image Recovery System, and press Enter key. To select the system, use arrow keys.
   The Instrument Image Recovery System window is opened. See Figure 10-1.

7. Enter 2 and press “OK”. Message will be displayed for asking if you allow to overwrite the C drive.

8. For the message, press “OK”. System recovery starts.
   After the recovery completes successfully, the system will restart automatically.
If You Have a Problem
B1500 System Recovery

Figure 10-1  Instrument Image Recovery System Screen

Instrument Image Recovery System

Enter a number from 1 to 5 corresponding to the [OK] choices below, then select OK. [Cancel]
Press the Enter key for OK and the ESC key for Cancel.

1. Run Check Disk on the system drive.
2. Recover the original factory system image.
3. View troubleshooting documentation.
4. Repair the system drive.
5. Exit and restart the instrument.

9. Set the computer name and add the user accounts to the B1500 again. They must be the value noted at the step of “Preparation” on page 10-23.


11. Update EasyEXPERT to the current revision, which is confirmed in “Preparation” on page 10-23 or the latest revision. See “Updating EasyEXPERT” on page 10-20.


For Windows 7 based B1500

1. Set the B1500 Standby switch to the OFF position.
2. Disconnect all USB devices from the B1500.
3. Connect the USB keyboard to a USB port of the B1500.
4. Set the B1500 Standby switch to the ON position.
5. Before Windows boots up, press the F8 key to display the boot system selection menu.
6. On the boot system selection menu, select Keysight Recovery System, and press Enter key. To select the system, use arrow keys.

   The Command Prompt window is opened. See Figure 10-2.

   Where, 2 is not valid now. 3 should be entered for rebooting the B1500 without performing system recovery.

7. For the message “Enter a Choice:”, enter 1 and press the Enter key. Message will be displayed for asking if you allow to overwrite the C drive.
8. For the message, enter 1 and press the Enter key. System recovery starts.
After the recovery completes successfully, the Command Prompt window displays the message as shown in Figure 10-3.

Enter 1 for rebooting the B1500.

Enter 2 for turning off the B1500.

**Figure 10-2 Keysight System Recovery Screen 1**

Keysight Technologies System Utilities
Recovery Options

Choose one of the following:

1. Recover Factory Backup Image.
2. Update System.
3. Exit

Enter a Choice:

**Figure 10-3 Keysight System Recovery Screen 2**

Choose one of the following:

1. Restart
2. Shut down

Enter a Choice:

9. Set the computer name and add the user accounts to the B1500 again. They must be the value noted at the step of “Preparation” on page 10-23.


11. Update EasyEXPERT to the current revision, which is confirmed in “Preparation” on page 10-23 or the latest revision. See “Updating EasyEXPERT” on page 10-20.

To Initialize Database

EasyEXPERT database can be initialized by the following procedure. You can use EasyEXPERT after this procedure is completed.

1. Exit Start EasyEXPERT.
2. Rename $D:\texttt{Agilent}\texttt{EasyEXPERT}\texttt{1}$ folder (EasyEXPERT database).
   
   Example:  
   
   CHDIR /D $D:\texttt{Agilent}\texttt{EasyEXPERT}$
   RENAME 1 1-backup

3. Create $D:\texttt{Agilent}\texttt{EasyEXPERT}\texttt{1}$ folder.
   
   Example:  
   
   MKDIR 1

4. Copy all files and folders in the $D:\texttt{Agilent}\texttt{EasyEXPERT}\texttt{Copy of 1}$ folder, and paste them to the $D:\texttt{Agilent}\texttt{EasyEXPERT}\texttt{1}$ folder.
   
   Example:  
   
   CHDIR Copy of 1
   XCOPY * ..\1 /s /e /q /i

To Restore Database

EasyEXPERT database can be restored by the following procedure.

In the example shown in “To Initialize Database”, the EasyEXPERT database backup is the whole $D:\texttt{Agilent}\texttt{EasyEXPERT}\texttt{1-backup}$ folder. The database can be restored by using the data in this folder.

- For EasyEXPERT revision 2.10 and earlier
  
  The database reconfiguration tool is required. Obtain it from Keysight Technologies web site. For the execution procedure, see the readme text file included in the package.

- For EasyEXPERT revision 2.11 and later
  
  1. Launch Start EasyEXPERT.
  2. Click Option > EasyEXPERT Database > Restore EasyEXPERT Database in the Start EasyEXPERT window.
  3. Follow the EasyEXPERT Database Restoration Wizard and complete the restoration of EasyEXPERT database.
Error Message
This chapter lists the Keysight B1500 error code.

- “Keysight EasyEXPERT Operation Error”
- “Keysight FLEX Execution Error”
- “Keysight B1500 Self-test/Calibration Error”
- “Setup File Converter Execution Error”
- “MDM File Converter Execution Error”

**NOTE**

This manual uses the following conventions.

- For Windows 7/8.1/10 64 bit version
  
  <program folder>: <system drive>:\Program Files (x86)
  
  <common data folder>: <system drive>:\ProgramData

- For Windows Vista, 7/8.1/10 32 bit version
  
  <program folder>: <system drive>:\Program Files
  
  <common data folder>: <system drive>:\ProgramData

- For Windows XP
  
  <program folder>: <system drive>:\Program Files
  
  <common data folder>: 
    <system drive>:\Documents and Settings\All Users\Application Data

- <system drive>: Drive the EasyEXPERT has been installed

- <database folder> for EasyEXPERT on B1500:
  
  D:\Agilent\EasyEXPERT\1

- <database folder> for EasyEXPERT on external PC:
  
  <common data folder>\Agilent\EasyEXPERT\User\Database\1
Keysight EasyEXPERT Operation Error

When Keysight B1500 causes errors in Keysight EasyEXPERT execution environment, the B1500 returns the following error codes and error messages.

101001  Log repository operation failed.
Consult the detail messages and solve the problems.

101002  Log file operation failed.
Consult the detail messages and solve the problems.

101003  Log record operation failed.
Consult the detail messages and solve the problems.

102001  Service started successfully.

102002  Service stopped successfully.

102003  Service starting process failed.
Restart the B1500/EasyEXPERT. If this error still arises, contact your nearest Keysight Technologies.

102004  Service stopping process failed.
Restart the B1500/EasyEXPERT. If this error still arises, contact your nearest Keysight Technologies.

103001  USB488 error occurred. Alias: A, Reason: B
Consult Alias and Reason, and solve the problems. After that, turn the B1500 off, remove the power cable, connect it again, and restart the B1500/EasyEXPERT.

103002  USB488 device was not found. Alias: A, Reason: B
Consult Alias and Reason, and add the B1500 by using the Connection Expert of Keysight IO Library.

103003  USB488 timeout occurred. Alias: A, Timeout: B [ms]
Contact your nearest Keysight Technologies. Then present the command history included in the detail messages.

103004  GPIB error occurred. Interface: A, Address: B, Reason: C
Error Message
Keysight EasyEXPERT Operation Error

Consult Interface, Address, and Reason, check the status of the target GPIB instrument, and solve the problems.

103005  GPIB address must be between 0 and 31. Interface: A, Address: B
Set the GPIB address to the one between 0 and 31.

103006  Duplicate GPIB address was found. GPIB address must be unique. Interface: A, Address: B
Assign an unique address to each GPIB instrument.

103007  GPIB device was not found. Interface: A, Address: B, Reason: C
Consult Interface, Address, and Reason, check the GPIB address, the cable connection, and the status of the target GPIB instrument, and solve the problems.

103008  GPIB timeout occurred. Interface: A, Address: B, Timeout: C [ms]
Consult Interface, Address, and Timeout, check the GPIB address, the cable connection, and the status of the target GPIB instrument, and solve the problems. Or, long timeout setting may solve the problem.

104001  Module (A) is not available.
If the target module fails the self-test, contact your nearest Keysight Technologies for repair. Or else, check the module configuration and specify the available module.

105001  Generic setup error occurred. Code: A, Reason: B
Firmware error. If this error code occurs as the top level error, contact your nearest Keysight Technologies. Then present Code and Reason.

105002  Duplicate data name was found. Data name must be unique. Data name: A
Assign an unique name to each variable defined in the test setup.

105003  Operation is not supported in offline mode.
Change the operation mode to Online to perform this operation.

105004  Interlock circuit is open. Interlock circuit must be closed for setting voltage source/compliance absolute value exceeding A V.
Close the Interlock circuit to apply the channel setup over A V.

105005  Output series resistor cannot be used for SMU with ASU.
Set NONE to Series R of the Unit: SMU:\n:HR/AS.
105006  Source wait time coefficient must be between $A$ and $B$.
       Set Output Wait to the value between $A$ and $B$.

105008  Monitor wait time coefficient must be between $A$ and $B$.
       Set Measurement Wait to the value between $A$ and $B$.

105010  Series resistor is not available for HPSMU using the 1 A range.
       Set NONE to Series R of the Unit: SMU:\text{n}:HP if the HPSMU is used over 100 mA. If 1MOHM is set, use the HPSMU within 100 mA.

105011  I/V Staircase Sweep needs at least one monitoring channel.
       Define one or more measurement variables (data used for data display or calculation) in the test setup for the staircase sweep measurement.

105012  I/V Pulsed Sweep needs exactly one monitoring channel.
       Define one measurement variable (data used for data display or calculation) in the test setup for the pulsed sweep measurement.

105013  I/V Sweep with pulsed bias needs exactly one monitoring channel.
       Define one measurement variable (data used for data display or calculation) in the test setup for the staircase sweep with pulsed bias measurement.

105014  I/V-t Sampling needs at least one monitoring channel.
       Define one or more measurement variables (data used for data display or calculation) in the test setup for the sampling measurement.

105015  C-V Sweep needs at least one monitoring channel.
       Define one or more measurement variables (data used for data display or calculation) in the test setup for the C-V sweep measurement.

105016  At least one measurement channel is required for Multi Channel I/V Sweep measurement.
       Define one or more measurement variables (data used for data display or calculation) in the test setup for the multi channel sweep measurement.

105017  Only one measurement channel can be used for I/V-t linear sampling measurement of interval < 2 ms.
       Define one measurement variable (data used for data display or calculation) in the test setup for the sampling measurement with the interval less than 2 ms using the Keysight 4155B/C or 4156B/C.
Error Message
Keysight EasyEXPERT Operation Error

105018  Base hold time is not available for 4155B/C and 4156B/C. The value must be 0.
        Set Base Hold Time to 0 for the sampling measurement using the 4155B/C or 4156B/C.

105020  Interlock circuit is open. Interlock circuit must be closed to set an output or compliance value greater than ±40 V.
        This is for using the 4155B/C or 4156B/C. Close the Interlock circuit to apply the channel setup over ±40 V.

105021  Current source value of \( A \) must be between \( B \) \( A \) and \( C \) \( A \).
        For the Unit: \( A \), set the current output value to the value between \( B \) \( A \) and \( C \) \( A \).

105022  Voltage compliance value of \( A \) must be between \( B \) \( V \) and \( C \) \( V \).
        For the Unit: \( A \), set Compliance to the value between \( B \) \( V \) and \( C \) \( V \).

105023  Voltage source value of \( A \) must be between \( B \) \( V \) and \( C \) \( V \).
        For the Unit: \( A \), set the voltage output value to the value between \( B \) \( V \) and \( C \) \( V \).

105024  Current compliance value of \( A \) must be between \( B \) \( A \) and \( C \) \( A \).
        For the Unit: \( A \), set Compliance to the value between \( B \) \( A \) and \( C \) \( A \).

105025  Power compliance value of \( A \) must be between \( B \) \( W \) and \( C \) \( W \).
        For the Unit: \( A \), set Pwr Comp to the value between \( B \) \( W \) and \( C \) \( W \).

105026  \( A \) power compliance must be OFF.
        For the Unit: \( A \), set Pwr Comp to OFF.

105027  Measurement unit emergency reset occurred.
        Code: \( A \), Reason: \( B \)
        Consult Code and Reason, specify the cause of emergency, and solve the problems.

105031  The product of voltage source value and current compliance value of \( A \) exceeds its output power range. Please set the current compliance value between \( B \) \( A \) and \( C \) \( A \).
        For the Unit: \( A \), set Compliance to the value between \( B \) \( A \) and \( C \) \( A \).
105032 The product of current source value and voltage compliance value of $A$ exceeds its output power range. Please set the voltage compliance value between $B$ V and $C$ V.

For the Unit: $A$, set Compliance to the value between $B$ V and $C$ V.

105033 The polarity of peak value(s) and the base value of SMU current pulse must be the same.

For the base and peak values, set the values of the same polarity.

105034 The start value and stop value of SMU log sweep must be non-zero and have same polarity for primary sweep source (and synchronous sweep source).

For the start and stop values, set the non-zero values of the same polarity.

105035 Invalid value ($A$) was specified for SMU I/V Sweep stop condition. Valid option(s): $B$

The value $A$ is not available for the setting of the sweep abort condition. Select one from the available choices $B$. If you use a formula, the calculation result must show the available value.

105036 The hold time for SMU I/V Sweep must be between $A$ s and $B$ s.

Set Hold to the value between $A$ s and $B$ s.

105037 The delay time for SMU I/V Sweep must be between $A$ s and $B$ s.

Set Delay to the value between $A$ s and $B$ s.

105038 SMU pulse width must be between $A$ s and $B$ s.

Set Width to the value between $A$ s and $B$ s.

105039 SMU pulse period must be between $A$ s and $B$ s.

Set Period to the value between $A$ s and $B$ s.

105040 SMU pulse width and period must conform following conditions.

For pulse width $A$ s or less: The period must be $B$ s longer or more than the pulse width.

For pulse width longer than $A$ s: The period must be $C$ s longer or more than the pulse width.

Set the values which satisfy the above conditions to Width and Period.
Error Message
Keysight EasyEXPERT Operation Error

105041  Invalid value (B) was specified for current monitor ranging mode of A. Valid option(s): C
        Set the ranging mode (C) available for the Unit: A.

105042  Invalid value (B) was specified for current monitor range of A. Valid option(s): C
        Set the value (C) available for Range of the Unit: A.

105043  Invalid value (B) was specified for current monitor ranging rule of A. Valid option(s): C
        Set the value (C) available for Range Change Rule of the Unit: A.

105044  Invalid value (B) was specified for voltage monitor ranging mode of A. Valid option(s): C
        Set the ranging mode (C) available for the Unit: A.

105045  Invalid value (B) was specified for voltage monitor range of A. Valid option(s): C
        Set the value (C) available for Range of the Unit: A.

105046  Invalid value (A) was specified for the integral mode of High-Resolution ADC. Valid option(s): B
        Set the value (B) available for Mode of the High Resolution ADC.

105047  The coefficient for High Resolution ADC A integral mode must be between B and C.
        Set the value between B and C to Factor of the High Resolution ADC.

105048  Invalid value (A) was specified for the averaging mode of High-Speed ADC. Valid option(s): B
        Set the value (B) available for Mode of the High Speed ADC.

105049  The coefficient for High Speed ADC A averaging mode must be between B and C.
        Set the value between B and C to Factor of the High Speed ADC.

105050  Invalid value (A) was specified for the integral mode of ADC. Valid option(s): B
        Set the value (B) available for Mode of the High Speed ADC.

105051  Invalid value (A) was specified for the sweep direction. Valid option(s): B
Set the value ($B$) available for Direction.

105052 Invalid value ($A$) was specified for the sweep stop condition. Valid option(s): $B$

Set the value ($B$) available for the sweep stop condition (Sweep status).

105053 Invalid value ($A$) was specified for the impedance measurement model. Valid option(s): $B$

Set the value ($B$) available for Model of C-V measurement.

105054 Hold time value must be between $A$ s and $B$ s.

Set Hold to the value between $A$ s and $B$ s.

105055 Delay time value must be between $A$ s and $B$ s.

Set Delay to the value between $A$ s and $B$ s.

105056 Voltage source value of $A$ must be between $B$ V and $C$ V.

Set the CMU voltage output value to the value between $B$ V and $C$ V.

105057 Frequency value of $A$ must be between $B$ Hz and $C$ Hz.

Set Frequency List to the value between $B$ Hz and $C$ Hz.

105058 Coefficient value of $A$ integral mode must be between $B$ and $C$.

Set the value between $B$ and $C$ to Factor of Integration Time.

105059 AC Level value of $A$ must be between $B$ mV and $C$ mV.

Set AC Level to the value between $B$ mV and $C$ mV.

105060 Invalid value ($B$) was specified for monitor ranging mode of $A$. Valid option(s): $C$

Set the ranging mode ($C$) available for CMU.

105061 SMU pulse period must be $A$ s longer than the pulse width.

For the SMU pulse output using the 4155B/C or 4156B/C, set Period and Width to the values which satisfy $\text{Period} \geq \text{Width} + A$.

105062 Primary sweep source step value must be greater than the setup resolution.

For the sweep measurement using the 4155B/C or 4156B/C, set Step of VAR1 to the value greater than or equal to the minimum setting resolution.
105063  Synchronous sweep source step value must be greater than the setup resolution. Adjust the offset value and the ratio value, or change the primary sweep source settings.

For the sweep measurement using the 4155B/C or 4156B/C, set Offset and Ratio of VAR1’ and Step of VAR1 to the values so that the VAR1’ source step value is greater than or equal to the minimum setting resolution.

105064  Compliance absolute value must be $A \, \text{A}$ or greater if the channel is the SMU pulse source and the output value is $B \, \text{Vpp}$.

For the $B \, \text{Vpp}$ pulse output using SMU of the 4155B/C or 4156B/C, set Compliance to $\pm \, A \, \text{A}$ or above.

105065  Compliance value must be $\pm \, 2 \, \text{V}$ or less if the channel is the SMU pulse source and the output value is 0 A to 10 $\mu\text{A}$.

For the pulse output up to 10 $\mu\text{A}$ using the 4155B/C or 4156B/C, set Compliance to the value within $\pm \, 2 \, \text{V}$.

105066  Current compliance must be 100 mA for VSU.

For using VSU of the 4155B/C or 4156B/C, set Compliance to 100 mA.

105067  Power compliance must be OFF for VSU.

For using VSU of the 4155B/C or 4156B/C, set Pwr Comp to OFF.

105071  Sampling interval for I/V-t sampling must be between $A \, \text{s}$ and $B \, \text{s}$.

Set Interval to the value between $A \, \text{s}$ and $B \, \text{s}$.

105072  Number of samples for I/V-t $A$ sampling must be between $B$ and $C$.

Set No of Samples to the value between $B$ and $C$.

105073  Hold time for I/V-t sampling must be between $A \, \text{s}$ and $B \, \text{s}$.

Set Hold Time to the value between $A \, \text{s}$ and $B \, \text{s}$.

105074  Multiplying the number of monitor channels by No of Samples must be between $A$ and $B$.

In the test setup for the sampling measurement, adjust No of Samples and the number of measurement channels so that the total number of measurement data, which is equal to the number of measurement channels multiplied by No of Samples, is between $A$ and $B$. 
105075 Invalid value \( A \) specified for I/V-t sampling Lin/Log setting.
Valid option(s): \( B \)
Set the value \( (B) \) available for Lin/Log.

105076 Base hold time for I/V-t sampling must be between \( A \) s and \( B \) s.
Set Base Hold Time to the value between \( A \) s and \( B \) s.

105077 Invalid value \( A \) specified for I/V-t sampling output sequence.
Valid option(s): \( B \)
Set the value \( (B) \) available for Output Sequence.

105078 Sampling interval for I/V-t sampling must be between \( B \) s and \( C \) s.
Set Interval to the value between \( B \) s and \( C \) s.

105079 Hold time for I/V-t sampling must be between \( B \) s and \( C \) s.
Set Hold Time to the value between \( B \) s and \( C \) s.

105080 Hold time for I/V-t sampling with interval of \( B \) s or longer must be between \( C \) s and \( D \) s.
Set Hold Time to the value between \( C \) s and \( D \) s.

105081 Hold time for I/V-t sampling with interval shorter than \( B \) s must be between \( C \) s and \( D \) s.
Set Hold Time to the value between \( C \) s and \( D \) s.

105082 The polarity of base value and the source value of SMU current sampling must be the same.
For Base and Source, set the values of the same polarity.

105083 The number of VAR1 steps multiplied by the number of VAR2 steps must be between \( A \) and \( B \) in I/V Sweep, I/V List Sweep and Multi Channel I/V Sweep.
Set the sweep output, Start/Stop/Step/No of Step/Sources, so that the total number of sweep steps, which is equal to the number of steps for VAR1 multiplied by the number of steps for VAR2, is between \( A \) and \( B \).

105091 List length of VAR1 sweep must be between \( A \) and \( B \) for the I/V List Sweep measurement. Length \( C \) is not applicable.
Define Sources vector data for VAR1 so that its number of data is between \( A \) and \( B \).
Error Message
Keysight EasyEXPERT Operation Error

105092 List length of VAR2 sweep must be between A and B for the I/V List Sweep measurement. Length C is not applicable.
Define Sources vector data for VAR2 so that its number of data is between A and B.

105093 List length of delay time must be between A and B for the I/V List Sweep measurement. Length C is not applicable.
Define Delay vector data so that its number of data is between A and B.

105094 Time until the first step measurement, (hold time + delay time), must be between A and B s for the I/V List Sweep measurement using SMU pulse.
Set Hold and Delay(1), so that Hold + Delay(1) is between A s and B s. Delay(1) indicates the first data in the Delay vector data.

105095 A does not support current measurement.
Specify the measurement resource which supports current measurement.

105096 At least one measurement channel is required for I/V List Sweep measurement.
Define one or more measurement variables (data used for data display or calculation) in the test setup for the I/V List Sweep measurement.

105801 Invalid value A specified for Output Value after Measurement in the Advanced Setup dialog box. Valid option(s): B
Set the value (B) available for Output Value after Measurement.

105802 Invalid value A specified for Bias Hold after Measurement in the Advanced Setup dialog box. Valid option(s): B
Set the value (B) available for Bias Hold after Measurement.

105803 Bias hold function execution error. All channel outputs or voltage compliance must be at ± A V or less to control the output switch or the series resistor.
Before controlling the output switch or the series resistor, set all channel output and compliance values to within ± A V. Or set Bias Hold after Measurement to OFF.

105804 Bias hold function execution error. Output voltage or voltage compliance must be ± 40 V or less to control the output switch or the series resistor.
Before controlling the output switch or the series resistor, set all channel output and compliance values to within ±40 V. Or set Bias Hold after Measurement to OFF.

105811 Invalid value A was specified for Semiconductor Relays (B) of Advanced Setup. Valid option(s): C
Set the value (C) available for Semiconductor Relays (B).

105821 Invalid value A was specified for Type of SPGU Pulse Setup. Valid option(s): B, VName: C
For SPGU Pulse Setup, set the value (B) available for Type of VName C.

105822 Invalid value A was specified for SW Sync of Pulse Switch Setup. Valid option(s): B, VName: C
For Pulse Switch Setup of SPGU, set the value (B) available for SW Sync of VName C.

105823 Invalid value A was specified for Normal of Pulse Switch Setup. Valid option(s): B, VName: C
For Pulse Switch Setup of SPGU, set the value (B) available for Normal of VName C.

105824 Delay value of Pulse Switch Setup must be between A s and B s. VName: C
For Pulse Switch Setup of SPGU, set Delay of VName C to the value between A s and B s.

105825 Width for pulse switch must be between A s and B s. VName: C
For Pulse Switch Setup of SPGU, set Width of VName C to the value between A s and B s.

105826 Sum of Delay and Width of Pulse Switch Setup must be within Period value. VName: A
For Pulse Switch Setup of SPGU, set Delay and Width of VName A so that Delay+Width is shorter than or equal to Period.

105830 Load Z value must be between A ohm and B ohm. VName: C
For Load Z Setup of SPGU, set Load Z of VName C to the value between A Ω and B Ω.

105831 Period value of SPGU Pulse Setup must be between A s and B s.
Error Message
Keysight EasyEXPERT Operation Error

For SPGU Pulse Setup, set Period to the value between $A$ s and $B$ s.

105832  PULSE COUNT value of SPGU Pulse Setup must be between $A$ and $B$.
For SPGU Pulse Setup, set PULSE COUNT to the value between $A$ and $B$.

105833  DURATION value of SPGU Pulse Setup must be between $A$ s and $B$ s.
For SPGU Pulse Setup, set DURATION to the value between $A$ s and $B$ s.

105834  Base value of SPGU Pulse Setup must be between $A$ V and $B$ V.
VName: $C$
For SPGU Pulse Setup, set Base of VName $C$ to the value between $A$ V and $B$ V.

105835  Peak value of SPGU Pulse Setup must be between $A$ V and $B$ V.
VName: $C$
For SPGU Pulse Setup, set Peak of VName $C$ to the value between $A$ V and $B$ V.

105836  Delay value of SPGU Pulse Setup must be between $A$ s and $B$ s.
VName: $C$
For SPGU Pulse Setup, set Delay of VName $C$ to the value between $A$ s and $B$ s.

105837  Width value of SPGU Pulse Setup must be between $A$ s and $B$ s.
VName: $C$
For SPGU Pulse Setup, set Width of VName $C$ to the value between $A$ s and $B$ s.

105838  Leading value of SPGU Pulse Setup must be between $A$ s and $B$ s.
VName: $C$
For SPGU Pulse Setup, set Leading of VName $C$ to the value between $A$ s and $B$ s.

105839  Trailing value of SPGU Pulse Setup must be between $A$ s and $B$ s.
VName: $C$
For SPGU Pulse Setup, set Trailing of VName $C$ to the value between $A$ s and $B$ s.

105840  Leading $\times 1.25$ must be within Width value. VName: $A$
For SPGU Pulse Setup, set Leading of VName A so that Leading×1.25 is shorter than or equal to Width.

105841 Sum of Delay, Width, and Trailing × 1.25 must be within Period value. VName: A

For SPGU Pulse Setup, set Delay/Width/Trailing of VName A so that Delay+Width+Trailing×1.25 is shorter than or equal to Period.

105842 Invalid value A was specified for PGU output impedance. Valid option(s): B, VName: C

For using PGU of 4155B/C or 4156B/C, set the value (B) available for Output Impedance of VName C.

105843 SPGU cannot be used for bias source of I/V-t linear sampling measurement of interval < 2 ms.

Set Interval to 2 ms or above for using SPGU as a bias source of the sampling measurement. Or else, do not use SPGU.

105844 |Peak−Base| value of PGU pulse must be between A V and B V. VName: C

Set Peak and Base of VName C so that |Peak−Base| is between A V and B V.

105845 Period, Width, and Delay values of PGU pulse must be in the same setting range. And Leading and trailing values must be in the same setting range.

Set Period, Width, and Delay so that the values belong to the same group. Also, set Leading and Trailing so that the values belong to the same group. For the group, see the PGU specifications.

105846 SPGU cannot output the specified voltage. Change Load Z value or output voltage.

Change Load Z value or setup voltage to apply the setting value correctly.

105881 N1272A/B1506A/B1507A Device Capacitance Selector is not found.

Check the status of the N1272A and the communication cable connections for N1272A/B1506A/B1507A, and solve the problems.

105882 Communication with N1272A/B1506A/B1507A Device Capacitance Selector interrupted. Connect the cable properly.
Error Message
Keysight EasyEXPERT Operation Error

Check the communication cable connections for N1272A/B1506A/B1507A, and solve the problems.

105883  N1272A/B1506A/B1507A Device Capacitance Selector is turned off. Connect the power cable properly and check the power switch.

Check the power cable connections for N1272A/B1506A/B1507A, and solve the problems.

105885  Input units for Device Capacitance Selector are not assigned. Please assign the units on the Configuration window's Device Capacitance Selector tab.

105891  No current load control SMU is assigned. Please assign the current load control SMU on the Configuration window's Gate Charge Adapter tab.

105892  Current load adjustment failed. Please check the High Current Switching Waveform.

Confirm the voltage/current waveform and change the load current appropriately.

105893  Resistive load bias adjustment failed. Please check the High Current Switching Waveform.

Confirm the voltage/current waveform and change the load current appropriately.

105894  Extraction of Gate Charge lines and parameters failed. Please check the Switching Waveform whether Vgs curve crosses both Vgs(on) and Vgs(off) or not.

If not, please increase Ig or OnPeriod for complete switching.

Confirm the voltage/current waveform and change the values appropriately.

105895  Extraction and derivation of Gate Charge lines and parameters from High Current Gate Charge characteristics and High Voltage Gate Charge characteristics failed. Please check whether the both characteristics are extracted successfully.

Confirm the voltage/current waveform and change the values appropriately.

105896  Gate Charge Adapter configuration is not applied. Please apply Gate Charge Adapter configuration on the Configuration window's Gate Charge Adapter tab.

105897  Calibration failed. Please check the open/short connection.
If the calibration is still failed, contact your nearest Keysight Technologies

105901 Over voltage was applied to SMU measurement terminal.
Check and correct connections of cables and measurement terminals.

105902 Over current was applied to SMU measurement terminal.
Check and correct connections of cables and measurement terminals.

105903 Cannot use the specified module that failed self-test.
To use the specified module, contact your nearest Keysight Technologies for servicing the instrument.

105904 $A$ cannot be set to Additional Data Variables. Only the channels defined in Channel Definition can be set.
In the Direct Control test setup, use the pull-down menu to set the Unit and the Type of the Additional Data Variables.

105905 Entry is already defined in Additional Data Variables. It is not necessary to redefine the entry. Unit: $A$, Type: $B$
In the Direct Control test setup, delete duplication from the Additional Data Variables.

105906 Variable name specified in Additional Data Variables is used for another variable. Specify a different name. Variable name: $A$
In the Direct Control test setup, change the variable name so that no duplication is found in the Additional Data Variables.

105907 Format parameter of FMT command must be 13.
In the Command Setup of the Direct Control test setup, set 13 to the first argument of the FMT command.

105908 Impedance and Admittance cannot be measured simultaneously.
In the Direct Control test setup, use the pull-down menu to set the Type of the Additional Data Variables. Then do not set both of impedance (Z) and admittance (Y).

105909 Program number must range from $A$ to $B$. number: $C$
In the Command Setup of the Direct Control test setup, specify the program number effective for the program memory.

105910 Variable number in program memory must range from $A$ to $B$. number: $C$
Error Message
Keysight EasyEXPERT Operation Error

In the Command Setup of the Direct Control test setup, specify the variable number effective for the program memory variable.

105911 Command field is empty. Choose a command from candidates.
In the Command Setup of the Direct Control test setup, set Command by using the pull-down menu. Do not leave it empty.

105912 Generic Setup error occurred in line A in Direct Control “B”.
sent command: C
In the Command Setup of the Direct Control test setup, check Command and Arguments of the line A, and set the command and the parameters properly.

105913 Incorrect usage of ST and END commands. Use them as a pair to store a command group into the program memory.
In the Command Setup of the Direct Control test setup, check how the ST and END commands are used, and correct the program. Put ST just before the code recorded to the program memory, and put END just after the code.

105914 Improper number of Arguments for the A command. Enter the Arguments correctly.
In the Command Setup of the Direct Control test setup, check the parameters for the command A, and set the Arguments properly.

105915 A pulse base must be between B A and C A.
Set Base to the value between B A and C A.

105916 A pulse peak must be between B A and C A.
Set the pulse peak value to the value between B A and C A.

105917 A pulse peak and base must be between B V and C V.
Set Base and the pulse peak value to the values between B V and C V.

105918 A compliance must be between B V and C V.
Set Compliance to the value between B V and C V.

105919 A compliance must be between B A and C A.
Set Compliance to the value between B A and C A.

105920 A pulse peak \times compliance exceeds its output power limit. Compliance must be between B V and C V.
Set Compliance to the value between $B\ V$ and $C\ V$.

**05921**

If the pulse peak value multiplied by the compliance exceeds its output power limit, Compliance must be between $B\ A$ and $C\ A$.

Set Compliance to the value between $B\ A$ and $C\ A$.

**05922**

A pulse delay time must be between $B\ s$ and $C\ s$.

Set Pulse Delay Time to the value between $B\ s$ and $C\ s$.

**05923**

A does not support pulse delay time. It must be 0.

Set Pulse Delay Time to 0 s.

**05924**

SMU pulse measurement delay time must be between $A\ s$ and $B\ s$.

Set Measurement Delay Time to the value between $A\ s$ and $B\ s$.

**05925**

SMU pulse averaging count must be between $A$ and $B$.

Set Pulse Averaging Count to the value between $A$ and $B$.

**05926**

A pulse duty cycle must be $B\ %$ or less if the pulse peak or compliance exceeds $C\ A$.

Adjust Period and Width so that the pulse duty is $B\ %$ or less, or set Compliance and the pulse peak value to $C\ A$ or less.

**05927**

A pulse width must be between $B\ s$ and $C\ s$ if the pulse peak or compliance exceeds $D\ A$.

Set Width to the value between $B\ s$ and $C\ s$, or set Compliance and the pulse peak value to $D\ A$ or less.

**05928**

A pulse base must be between $B\ A$ and $C\ A$ if the pulse peak exceeds $D\ A$.

Set Base to the value between $B\ A$ and $C\ A$, or set the pulse peak value to $D\ A$ or less.

**05929**

A pulse peak and base must be same polarity if the pulse output exceeds $B\ V$.

For the pulse peak and base values, set the values of the same polarity. Or set the pulse output value to $B\ V$ or less.

**05930**

The coefficient for High Speed ADC TIME averaging mode must be between $A\ s$ and $B\ s$.

On the setting of Mode: TIME for High Speed ADC in the Integration Time setup, set Factor to the value between $A\ s$ and $B\ s$.
Error Message
Keysight EasyEXPERT Operation Error

105931  Invalid value \( A \) was specified for the series resistor of \( B \).
Valid option(s): \( C \)

In the Application Test definition, invalid value \( A \) was passed to Series R. Correct the setup so that the available value (\( C \)) is set.

105932  N1258A selector is not found.

Check the status of the N1258A and the communication cable connection, and solve the problems.

105933  Communication with N1258A selector interrupted. Connect the cable properly.

Check the connection of communication cable, and solve the problems.

105934  N1258A selector is turned off. Connect the power cable properly.

Check the connection of power cable, and solve the problem.

105935  N1258A selector can make an input-output path. Multiple input channels cannot be specified.

Use one of the measurement resources connected to the N1258A inputs.

105936  Invalid value \( A \) was specified for SMU I/V sweep Linear/Log.
Valid option(s): \( B \)

For the I/V Sweep test setup, set Linear/Log to the available value (\( B \)).

105937  Invalid value \( A \) was specified for C-V sweep Linear/Log.
Valid option(s): \( B \)

For the C-V Sweep test setup, set Linear/Log to the available value (\( B \)).

105938  The start value and stop value of C-V log sweep must be non-zero and have same polarity.

Set Start and Stop to the non-zero values of the same polarity.

105939  SMU cannot set the voltage or current exceeds Setting Limit defined in the SMU Output Setting Limits tab screen on the Configuration window.

Change the setting of the SMU Output Setting Limits tab screen, or set the output value to the value up to Voltage/Current Setting Limit.

105940  SMU pulse period must be \( A \) s longer than measurement delay time + measurement time. Measurement Delay Time: \( B \) s, Measurement Time: \( C \) s, Pulse Period: \( D \) s
Set Period and Measurement Delay Time so that Period is longer than or equal to $A + B + C$ s.

**105941** Measurement time must be equal to or less than pulse delay time + pulse width in case of AUTO measurement delay setting.
Channel: $A$, Pulse Delay Time: $B$ s, Pulse Width: $C$ s, Measurement Time: $D$ s

Set Pulse Delay Time and Width so that the measurement time ($D$) is shorter than or equal to $B + C$ s. Or set Measurement Delay Time to non-AUTO value.

**105942** SMU pulse period must be $A$ s longer than pulse delay time + pulse width. Channel: $B$, Pulse Delay Time: $C$ s, Pulse Width: $D$ s, Pulse Period: $E$ s

Set Period, Width, and Pulse Delay Time so that Period is longer than or equal to $A + C + D$ s.

**105943** Total setting current exceeds the capacity of main frame power supply. Reduce setting current.

Check the current output value of all modules. And adjust the value so that the total power consumption is within the limit of the mainframe. For the power consumption, see Specifications.

**105951** HCSMU detected open sense condition. Connect the cables properly between HCSMU and DUT, then use Kelvin connection.

Confirm the HCSMU cable connection, and make the Kelvin connection properly to the terminals of DUT.

**105952** HCSMU detected overvoltage condition. HCSMU output terminals may be open. Connect the cables properly between HCSMU and DUT, then use Kelvin connection.

Confirm the HCSMU cable connection, and make the Kelvin connection properly to the terminals of DUT.

**105953** MCSMU detected overvoltage condition. MCSMU output terminals may be open. Connect the cables properly between MCSMU and DUT, then use Kelvin connection.

Confirm the MCSMU cable connection, and make the Kelvin connection properly to the terminals of DUT.
Error Message
Keysight EasyEXPERT Operation Error

105960  Module set to the HCSMU field on the Module Selector tab screen cannot be set to the Master HCSMU or Slave HCSMU field on the Dual HCSMU Combination tab screen. Empty the HCSMU field and then set the Dual HCSMU Combination tab screen.

Check the Module Selector tab screen of the Configuration window. And empty the HCSMU field to configure the Dual HCSMU.

105970  N1265A/B1506A Ultra High Current Expander / Fixture is not found.

Check the status of the N1265A/B1506A and the communication cable connection, and solve the problems.

105971  Communication with N1265A/B1506A Ultra High Current Expander / Fixture interrupted. Connect the cable properly.

Check the connection of communication cable, and solve the problems.

105972  N1265A/B1506A Ultra High Current Expander / Fixture is turned off.

Connect the power cable properly and check the power switch.

Check the connection of power cable, and solve the problem.

105973  N1265A/B1506A Ultra High Current Expander / Fixture can make an drain input-output path. Multiple drain input channels cannot be specified.

Use one of the measurement resources connected to the N1265A/B1506A Selector Input and UHC Input.

105974  Same SMU cannot be specified for V Control SMU and I Control SMU of N1265A/B1506A Ultra High Current Expander / Fixture.

Check the UHC Expander / Fixture tab screen of the Configuration window and set the different SMU to each of Voltage Control SMU and Current Control SMU.

105975  Failed to read correction data from EEPROM of N1265A/B1506A Ultra High Current Expander / Fixture. Default values for correction data will be applied.

Contact your nearest Keysight Technologies.

105976  Over voltage is detected in Selector Output High Force, Low Force, or Low Sense terminal of N1265A/B1506A. Remove the causes of overvoltage.

Check and correct connections of cables and measurement terminals. If necessary, perform reboot and self-test of the N1265A/B1506A.
Error Message

Keysight EasyEXPERT Operation Error

105977 Over voltage is detected in Selector Output High Sense terminal of N1265A/B1506A. Remove the causes of overvoltage.

Check and correct connections of cables and measurement terminals. If necessary, perform reboot and self-test of the N1265A/B1506A.

105978 Pulse width overrun is detected in N1265A/B1506A. Check the assignment of control modules.

Check and correct the connections of the control SMU. If necessary, perform reboot and self-test of the N1265A/B1506A.

105979 Cooling fan failure is detected in N1265A/B1506A. Check the operation of the fan.

Make enough space for air flow. If necessary, perform reboot and self-test of the N1265A/B1506A. If the fan is defective, contact your nearest Keysight Technologies.

105980 N1266A HVSMU Current Expander is not found.

Check the status of the N1266A and the communication cable connection, and solve the problems.

105981 Communication with N1266A HVSMU Current Expander interrupted. Connect the cable properly.

Check the connection of communication cable, and solve the problems.

105982 N1266A HVSMU Current Expander is turned off. Connect the power cable properly and check the power switch.

Check the connection of power cable, and solve the problem.

105983 N1266A HVSMU Current Expander can make an input-output path. Multiple input channels cannot be specified.

Use either HVSMU or HVMCU.

105984 Same SMU cannot be specified for V Control SMU and I Control SMU of N1266A HVSMU Current Expander.

Check the HVSMU Current Expander tab screen of the Configuration window and set the different SMU to each of Voltage Control SMU and Current Control SMU.

105985 Failed to read correction data from EEPROM of N1266A HVSMU Current Expander. Default values for correction data will be applied.

Contact your nearest Keysight Technologies.
Error Message
Keysight EasyEXPERT Operation Error

Confirm the connection of the control modules and perform the self-calibration of the modules. Then try the self-test again.
If the N1265A/B1506A does not pass Self Test, contact your nearest Keysight Technologies.

Confirm the connection of the control modules and perform the self-calibration again.
If the N1265A/B1506A does not pass Self Calibration, contact your nearest Keysight Technologies.

Confirm the connection of the control modules and perform the self-calibration of the modules. Then try the self-test again.
If the N1266A does not pass Self Test, contact your nearest Keysight Technologies.

105989 Cannot use the N1258A/N1265A’s series resistor for HVSMU when the HVMCU is used.
Check the Module Selector tab screen of the Configuration window. To use HVMCU, remove the check from the “Enable Series Resistor (100k ohm) for HVSMU” check box.

105990 N1268A Ultra High Voltage Expander is not found.
Check the status of the N1268A and the communication cable connection, and solve the problems.

105991 Communication with N1268A Ultra High Voltage Expander interrupted. Connect the cable properly.
Check the connection of communication cable, and solve the problems.

105992 N1268A Ultra High Voltage Expander is turned off. Connect the power cable properly and check the power switch.
Check the connection of power cable, and solve the problem.

105993 Same SMU cannot be specified for V Control SMU and I Control SMU of N1268A Ultra High Voltage Expander.
Check the UHV Expander tab screen of the Configuration window and set the different SMU to each of Voltage Control SMU and Current Control SMU.
105994  $A$ is already used in $B$.
Check the setting of the Configuration window and set the different SMU to each of the inputs for the selector and the expander control.

105995  Diagnosis failed. Code: $A$, Reason: $B$
Confirm the connections of modules and the connections of output terminals. Then try the diagnosis again.
If the N1265A does not pass Diagnosis, contact your nearest Keysight Technologies.

105996  Diagnosis failed. Code: $A$, Reason: $B$
Confirm the connections of modules and the open condition of output terminals. Then try the diagnosis again.
If the N1268A does not pass Diagnosis, contact your nearest Keysight Technologies.

105998  Main frame reset occurs.
Consult the detail messages and solve the problems.

105999  Communication errors for Digital I/O devices are detected.
Consult the detail messages and solve the problems.

106001  Logon request was rejected. The number of Logons already reaches the limit of the software regulation.
Restart EasyEXPERT. If this error still arises, restart the B1500.

107001  Workspace management error was occurred.
Contact your nearest Keysight Technologies.

107002  Workspace was not found.
Restart EasyEXPERT. If this error still arises, contact your nearest Keysight Technologies.

107003  Workspace could not be loaded.
Restart EasyEXPERT. If this error still arises, contact your nearest Keysight Technologies.

107004  The request to load or create Workspace was rejected. Workspace is already active.
Close the present Workspace and open the Workspace again.

107005  The operation cannot be executed because Workspace is in use now.
Error Message
Keysight EasyEXPERT Operation Error

Close the present Workspace and open the Workspace again.

107006  The workspace name is conflicting. It must be unique in system.
         Specify a proper Workspace name and execute again.

107011  Cannot import Workspace. Specified file is not effective for
         Workspace. Specify the effective file. Path: A

107012  Cannot import Workspace. Specified file is not supported by this
         EasyEXPERT. EasyEXPERT must be updated to the revision A or later
         to import this file. Path: B

107013  Failed to import Workspace. Refer to the detail message, and retry after
         taking necessary measures. Path: A
         Consult the detail messages and solve the problems.

107014  Failed to export Workspace. Refer to the detail message, and retry after
         taking necessary measures. Path: A
         Consult the detail messages and solve the problems.

108001  Function Library management error occurred.
         Contact your nearest Keysight Technologies.

108002  Function Library function has not been configured correctly or is not
         running.
         Restart EasyEXPERT. If the problem still arises, contact your nearest
         Keysight Technologies.

108003  Invalid Function Module assembly file.
         Restart EasyEXPERT. If the problem still arises, contact your nearest
         Keysight Technologies.

108004  Invalid Function Module.
         Restart EasyEXPERT. If the problem still arises, contact your nearest
         Keysight Technologies.

108005  Function Module was not found.
         Restart EasyEXPERT. If the problem still arises, contact your nearest
         Keysight Technologies.

108006  Function Module is inaccessible because it has been removed.
         Restart EasyEXPERT. If the problem still arises, contact your nearest
         Keysight Technologies.
108007  The same process is running now.
        Restart EasyEXPERT. If the problem still arises, contact your nearest
        Keysight Technologies.

108008  Profile was not found.
        Restart EasyEXPERT. If the problem still arises, contact your nearest
        Keysight Technologies.

108009  Profile could not be loaded.
        Restart EasyEXPERT. If the problem still arises, contact your nearest
        Keysight Technologies.

108010  The request to load or create Profile was rejected. Profile is already
        active.
        Restart EasyEXPERT. If the problem still arises, contact your nearest
        Keysight Technologies.

108011  The following function module is incompatible with the installed
        EasyEXPERT software. Module ID: A, Path: B
        Restart EasyEXPERT. If the problem still arises, contact your nearest
        Keysight Technologies.

108020  An I/O error occurred during Function Library operation. Path: A
        Restart EasyEXPERT. If the problem still occurs, contact your nearest
        Keysight Technologies.

108021  Failed to load a Function Module. Path: A
        Restart EasyEXPERT. If the problem still occurs, contact your nearest
        Keysight Technologies.

108022  Failed to save a Function Module. Path: A
        Restart EasyEXPERT. If the problem still occurs, contact your nearest
        Keysight Technologies.

109001  Auto calibration is in progress.
        Wait for the completion of self-calibration.

109002  CMU phase compensation failed.
        Check the cable connection and re-try the phase compensation.

109011  CMU open correction failed.
        Check the cable connection and re-try the open correction.
Error Message
Keysight EasyEXPERT Operation Error

109012  The value of standard for CMU open correction must be finite as admittance.

109021  CMU short correction failed.
         Check the cable connection and re-try the short correction.

109022  The value of standard for CMU short correction must be finite as impedance.

109031  CMU load correction failed.
         Check the cable connection and re-try the load correction.

109032  The value of standard for CMU load correction must be finite in impedance (non-zero as admittance).

109041  Cannot define multiple standby settings for a SMU. Channel: A

109051  Direct Control execution status. Sweep measurement was aborted by the automatic abort function or the power compliance. Test setup: A

109052  Direct Control execution status. Quasi-static CV measurement was aborted by the automatic abort function. Test setup: A

109053  Direct Control execution status. Search measurement was aborted by the automatic abort function. Test setup: A

109054  Direct Control execution status. Sampling measurement was aborted by the automatic abort function. Test setup: A

109061  Duplicate SMU assignment was found. SMU assignment must be unique. SMU: A

110001  Configuration query completed.

111001  Data name (A) is invalid.
         Use the usable characters for the data name.

111002  Function name (A) is invalid.
         Use the usable characters for the function name.

111003  Function name (A) duplicates other data/function name.
         Assign an unique name to each function-variable defined in the test setup.

111004  Definition expression of function (A) is invalid. expression: B
         Check and correct the definition.
111005  The data \( A \) assigned with the data \( B \) is not defined.
In the External Variable Setup of the Application Test definition, specify a defined variable to the External variable.

111006  The data \( A \) assigned to the data \( B \) is not defined.
In the External Variable Setup of the Application Test definition, specify a defined variable to the Measurement data.

111007  The data \( A \) cannot be assigned to the data \( B \) for the mismatch of their types.
In the External Variable Setup of the Application Test definition, check the data type of variables for the External variable and the Measurement data. Assign the variables of the same type.

111008  Recursive definition is not allowed for function \( A \). Expression: \( B \)
Check and correct the expression \( B \).

111011  Vector data expression is expected. Expression: \( A \)
Set a vector data expression.

111012  Numeric expression is expected. Expression: \( A \)
Set a numeric expression.

111013  String expression is expected. Expression: \( A \)
Set a string expression.

111014  Descriptor expression is expected. Expression: \( A \)
Set a descriptor expression.

111015  Module descriptor expression is expected. Expression: \( A \)
Set a module descriptor expression.

111016  ALWaveform type expression must be entered. Expression: \( A \)
Set a ALWaveform type expression.

111021  Test setup name cannot be an empty string.
Set the test setup name which is non empty string.

111022  Test setup name must be \( A \) characters or less.
Set the test setup name within \( A \) characters.

111031  Assign module parameter for ALWaveform type parameter.
Error Message
Keysight EasyEXPERT Operation Error

In the Assign ALWaveform Output Channels of the Application Test definition, set the test parameters of the Module type.

111032  ALWG Pattern Name must be entered.
In the Define ALWG Waveform setup, specify Pattern Name.

111033  Invalid character is included in Name of module parameter assigned for ALWaveform type parameter. Module name: A, Invalid character: B
Use the usable characters for the Module parameter name.

111034  Invalid character is included in ALWG Pattern Name. ALWG pattern name: A, Invalid character: B
Use the usable characters for Pattern Name.

111035  No sequence is defined in the ALWG waveform data. Define one column or more.

111036  Pattern is not defined in the ALWG waveform data for the output channel A. Specify a pattern.

111037  ALWG waveform data contains an invalid pattern.
Name of the invalid pattern: A

111038  ALWG waveform data memory overflow. Delete unnecessary columns or points in a pattern, and increase free space.
Output channel: A, Required space: B, Maximum space: C

112001  Output function must be constant for the unit (A) in common mode.
In the Channel Definition of the Classic Test setup, set Function to CONST for the channel set to Mode: COMMON.

112002  Output function (A) must be assigned to any unit.
In the Channel Definition of the Classic Test setup, set Function to A for any channel.

112003  Output function (A) cannot be assigned to multiple units (B and C).
In the Channel Definition of the Classic Test setup, Function: A is available for a channel.

112004  Pulse mode cannot be assigned to multiple SMUs (A and B).
In the Channel Definition of the I/V Sweep test setup, the pulse mode (VPULSE or IPULSE) can be set to a channel.

112005  I/V mode of the primary sweep source and synchronous sweep source must be the same.
In the Channel Definition of the I/V Sweep test setup, set the same source mode (voltage or current) to the VAR1 and VAR1’ channels.

112006  Duplicate channel data name was found. Channel data name must be unique. Channel data name: A

In the Channel Definition of the Classic Test setup, assign an unique name to each variable defined in the test setup.

112007  Duplicate channel unit assignment was found. Channel unit assignment must be unique. Channel unit: A

In the Channel Definition of the Classic Test setup, a Unit is available for to a channel.

112008  No channel unit was assigned. At least one channel unit must be assigned.

In the Channel Definition of the Classic Test setup, set a channel.

112009  Function (A) can be used for a maximum of B channel(s) in the C mode.

In the Channel Definition of the Classic Test setup, Function: A is available for B channel(s).

112010  All SPGU channels must be set to the same output mode, VPULSE or ALWG.

In the Channel Definition of the Classic Test setup, set the same output mode, VPULSE or ALWG, to all SPGU channels.

112011  SMU descriptor expression is expected. Expression: A

In the Channel Definition of the Classic Test setup, set a SMU descriptor expression to Unit.

112012  CMU descriptor expression is expected. Expression: A

In the Channel Definition of the Classic Test setup, set a CMU descriptor expression to Unit.

112013  SPGU descriptor expression must be entered. Expression: A

In the Channel Definition of the Classic Test setup, set a SPGU descriptor expression to Unit.

112014  Mode must be V or COMMON for VSU (A).

In the Channel Definition of the Classic Test setup, set Mode to V or COMMON for the VSU channel.

112015  VMU (A) must be defined as a constant current source.
Error Message
Keysight EasyEXPERT Operation Error

In the Channel Definition of the Classic Test setup, set Mode to I for the VMU channel.

112016 Mode must be COMMON for GNDU.

In the Channel Definition of the Classic Test setup, set Mode to COMMON for the GNDU channel.

112021 Numeric expression is expected for power compliance. Expression: $A$
Set Pwr Comp to a numeric expression.

112022 No CMU was assigned. At least one CMU must be assigned.

In the Channel Definition of the C-V Sweep test setup, set the CMU channel.

112023 No SMU was assigned. At least one SMU must be assigned.

In the Channel Definition of the I/V-t Sampling test setup, set a SMU channel.

112024 At least one SPGU must be used for SPGU Control.

In the Channel Definition of the SPGU Control setup, set a SPGU channel.

112051 Auto analysis operation failed.
Consult the detail messages and solve the problems.

112052 Invalid value $A$ specified for the switching matrix input setting. Specify a string, string variable, or module variable defined in the test definition or test setup.

Check the value entered into Input of the Switching Matrix Control setup, and enter the appropriate value.

112053 Enter a value for numeric variable $A$, used to specify the switching matrix output channel.

Check the value entered into Output of the Switching Matrix Control setup, and enter the appropriate value.

112054 A switch setup named $A$ is already in the preset group $B$. The switch setup name must be unique in a preset group.

Assign an unique name to each switch setup stored in a preset group (My Favorite Setup).

112055 A preset group named $A$ already exists. The preset group name must be unique.
Assign an unique name to each preset group (My Favorite Setup).

112056 Enter a name for the switching matrix setup.
Set the switch setup name which is non empty string.

112057 Maximum length for a switching matrix setup name is $A$ characters.
Set the switch setup name within $A$ characters.

112058 Read Switch Setup operation failed. Set the switching matrix configuration mode to Normal. Could not read the setup for connecting multiple input ports to a output channel.

112059 The present couple port setting is different from that when this pattern was created. Therefore, there is a possibility that switching matrix will not be set just as you intend.

112060 Specified connection pattern is not available for the couple port $A, B$.
Check the connection pattern and specify the pattern effective for the couple port.

112061 Input port $A$ uses a shared path. The path is currently connected to the other input port. The specified connection is not available.
Disconnect the input port presently connected to the shared path to apply the specified connection. Or use the other input port.

112071 SMU $A$ cannot be used with CMU simultaneously, because it is connected to SCUU.
In the Channel Definition of the Direct Control test setup, use a SMU not connected to SCUU to set CMU channel and SMU channel.

112072 Invalid value $A$ was specified for Enable/Disable of I/V-t Sampling Stop Condition. Valid option(s): $B$
Set the value ($B$) available for Enable/Disable.

112073 Invalid value $A$ was specified for Name of I/V-t Sampling Stop Condition. Valid option(s): $B$
Set the value ($B$) available for Name.

112074 Invalid value $A$ was specified for Event of I/V-t Sampling Stop Condition. Valid option(s): $B$
Set the value ($B$) available for Event.

112075 Invalid function was used in the definition of variable specified by Name of I/V-t Sampling Stop Condition.
Correct the definition of the variable set to Name.

112100  ALWG waveform data for $A$ was not found. Set data of the ALWaveform type parameter properly.
Set ALWG Source to a ALWaveform type variable ($A$) which contains the sequence data. Or set the waveform data for the variable ($A$) properly.

112101  Multiple ALWG waveform data are specified for $A$. Set Properties of the ALWaveform type parameter properly.
Set Properties and waveform data properly for the variable ($A$) defined in Test Specification of Application Test.

112102  Primary sweep source of C-V Sweep must be V mode.
In the C-V Sweep test setup, set Mode to V for the SMU used for the sweep source (VAR1).

112103  $A$ does not support $B$ mode.
In the Channel Definition, set Mode to the value available for $A$.

112103  $A$ does not support $B$ mode.
In the Channel Definition, set Mode to the value available for $A$.

113002  Application test definition name cannot be an empty string.
Set the Application Test definition name which is non empty string.

113003  Application test definition of the same name is already existing. Test definition: $A$ Test categories: $B$
Assign an unique name to each Application Test definition.

113011  Duplicate parameter name was found. Parameter name must be unique. Parameter name: $A$
Assign an unique name to each parameter defined in Test Specification of Application Test.

113012  Duplicate typical value $A$ is assigned. Each typical value must be unique for a numeric parameter.
For setting Typical Values of a Numeric parameter defined in Test Specification of Application Test, set unique values.

113013  Symbol must not be an empty string.
For setting Symbols of a Numeric parameter defined in Test Specification of Application Test, set Symbol which is non empty string.

113014 Symbol $A$ is duplicated. Symbol must be unique for a numeric parameter.

For setting Symbols of a Numeric parameter defined in Test Specification of Application Test, set an unique symbol to each Symbol.

113015 Same value $A$ is assigned to symbols $B$ and $C$. Each symbol must have unique value for a numeric parameter.

For setting Symbols of a Numeric parameter defined in Test Specification of Application Test, assign an unique Value to each Symbol.

113016 Duplicate typical value $A$ is assigned. Each typical value must be unique for a string parameter.

For setting Typical Values of a String parameter defined in Test Specification of Application Test, set unique values.

113017 Empty string is not allowed for the symbol.

For setting Symbols of a Vector parameter defined in Test Specification of Application Test, set Symbol which is non empty string.

113018 Symbol $A$ is used for another vector parameter. Specify a different symbol.

For setting Symbols of a Vector parameter defined in Test Specification of Application Test, set an unique symbol to each Symbol.

113021 The type of evaluated value does not match the type of parameter $A$.

For the parameter defined in Test Specification of Application Test, set a value of the data type specified by Type.

113022 Value for numeric parameter is out of range. Value must be in range. Parameter name: $A$, Parameter value: $B$, Parameter range: from $C$ to $D$.

For the Numeric parameter defined in Test Specification of Application Test, set a value between $C$ and $D$.

113023 Value for string parameter is not contained in the enumeration. Value must be a member of the enumeration. Parameter name: $A$, Parameter value: $B$, Enumeration: $C$. 
Error Message
Keysight EasyEXPERT Operation Error

For the String parameter defined in Test Specification of Application Test, set a value shown in C.

113024 Value for module parameter is invalid or is not compliant to the resource type of the parameter. Parameter name: A, Parameter value: B
For the Module parameter defined in Test Specification of Application Test, set a value which is an available resource included in Resource Types.

113025 Improper value specified for the vector parameter. The value must be within the following range.
Restriction: A, Specified value: B, Effective range: C to D
For the Vector parameter defined in Test Specification of Application Test, set values between C and D.

113031 Test setup A depends on an undefined application test B. Please import the application test B in advance.

114001 A preset group named A already exists. The preset group name must be unique.
Assign an unique name to each preset group (My Favorite Setup).

114002 Unnamed preset group cannot be exported. Please name the preset group in advance.
Before performing the export, set the preset group (My Favorite Setup) name which is non empty string.

114011 A test setup named A is already in the preset group B. The test setup name must be unique in a preset group.
Assign an unique name to each test setup in a preset group (My Favorite Setup).

114012 A test setup named A cannot be retrieved in the preset group B. Probably it had already been modified or deleted.

114021 Following test result record cannot be retrieved. Probably it had already been deleted. Test result record: A

114031 Change the file name in the File Name Format dialog box. Following elements can be used in the file name.

A Setup Name
B Date (Time stamp)
C Count
$D$ Device ID
$E$ Flag
$F$ Remarks

Set the file name by using the usable elements. Or consult the detail messages and solve the problems.

114032 Change the file name in the File Name Format dialog box. Specified value contains an invalid character. Specified file name: $A$
Invalid character: $B$
Set the file name by using the usable characters.

114101 File I/O error occurred during automatic data export. Refer to the detail message, and retry after taking necessary measures.

114102 Specify the folder path in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box.

114103 Change the folder path in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box. Specified value contains an invalid character. Specified folder path: $A$

114104 Folder creation failed during automatic data export. Specify the correct drive letter and folder path in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box.

114105 Change the file extension in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box. Specified value contains an invalid character.
Specified file extension: $A$

114106 Data file creation failed during data folder export or automatic data export. Refer to the detail message, and retry after taking necessary measures.

114107 Index file creation failed during data folder export or automatic data export. Refer to the detail message, and retry after taking necessary measures.

114151 Specify the XML Style Sheet File Path in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box.

114152 Change the XML Style Sheet File Path in the Test Result Data Folder Export dialog box or Test Result Data Auto Export dialog box. Specified value contains an invalid character. Specified path: $A$

115001 There is no working test setup. First preset the test setup.
115011 The application test $A$ depends on an undefined application test $B$. Import the application test $B$ in advance.

115021 Test setup import operation failed. Probably the imported contents are not a test setup.

115022 Test setup conversion failed. Setup $A$ is not available for the tests that use the model $B$.

Use a setup compatible with the model $B$.
To use the setup $A$, restart EasyEXPERT with the Model setting which is used for creating the setup $A$, and modify the setup so that it is compatible with the model $B$.

115031 Failed to invoke $A$.
Consult the detail messages and solve the problems.

115032 Repeat execution was aborted.
Consult the detail messages and solve the problems.

115041 Standby state was changed to OFF due to high voltage related error.

115042 Standby state was automatically changed to OFF by the measurement unit emergency reset.

116001 Connected model not supported by EasyEXPERT. Only model $A$ is supported. Connected model: $B$ (address: $C$)
Update the EasyEXPERT software.

116002 B1500A/B1505A firmware revision $A$ is not supported by this revision of EasyEXPERT. Only revisions $B$ and later are supported.
Update the B1500A/B1505A firmware to the revision $B$ or later.

116003 Invalid argument specified for /gpib. Specified argument: /gpib:$A$
Example argument (valid): /gpib:gpib0::17

116004 EasyEXPERT does not support 4155/56 firmware revision $A$. Update the firmware to the revision $B$ or later.

117001 Enter another label for the switching matrix input port. $A$ is already used for another port.

117002 Do not use a colon (:) in the label for a switching matrix input port.

117003 Connect the switching matrix to use this function. To establish the GPIB connection, set the GPIB address on the Configuration window’s Switching Matrix tab, and click the Poll button.
117004 Invalid value \( A \) for the switching matrix output channel. Value must be between \( B \) and \( C \).

In the Switching Matrix Control setup, set Outputs to the values between \( B \) and \( C \).

117005 \( A \) to \( B \) is not a valid range for the switching matrix output channels. Use positive integers, with the first value no greater than the second.

In the Switching Matrix Control setup, set Outputs so that the value in the right field is greater than the value in the left field. Then set integer greater than or equal to 1.

117006 Switching matrix close error. Enter odd numbers to specify output channels connected to couple input port \( A \).

117007 Switching matrix open error. Enter odd numbers to specify output channels connected to couple input port \( A \).

117008 Switching matrix input port \( A \) is a couple input port. Enter \( A - 1 \) to specify the couple port.

117009 \texttt{srmToModule}(\( A \)) execution failed. Specified port number is out of the valid range (1 to 14). Otherwise, an invalid resource name has been defined in the switching matrix input port configuration. Enter the port number for an input that has a valid resource name.

In the Switching Matrix tab screen of the Configuration window, assign the measurement resource (SMU, CMU, or GNDU) to the input port (SWM IN1 to SWM IN14). And set the argument of the \texttt{srmToModule} built-in function to one of the input port numbers 1 to 14 which is assigned to the measurement resource.

117010 Switching matrix command execution error. B2200 error code: \( A \)

B2200 error message: \( B \)

See \textit{Keysight B2200 User’s Guide}.

117011 Connected model not supported by EasyEXPERT. Only model \( A \) is supported. Connected model: \( B \)

Connect the switching matrix supported by EasyEXPERT, and set the GPIB address correctly.

117012 Capacitance compensation data file read error. Specified file is either corrupt, or is not a compensation data file.
Open the Extended Configuration dialog box from the Switching Matrix tab screen of the Configuration window, and set User Compensation Data File to the name of a proper user defined compensation data file.

117013  Self test failed.
Restart the instruments. If this error still arises, contact your nearest Keysight Technologies.

117014  Your operation to the switching matrix was refused because other test is using it.
Re-try the operation after completing the operation controlled by the Switching Matrix Operation Panel or the Switching Matrix Control setup.

117015  Operation is not supported in offline mode.
Perform the operation in the On-line mode.

120000  Script program execution error.

120001  Duplicated variable name used.
In a script program, the local variable name must be unique. Change the name of the variable.

120002  Script program execution is aborted.
Program execution was paused by clicking the Pause button.

120003  Script program execution ended abnormally.
Program execution was stopped by an illegal operation or statement. Click the Detail button. And consult the detail messages and solve the problems.

120004  An error forced by ERROR statement.
Program execution was stopped by the ERROR statement. This is the status message in normal operation.

120005  Invalid value detected in flow control statement.
Correct the IF, FOR, or other flow control statement. Inappropriate expression is used in the statement.

120006  Pasting program component failed.
Specified program components cannot be pasted to the specified place. Cut or copy the appropriate program components, and paste them to the appropriate place.

120007 Variable type mismatch detected for assigning.
Enter the appropriate value to the variable. Data type must be the same.

120008 Unknown program component imported. Keyword Prefix: A, Keyword: B
Data import was completed for an application test definition that contains a statement to call a test definition not in this system. Then the statement was automatically commented out. Before importing the test definition, import the test definition to be called.

121000 Plug-in execution error.

121001 Plug-in execution aborted.
Plug-in execution was paused by clicking the Pause button.

121002 Plug-in execution ended abnormally.

122000 Script Error.

122001 Operator located in wrong place. Operator: A
Correct the expression. Put the operator in the correct place.

122002 Invalid expression is specified in user function definition.
User function: A, Expression: B
Correct the expression B defined in the user function or analysis function A. Click the Detail button for more information.

122003 Bracket Mismatch.
Add or delete parenthesis. Parentheses must be paired.

122004 Invalid expression is specified for function argument. Function: A, Argument: B
Correct the expression defined in the argument B of the function A. Click the Detail button for more information.

122005 Invalid type of data is specified as function argument.
Check the data type expected by the function and correct the argument.

122006 Incorrect data is specified as function argument.

122007 Specified argument is out of range.
Correct the value of the argument. The value must be within its allowable range.

122008  Invalid character is used for system symbol. System symbol: $A$, Invalid character: $B$

122009  Invalid character is used for user defined symbol. User defined symbol: $A$, Invalid character: $B$

Use the characters available for the user defined symbol.

122010  Missing operator. Index: $A$
Correct the expression. Put the operator on the correct place.

122011  Missing operand. Index: $A$
Correct the expression. Number of operands must be one for the monomial operators, and two for the binomial operators.

122012  Operand Type Mismatch. Operator: $A$
Correct the expression. The type of operands used in the expression must be the same.

122013  Undefined Symbol is used. Symbol: $A$
Correct the expression. Symbols must be defined before using them in the expression.

122014  Function failed to call. Function: $A$
Failed to call the function $A$. For more information, click the Detail button.

122015  Number of vector data elements must be $A$ or less.

122016  Function execution ended abnormally.
Contact your nearest Keysight Technologies.

123000  Only literal value can be specified here.
In the Variable Inspector, enter a string available for a literal value.

130001  Transport function error occurred.

130002  A target package was not found.
Cannot perform file import because of defective file.

130003  The package is unusable because it includes incorrect data.
Cannot perform file import because of defective file.
130004  Package data is insufficient for this process.
Cannot perform file import because of defective file.

130005  File I/O error. Cannot find or access the package file.
Cannot perform file import/export because of access error or defective file.

130011  Data import failed. Data may be incompatible or corrupt. Data: A
If the data is defective, data import cannot be performed.
If the data was created by the new version of EasyEXPERT, update the EasyEXPERT software.
If the data is for the different model, restart EasyEXPERT with the Model setting which is used for creating the data, and modify the data so that it is compatible with the desired model.

131001  Conversion function error occurred.
Consult the detail messages and solve the problems.

131002  Invalid style sheet.
Cannot perform data export (to CSV or XMLSS). Check and correct the style sheet file.

131003  Invalid XML document.
Cannot perform data export (to CSV or XMLSS) because of defective file.

131004  Conversion process failed.
Cannot perform data export (to CSV or XMLSS). Check and correct the style sheet file.

131005  File I/O error. Cannot access the target file.
Cannot perform data export (to CSV or XMLSS) because of access error or defective file.

132001  Command interface error occurred.
Consult the detail messages and solve the problems.

132002  The process failed to execute the specified external command.
Check and correct the command file, check if the file is in the system path, and specify a proper file.
Error Message
Keysight EasyEXPERT Operation Error

133001  GPIB interface error occurred.
Consult the detail messages and solve the problems.

133002  Internal error occurred during GPIB operation.
Check GPIB configuration by using Keysight Connection Expert.

133003  The GPIB operation failed to complete within the specified timeout period.
Set a proper timeout value. Also check GPIB configuration by using Keysight Connection Expert.

133004  The specified expression does not match any device, or the GPIB resource was not found.
Set GPIB address properly. Also check GPIB configuration by using Keysight Connection Expert.

133005  The specified GPIB resources are invalid.
Set GPIB address properly. Also check GPIB configuration by using Keysight Connection Expert.

133006  The specified GPIB address value is invalid.
Set GPIB address properly. Also check GPIB configuration by using Keysight Connection Expert.

133007  The specified GPIB interface number value is invalid.
Set the correct GPIB interface number. Also check GPIB configuration by using Keysight Connection Expert.

133008  The specified timeout value is invalid.
Set a proper timeout value. Also check GPIB configuration by using Keysight Connection Expert.

133009  The specified delimiter characters are invalid.
Set a proper delimiter value. Also check GPIB configuration by using Keysight Connection Expert.

133010  Install Keysight IO Library.

133011  Cannot use the specified GPIB address A that assigned to B1500.
Assign the different GPIB address to the other GPIB devices. And set it properly.

134001  Dialog box interface error occurred.
Consult the detail messages and solve the problems.

134002  The process failed to activate the message-box window.
Restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

134003  Message-box is already registered in the system.
Restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

134004  Message-box function is not available because it is unregistered.
Restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

134005  The message-box configuration with no button information is invalid.
In the message box setup, set Button properly.

135001  No value is entered in this field.
Enter the appropriate value in this field.

140001  Specified value range from $A$ to $B$ of the axis “$C$” is not valid.
Specified value is not allowed for the “$C$” axis of X-Y Graph. Enter a proper value.

140002  Specified scale type “$A$” of the axis “$B$” is not valid.
Set the scale type to LINEAR or LOG.

140003  Data for Auto Analysis is not found.
Cannot find the data that satisfy the automatic analysis condition. Check and specify the analysis condition properly.

140004  Data Display Operation has not completed within specified time ($A$ seconds).
Cannot complete the graph plot, automatic analysis, or data display properly. Re-try the operation. Also restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

140005  Invalid operation for the stream occurred.
Restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

140006  Duplicate data name was found. Data name must be unique. data name:
$A$
Error Message
Keysight EasyEXPERT Operation Error

Assign an unique name for each parameter in the Data Display setup.

140007  No printers installed.
Add a printer.

140008  Operation for printing failed.
Check and set the printer setup properly.

140009  Failed to evaluate the read out function “A”.
Re-try the operation. Also restart EasyEXPERT. If the problem still arises, contact your nearest Keysight Technologies.

140010  Enable the X-Y Graph to use this read out function.

140011  Define the axis A to use this read out function.
Enable the axis A or use this function for the effective axis.

140012  There is no data for this read out function.
Execute measurement to get the data.

140013  Font size must be between A and B.

140014  Number of texts exceeds the limit. Maximum of A texts are allowed.

140015  Number of pointers exceeds the limit. Maximum of A pointers are allowed.

140016  Invalid value included in data specified by the marker. Pointer could not be added.

140017  Available number of decades for the log scale must be between A and B.

140101  Scalar data function call was failed because scalar data named A was not found.
Correct the test definition so that the data is set before the function is called.

140102  Vector data function call was failed because vector data named A was not found.
Correct the test definition so that the data is set before the function is called.

140103  Invalid value (A) was specified for axis scale. Valid option(s): B
Correct the test definition so that the axis scale matches B.
141001  Maximum A Data Display windows can be opened other than the base window.
Close some Data Display windows to open new windows.

141002  Maximum A Base Data Display windows can be opened.
Close some Base Data Display windows to open new windows.

151001  Maximum A Data Display windows can be opened other than the base window.
Close some Data Display windows to open new windows. Or reduce the number of data traces to display from now.

151002  Test execution mode cannot be changed during the test.
Wait until the test is completed.

151003  Up to A data traces can be displayed in the Data Display window.
Reduce the number of data traces to display from now.

151004  Repeat Measurement Setup is not available when Data Record is OFF.
Check “Record Test Result Data Automatically” in the Run Option dialog box before performing the repeat measurement.

151005  Thermo-trigger list must be defined.
Set the thermo-trigger function on the Thermo-trigger List dialog box.

151006  Thermometer channel must be enabled.
In the UHC Expander / Fixture tab screen of the Configuration window, enable the thermometer channel and set the temperature measurement condition.

161001  Number of test definition windows must be A or less.
Close some Test Definition windows to open new windows.

170001  Failed in archive processing. reason: A
Failed in the database backup or recovery. Check if the .xdb file is defective. Also consult the reason and the detail messages, and solve the problems.

171001  Data compression failed. Program error. Contact Keysight Technologies.

171002  Specify a correct file for the import. Specified file is either unsupported or corrupt.
Check if the specified file is defective, and specify a proper file.

171003  File I/O failed during compressed data export. Could not access destination file. Specified file is either unsupported or corrupt. Specify a correct file for the export.

171004  Compression process or decompression process failed. Specified file is either unsupported or corrupt. Specify a correct file for the export or import. It may also be a program error.

200001  Select from the candidates.
        Specify the value from the choices for this field.

200002  Input a numeric value.
        The value must be numeric. Enter a numeric value.

200003  Number of grid data elements must be $A$ or less.
        In the Define vector data dialog box, set the vector data so that the number of data is within $A$.

200004  Data paste failed. Data format is unsupported or incorrect.
        In the Define vector data dialog box, the Paste operation supports comma separated data (each data must be separated by a comma, and have a CR/LF or LF at the end of each line) and tab separated data (each data must be separated by a tab, and have a CR/LF or LF at the end of each line).

200005  Data paste failed. Data of size $A \times B$ cannot be pasted to position $C,D$. It must be pasted to a range of $E \times F$.
        In the Define vector data dialog box, the size of this vector data is $E \times F$. Paste the data within this size.

201001  Failed to load image data. File $A$ may not be an image file.
        Specify a proper image file.

202001  The name $A$ already exists.
        Assign an unique name.

300001  SDA daemon is already running.
        Cannot run the SDA daemon in parallel. If this error is caused by missing the termination process, end StaDaemon.exe by using Windows Task Manager or restart Windows.
300002  SDA daemon configuration file is corrupt. Check the file <common
data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.exe.config.

300003  Specify a correct folder for the EasyEXPERT database. Specified
folder not found.

Check the file <common data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.exe.config and confirm the database folder.

300004  Moving of EasyEXPERT database failed. Refer to the detail message,
and re-try after taking necessary measures.

300005  Another user is running EasyEXPERT. EasyEXPERT does not support
“switching user”.

300011  SDA daemon failed to start FLEX command service.
path: A, arguments: B, reason: C

Contact your nearest Keysight Technologies. Then present the log file
<database folder>/log/latest.log and the reason shown in this message.

300012  FLEX command service was stopped by SDA daemon. After closing
Keysight Connection Expert, launch Start EasyEXPERT or restart
B1500.

300021  SDA daemon failed to start SDA service.
path: A, arguments: B, reason: C

Contact your nearest Keysight Technologies. Then present the log file
<database folder>/log/latest.log and the reason shown in this message.

300031  SDA daemon failed to start SDA shell.
path: A, arguments: B, reason: C

Contact your nearest Keysight Technologies. Then present the log file
<database folder>/log/latest.log and the reason shown in this message.

300041  SDA daemon failed to start model name inspection process.
Path: A, Arguments: B, Reason: C

Contact your nearest Keysight Technologies. Then present the detail
messages and the reason shown in this message.

300042  Model name inspection failed. Set VISA interface ID and GPIB address
correctly, or connect the GPIB cable properly. Reason: A

300051  SDA daemon failed to start database recovery process.
Path: A, Arguments: B, Reason: C
Reinstall EasyEXPERT software. Or contact your nearest Keysight Technologies. Then present the detail messages and the reason shown in this message.

300052 Database recovery failed. Contact Keysight Technologies. Reason: A

Contact your nearest Keysight Technologies. Then present the detail messages and the reason shown in this message.

300061 SDA daemon failed to start SDA authentication.
path: A, arguments: B, reason: C

Contact your nearest Keysight Technologies. Then present the log file <database folder>/log/latest.log and the reason shown in this message.

300101 An error occurred during inspection of the specified database. Path: A
Specify another healthy database backup. See the log file <common data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.log if needed.

300102 The specified EasyEXPERT database is corrupted. Please replace it with a healthy backup or use a copy of initial database.
Path: A, Reason: B
Specify another healthy database backup.

300103 The specified XDB archive is corrupted. Path: A
Specify another healthy database backup.

300104 Disk space is insufficient.
Drive: A, Current Space: B bytes, Required Space: C bytes
To increase disk free space, delete unnecessary files or use folder compression feature of Windows. After you got required space, please retry the operation.

300105 The specified drive A is not the drive B where EasyEXPERT database is located. Please specify a location on the drive B.

300106 Unnecessary content is in the backup. Different versions of databases may be contained in the backup. Content: A
Specify another healthy database backup.

300107 Necessary content is not found in the backup. Content: A
Specify another healthy database backup.

300108 The database of version A is not supported by installed EasyEXPERT software.
Specify another healthy database backup.

300109 Failed to expand XDB archive. Cannot continue restoration of database. The original database is left as before.

Specify another healthy database backup. See the log file <common data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.log if needed.

300110 Could not delete folder. The folder is left in the following location. Path: A

Delete the folder A manually. See the log file <common data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.log if needed.

300111 Failed to replace the current database with the following folder.
Source: A, Destination: B

If Source shows the EasyEXPERT database folder name, the database remains the condition before starting restore.

If Destination shows the EasyEXPERT database folder name, the database is broken. Restore the database by deleting the folder named “1” and renaming the temporary folder named “1.xxx”, for example 1.tmp1A, to “1”.

See the log file <common data folder>\Agilent\EasyEXPERT\Daemon\StaDaemon.log if needed.

300112 Failed to update Application Library. Information: A

Consult the Information A and solve the problem.

300113 The specified backup is partially deleted.

Specify another healthy database backup.

300114 The specified folder is not empty. Please select an empty folder.

300115 Folder deletion is aborted. The folder is left in the following location. Path: A

300116 Expansion of the specified XDB archive is aborted. Expanded files are removed.

300117 Copying the specified folder is aborted. Copied files are removed.

400001 Failed to retrieve inf.dat. Path: A, Description: B

400002 Cannot access EasyEXPERT Database root directory. Path: A, Description: B
Error Message
Keysight EasyEXPERT Operation Error

400003  Intermingled EasyEXPERT Database root directory.
        Path: A, Description: B
400004  Invalid EasyEXPERT root directory. Path: A, Description: B
400005  Failed to retrieve dir file. Path: A, Description: B
400006  Cannot access EasyEXPERT Database lib directory.
        Path: A, Description: B
500011  License device not found. Connect the license device for EasyEXPERT properly. Feature: A, Error: B
500012  License device busy. Try again later. Feature: A, Error: B
500021  License for this feature is locked. Try again later. Feature: A, Error: B
500022  Unlicensed feature found. Feature: A
        Get and install the license.
500023  Unknown license information for this feature. The software revision may be too old. Feature: A
        Update the EasyEXPERT software.
500024  You need the license to use this function. Function: A, Required Option: B
        Get and install the license.
500031  License authentication error. Feature: A, Reason: B
        Contact your nearest Keysight Technologies.
500032  License authentication failed. Feature: A, Reason: B
        Contact your nearest Keysight Technologies.
500041  Installation of the license file is failed. Please check the license file.
        Check if the license file is effective.
500042  Host ID in the license file does not match the actual Host ID. Please check the license file. Actual Host ID: A
        Check if the license file is effective.
500051  License for EasyEXPERT Extension is required. Please specify the license file.
500052  Installation will be aborted. After obtaining the license file for EasyEXPERT Extension, please retry installation.
Get and install the license.

**500053** Starting of EasyEXPERT will be aborted. After obtaining the license file for EasyEXPERT Extension, please retry starting of EasyEXPERT.

Get and install the license.
**Keysight FLEX Execution Error**

When Keysight B1500 causes errors in Keysight FLEX command execution environment, the B1500 returns the following error code and error message.

- **100** Undefined GPIB command.
  Send the correct command.

- **102** Incorrect numeric data syntax.
  Correct the data syntax.

- **103** Incorrect terminator position.
  Correct the command syntax. The number of parameters will be incorrect.

- **104** Incorrect serial data syntax.

- **120** Incorrect parameter value.
  Correct the parameter value.

- **121** Channel number must be 1 to 10.
  Correct the channel number. The channel number must be 1 to 10 for Keysight B1500.

- **122** Number of channels must be corrected.
  Check the MM, FL, CN, CL, IN, DZ, or RZ command, and correct the number of channels.

- **123** Compliance must be set correctly.
  Incorrect compliance value was set. Set the compliance value correctly.

- **124** Incorrect range value for this channel.
  Check the range value available for the channel, and correct the range value.

- **125** Search goal value must be less than compliance value.

- **126** Pulse base and peak must be same polarity.
  The polarity of the base and peak values must be the same in the PI command. Also the polarity of the base, start, and stop values must be the same in the PWI command.
130  Start and stop must be same polarity.
For a log sweep, the polarity of the start and stop values must be the same in the WV, WI, WSV, WSI, or WNX command. Also, 0 is not allowed for the start and stop values.

140  Invalid setup
Check the setup required for the specified function and set it properly.

150  Command input buffer is full.
Keysight B1500 can receive 256 characters maximum including the terminator at one time.

151  This command is not allowed to this channel.

152  Cannot use failed module.
The channel number specifying the module failed the self-test or calibration. Specify another module that passed the self-test or calibration. For the service purpose, execute the RCV command to enable the module.

153  No module for the specified channel.
Module is not installed in the slot specified by the channel number.

154  Cannot recover this module.
The specified module cannot recover from the fail status. It may be defective.

155  Module initialization failed.
The specified module failed the initialization. It may be defective.

160  Incorrect ST execution.
The internal memory programming can be started by the ST command and completed by the END command. Do not enter the ST command between the ST command and the END command.

161  Incorrect END execution.
The internal memory programming can be started by the ST command and completed by the END command. Do not send the END command before starting the programming.

162  Incorrect command for program memory.
Error Message
Keysight FLEX Execution Error

Specified command cannot be stored in the program memory. For the incorrect commands, see *Keysight B1500 Programming Guide*.

170 Incorrect usage of internal variable.

The internal variable must be \%In for integer data, or \%Rn for real data. Where \( n \) is an integer, 0 to 99. Use \%In for the integer type command parameters; and use \%Rn for the real type command parameters. For the internal variables, see the VAR command of *Keysight B1500 Programming Guide*.

171 Internal variable is not allowed.

The internal variables \%In and \%Rn are not available for the ACH, VAR, and VAR? commands. Do not use the internal variables for the commands.

200 Channel output switch must be ON.

To enter the specified command, set the channel output switch to ON.

201 Compliance must be set.

To change the source output mode (voltage or current), set the compliance value.

202 Interlock circuit must be closed.

To set the output voltage or the voltage compliance to more than the allowable voltage for the interlock open condition (high voltage state), close the interlock circuit. If the interlock circuit is opened in the high voltage state, outputs of all units will be set to 0 V.

203 Cannot enable channel.

The channel output switch cannot be set to ON in the high voltage state. Set the output voltage or the voltage compliance to the allowable voltage for the interlock open condition or less to set the switch to ON.

204 Cannot disable channel.

The channel output switch cannot be set to OFF in the high voltage state. Set the output voltage or the voltage compliance to the allowable voltage for the interlock open condition or less to set the switch to OFF. Or send the CL command with no parameter to set switches of all channels to OFF immediately.

205 DZ must be sent before RZ.
The RZ command is effective for the channels set to 0 V output by the DZ command.

206 Do not specify the channel recovered by RZ.

Specify the channels that have not been recovered yet by the RZ command after the DZ command. The RZ command cannot be executed if the specified channels include a channel that has already been recovered by the RZ command.

210 Ext trigger could not start measurement.

External trigger cannot start measurement because of busy condition.

211 TM1 must be sent to use GET.

Send the TM1 command to use the GPIB GET command (TRIGGER statement in HP BASIC).

212 Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the DV, DI, PV, PI, PWV, PWI, TDV, TDI, LSV, LSI, LSSV, LSSI, BSV, BSI, BSSV, or BSSI command. Set the compliance value correctly.

213 Cannot perform self-test or calibration.

Self-test and calibration cannot be performed in the high voltage state. Set the output voltage or the voltage compliance to the allowable voltage for the interlock open condition or less to perform the self-test or calibration.

214 Send MM before measurement trigger.

Before sending the measurement trigger, the MM command must be sent to set the measurement mode.

217 Self-test is not defined for this module.

218 Cannot change output range.

The specified module failed the output range change. The output is set to the initial condition 0 V and 100 μA.

219 Channel output switch must be OFF.

The channel output switch must be OFF before executing the specified command.

220 Send WV or WI to set primary sweep source.
Error Message
Keysight FLEX Execution Error

Before triggering the staircase sweep measurement, triggering the staircase sweep with pulsed bias measurement, or sending the WSV, WSI, or WNX command to set the synchronous sweep source, send the WV or WI command to set the primary sweep source.

221 Send PWV or PWI to set pulse sweep source.

Before triggering the pulsed sweep measurement, or sending the WSV or WSI command to set the synchronous sweep source, send the PWV or PWI command to set the pulse sweep source.

222 Send PV or PI to set pulse source.

Before triggering the staircase sweep with pulsed bias measurement, send the PV or PI command to set the pulse source.

223 Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the WV, WI, WSV, WSI, WNX, or BDV command. Set the compliance value correctly.

224 Sweep and sync output modes must be the same.

The primary sweep channel and the synchronous sweep channel must be different, and they must be set to the same output mode (voltage or current).

225 Send WSV, WSI, or WNX to get sync sweep data.

If you enable data output of the synchronous sweep source, do not forget to set the synchronous sweep source by the WSV, WSI, or WNX command. For data output, see the FMT command of Keysight B1500 Programming Guide.

226 Set linear sweep for MM4 or MM5.

Only the linear sweep is available for the PWV or PWI command for the pulsed sweep measurement (MM4) or the WV or WI command for the staircase sweep with pulsed bias measurement (MM5).

227 Sweep measurement was aborted.

Sweep measurement was aborted by the automatic abort function or the power compliance.

228 Pulse period is not set for pulse measurements.

230 Pulse source must be set.
To perform the pulsed spot measurement (MM3), send the PV or PI command to set the pulse source.

231 Compliance must be set correctly.

Compliance was not set or an incorrect compliance value was set in the PV, PI, PWV, or PWI command. Set the correct compliance value effective for the pulse output.

232 Invalid pulse output setup

Check the pulse output setup and set the correct value.

233 Invalid pulse timing setup

Check the pulse timing parameters and set the correct values.

238 Too large pulse width (max. 2 s).

The maximum value of the pulse width is 2 s. And the available value depends on the pulse period value. See the PT command of Keysight
B1500 Programming Guide.

239 Pulse width must be 0.01 ms or more.

Set the pulse width to 0.01 ms or more. See the PT command of Keysight
B1500 Programming Guide.

240 Enter QSV to set QSCV sweep source.

The QSV command must be entered to set the sweep source of the quasi-static CV measurement.

241 QSR range value must be −9 to −14.

The range values available for the QSR command are −9 to −14. Set one of the available values.

242 QSCV measurement was aborted.

Quasi-static CV measurement was aborted by the automatic abort function.

243 Enter MM13 before QSZ.

Before the QSZ command, the MM13 command must be entered to set the measurement mode.

244 Set a longer integration time to QST.

The integration time is too short to perform the offset measurement. Set a longer value to the integration time parameter of the QST command.
Error Message
Keysight FLEX Execution Error

245 Specify a higher measurement range to QSR.
Too large offset current was measured. Specify the next higher measurement range to the QSR command.

246 QSV mode value must be 1 or 3.
The *mode* values available for the QSV command are 1 (single linear) and 3 (double linear). Set one of the available values.

247 Dedicated channel must be specified by QSO.
Specify the dedicated channel to the QSO command. It must be the channel other than the measurement channel set by the MM13 command or the sweep output channel set by the QSV command.

253 Program memory is full.
Maximum of 2000 programs or 40000 commands can be stored in the program memory. See the ST command of *Keysight B1500 Programming Guide*.

254 Invalid input for a memory program.
The GPIB GET command (TRIGGER statement in HP BASIC) and an external trigger input are not allowed in a memory program (between the ST and END commands).

255 Maximum nesting level is eight.
Nesting (one program calling another) of a memory program must be eight levels or less.

260 Data output buffer is full.
Maximum 34034 measurement data items can be stored in the data output buffer.

270 Search source channel must be set.
Before triggering the search measurement or sending the LSSV, LSSI, BSSV, or BSSI command to set the synchronous search source, send the LSV, LSI, BSV, or BS1 command to set the primary search source.

271 Search monitor channel must be set.
Before triggering the search measurement, send the LGV, LGI, BGV, or BGI command to set the search monitor channel.

273 Search and sync output modes must be the same.
The primary search source channel and the synchronous source channel must be different, and they must be set to the same output mode (voltage or current).

274 Search sync source is overflow.
Set the search sources so that the same output range is set to both primary and synchronous search sources.

275 Search target must be compliance value or less.
The search target value must be less than or equal to the compliance value of the search monitor channel. Correct the search target value or the compliance value.

276 Start and stop must be different.
Set different values for the search start and stop values.

277 Step must be output resolution or more.
Set the search step value to the output resolution or more.

278 Search and sync channels must be different.
Set the search source and the synchronous source to different channels.

279 Search monitor mode must be compliance side.
Send the LGI/BGI command to set the voltage source search monitor channel, or send the LGV/BGV command to set the current source search monitor channel.

280 Send WDCV to set CV sweep source.
Before triggering the multi frequency CV measurement, send the WDCV command to set the DC voltage sweep source.

281 Send PDCV to set CV pulse source.
Before triggering the pulsed spot C measurement, send the PDCV command to set the pulsed voltage source.

282 Send PWDCV to set CV pulse sweep source.
Before triggering the pulsed CV measurement, send the PWDCV command to set the pulsed voltage sweep source.

283 Set linear sweep for MM20.
Only the linear sweep is available for the PWDCV command for the pulsed CV measurement (MM20).
Error Message
Keysight FLEX Execution Error

284  Improper setting of CMU frequency and pulse width.
     Pulse width value is out of the range for the CMU output frequency. Set
     both frequency value and pulse width value properly.

290  Send WFC to set Cf sweep source.
     Before triggering the Cf sweep measurement, send the WFC command
     to set the frequency sweep source (oscillator).

301  Line power failure.

303  Excess voltage in MPSMU.
     Voltage that exceeds maximum voltage at the present current range was
     detected by a MPSMU. All output switches were set to OFF.

304  Ground unit abuse is detected.

305  Excess current in HPSMU.
     Current that exceeds maximum current at the present voltage range was
     detected by a HPSMU. All output switches were set to OFF.

307  Unsupported module.
     This module is not supported by this firmware revision. Until you
     update the firmware, use Keysight B1500 with this module removed.

309  Unknown emergency occurred.
     All modules stopped their output and opened their output relay.

310  Interlock open operation error. Initialized.
     Initialization was automatically performed because the B1500 failed to
     set its output to 0 V when the interlock circuit was opened in the high
     voltage condition. Any module may be defective. Perform self-test.

311  ASU control cable was connected/disconnected.
     The B1500 must be turned off when the Atto Sense and Switch Unit
     (ASU) is connected/disconnected.

312  SCUU control cable was connected/disconnected.
     The B1500 must be turned off when the SMU CMU Unify Unit
     (SCUU) is connected/disconnected.

320  Excess current in CMU.
     Current that exceeds maximum current at the present voltage range was
     detected by the CMU. The output switch was set to OFF.
321 This command is not available for CMU.
CMU was specified for the SMU dedicated command. Specify SMU.

322 This command is not available for SMU.
SMU was specified for the CMU dedicated command. Specify CMU.

323 Use SSP instead of CN for SCUU modules.
It is not necessary to specify the modules connected to the SMU CMU Unify Unit (SCUU) in the CN command. The output switches will be controlled by the SSP command.

330 Turn on again to detect source channel.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

331 Turn on again to detect synchronous channel.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

332 Turn on again to detect measurement channel.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

333 Turn on again to detect search source.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

334 Turn on again to detect search sync source.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

335 Turn on again to detect search monitor channel.
SCUU might be disconnected/connected on the power on condition. Restart the B1500 to detect and enable the channel.

603 Sweep and pulse channels must be different.
Set the sweep source and the pulse source to different channels for the staircase sweep with pulsed bias measurement (MM5).

610 Quasi-pulse source channel must be set.
Before triggering the quasi-pulsed spot measurement, send the BDV command to set the quasi-pulse source.
Error Message
Keysight FLEX Execution Error

620 TGP specified incorrect I/O port.
Specify trigger input for the Ext Trig In port, or trigger output for the Ext Trig Out port by the TGP command. See the TGP command of Programming Guide.

621 Specify trigger input port for PAX/WSX.
No trigger input port was specified for the PAX or WSX command. Specify the trigger input port, or set the port as the trigger input port. See the TGP command of Keysight B1500 Programming Guide to set trigger port.

622 Specify trigger output port for OSX.
No trigger output port was specified for the OSX command. Specify the trigger output port, or set the port as the trigger output port. See the TGP command of Keysight B1500 Programming Guide to set trigger port.

626 DIO control mode must be HV/HC/HP SMU selector control mode (ERMOD 2).
Set the digital IO control mode to the N1258A/N1259A control mode by using the ERMOD 2 command.

627 Mismatch HV/HC/HP SMU selector ID
Module selector is not connected to the Digital IO connector. Connect the N1258A or the module selector of the N1259A.

628 HV/HC/HP SMU selector control cable was disconnected.
Connection cable was removed. Turn the instrument off and connect the cable. And then turn the instrument on again.

629 HV/HC/HP SMU selector is not active.
Module selector does not respond. The power code may be removed.

630 Incorrect polarity of search step value.
For the linear search measurement. The step value must be positive if start<stop, or negative if start>stop.

631 Number of search steps must be 1001 or less.
For the linear search measurement. The number of search steps between start and stop must be 1001 or less. This means the |step| value must be |stop−start|/1001 or more.
Error Message
Keysight FLEX Execution Error

632	Search measurement was aborted.
Search measurement was aborted by the automatic abort function.

640	Search limits must be range/20000 or more.
For the binary search measurement. The limit value for the search target must be \textit{range}/20000 or more. where \textit{range} means the measurement range actually used for the measurement.

650	Data format must be ASCII to get time data.
The time stamp function is not available for the binary data output format. To use the time stamp function, set the data output format to ASCII.

655	Cannot connect/disconnect series resistor.
The series resistor status cannot be changed in the high voltage state. Set the output voltage or the voltage compliance to the allowable voltage for the interlock open condition or less to connect or disconnect the series resistor.

656	Series resistor must be OFF for 1 A range.
The series resistor cannot be set to ON for the measurement channels or the output channels that use 1 A range.

657	Series resistor cannot be used with ASU.
The series resistor is not available for the channel connected to the Atto Sense and Switch Unit (ASU).

660	Sampling measurement was aborted.
Sampling measurement was aborted by the automatic abort function.

661	Negative hold time is only valid for I/V-t linear sampling with interval < 2 ms.

662	Sampling interval for I/V-t log sampling must be 2 ms or longer.

663	Number of samples does not have to exceed 100001.

664	Base and bias must be same polarity for I mode.
The base and bias values of the MI command must be the same polarity.

670	Specified channel does not have ASU.
Specify the module that can be used with the ASU.
Error Message
Keysight FLEX Execution Error

<table>
<thead>
<tr>
<th>No.</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>671</td>
<td>SSP is not available for this channel. SSP command is available only for the CMU. Specify the slot number that the CMU has been installed.</td>
</tr>
<tr>
<td>680</td>
<td>CMU correction mode must be manual. To perform the CMU correction by using the ADJ? command, set the CMU correction mode to manual by using the ADJ command.</td>
</tr>
<tr>
<td>681</td>
<td>CMU correction mode must be off.</td>
</tr>
<tr>
<td>682</td>
<td>Invalid standard is specified as CMU correction.</td>
</tr>
<tr>
<td>683</td>
<td>Frequency index is not available for CMU correction.</td>
</tr>
<tr>
<td>684</td>
<td>AC Voltage is 0 mV.</td>
</tr>
<tr>
<td>685</td>
<td>CMU correction is not complete.</td>
</tr>
<tr>
<td>690</td>
<td>DIO control mode must be Ultra High Current Expander / Fixture control mode (ERMOD 4). Set the digital IO control mode to N1265A control mode by using the ERMOD 4 command.</td>
</tr>
<tr>
<td>691</td>
<td>Mismatch Ultra High Current Expander / Fixture ID. Ultra high current expander(fixture) is not connected to the Digital IO connector. Connect the N1265A.</td>
</tr>
<tr>
<td>692</td>
<td>Ultra High Current Expander / Fixture control cable was disconnected. Connection cable was removed. Turn the instrument off and connect the cable. And then turn the instrument on again.</td>
</tr>
<tr>
<td>693</td>
<td>Ultra High Current Expander / Fixture is not active. Ultra high current expander(fixture) does not respond. The power switch may be off or the power code may be removed.</td>
</tr>
<tr>
<td>694</td>
<td>DIO control mode must be HVSMU Current Expander control mode (ERMOD 8). Set the digital IO control mode to N1266A control mode by using the ERMOD 8 command.</td>
</tr>
<tr>
<td>695</td>
<td>Mismatch HVSMU Current Expander ID. HVSMU current expander is not connected to the Digital IO connector. Connect the N1266A.</td>
</tr>
<tr>
<td>696</td>
<td>HVSMU Current Expander control cable was disconnected.</td>
</tr>
</tbody>
</table>
Connection cable was removed. Turn the instrument off and connect
the cable. And then turn the instrument on again.

**697**
HVSMU Current Expander is not active.

HVSMU current expander does not respond. The power switch may be
off or the power code may be removed.

**940**
DIO control mode must be Ultra High Voltage Expander control mode
(ERMOD 16).

Set the digital IO control mode to N1268A control mode by using the
ERMOD 16 command.

**941**
Mismatch Ultra High Voltage Expander ID.

Ultra high voltage expander is not connected to the Digital IO
connector. Connect the N1268A.

**942**
Ultra High Voltage Expander control cable was disconnected.

Connection cable was removed. Turn the instrument off and connect
the cable. And then turn the instrument on again.

**943**
Ultra High Voltage Expander is not active.

Ultra high voltage expander does not respond. The power cord may be
removed.

**950**
DIO control mode must be Device Capacitance Selector control mode
(ERMOD 32).

Set the digital IO control mode to N1272A control mode by using the
ERMOD 32 command.

**951**
Mismatch Device Capacitance Selector ID.

N1272A/B1506A/B1507A is not connected to the Digital IO connector.
Connect the N1272A, B1506A, or B1507A.

**952**
Device Capacitance Selector control cable was disconnected.

Connection cable was removed. Turn the instrument off and connect
the cable. And then turn the instrument on again.

**953**
Device Capacitance Selector is not active.

N1272A/B1506A/B1507A does not respond. The power cord may be
removed.

**999**
Error not supported by the ERR? command occurs. Execute the ERRX?
command to read the error code and the error message.
### Error Message

**Keysight FLEX Execution Error**

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>The specified module doesn’t support power compliance. The power compliance is not available for the specified module.</td>
</tr>
<tr>
<td>1001</td>
<td>Illegal pulse duty</td>
</tr>
<tr>
<td></td>
<td>Set the pulse period and the pulse width so that the pulse duty ratio is within the acceptable range.</td>
</tr>
<tr>
<td>1002</td>
<td>Illegal pulse width</td>
</tr>
<tr>
<td></td>
<td>Check the pulse width and set the correct value.</td>
</tr>
<tr>
<td>1003</td>
<td>Illegal pulse base/peak limit</td>
</tr>
<tr>
<td></td>
<td>Check the pulse base and peak values, and set the correct values.</td>
</tr>
<tr>
<td>1004</td>
<td>Illegal pulse base/peak polarity</td>
</tr>
<tr>
<td></td>
<td>Check the pulse base and peak values, and set the polarity properly.</td>
</tr>
<tr>
<td>1005</td>
<td>Illegal sweep polarity</td>
</tr>
<tr>
<td></td>
<td>Check the sweep start and stop values, and set the polarity properly.</td>
</tr>
<tr>
<td>1006</td>
<td>Application measurement setup is not sufficient.</td>
</tr>
<tr>
<td></td>
<td>Check the setup required for the specified measurement and set it properly.</td>
</tr>
<tr>
<td>1007</td>
<td>Source channel must be set.</td>
</tr>
<tr>
<td></td>
<td>Set the source output channel properly.</td>
</tr>
<tr>
<td>1008</td>
<td>Pulse output channel is required.</td>
</tr>
<tr>
<td></td>
<td>Specify the pulse output channel. Or set the pulse output channel properly.</td>
</tr>
<tr>
<td>1009</td>
<td>The specified value is out of range defined by output limit function.</td>
</tr>
<tr>
<td></td>
<td>Specify the voltage/current output value within the range limited by the LIM command. Or change the limit value by using the LIM command.</td>
</tr>
<tr>
<td>1010</td>
<td>This B1500A does not support PCH.</td>
</tr>
<tr>
<td></td>
<td>PCH is not supported by this B1500A. The B1500A must be upgraded to use the dual HCSMU operation.</td>
</tr>
<tr>
<td>1011</td>
<td>SMU is not installed in the slot set to PCH.</td>
</tr>
<tr>
<td></td>
<td>Empty slot or non SMU module was specified by PCH. The HCSMU modules must be specified.</td>
</tr>
</tbody>
</table>
1012 Execute CL to the modules set to PCH. Output switch of the modules set to PCH must be OFF previously.

1013 Execute ERHPA 0,0,0 before PCH. Modules set to ERHPA cannot be specified in PCH. Execute ERHPA 0,0,0, then execute PCH. After that execute ERHPA to set the module selector input connection.

1014 Modules set to PCH must be HCSMU. Only the HCSMU module can be specified in PCH.

1015 Modules set to PCH must be different. Same module was specified by PCH for both master and slave HCSMU modules. They must be the different modules.

1016 Do not execute CN/CNX to the slave module set to PCH. Specify the master module in CN/CNX to enable the dual HCSMU channel.

1017 Specified module is already used for dual HCSMU. Specify a free HCSMU.

1018 Total setting current exceeds the capacity of main frame power supply. Reduce setting current. Set the current lower than the specified value.

1019 A voltage setting other than 0 V or a current setting above +4 mA or below −4 mA can be applied to only one HVSMU channel in case of single channel HVSMU operation. Change HVSMU operation mode by HVSMUOP command.

1020 Cannot change HVSMU operation mode in high voltage status. Execute HVSMUOP command after solving the high voltage status.

1021 Cannot change N1274A path in high voltage status. Execute ERHPQG command after solving the high voltage status.

1022 Execute ERHPE 1 before ERHPQG. Enable the external relay control function of the N1258A module selector using ERHPE command, and then execute ERHPQG command.

2000 SPGU module does not exist.
Error Message
Keysight FLEX Execution Error

The SPGU channel number must be specified correctly.

2001 SPGU channel does not exist.
The SPGU channel number must be specified correctly.

2002 SPGU signal source does not exist.
The SPGU signal source number must be specified correctly.

2003 SPGU operation mode must be PG. (SIM 0).
2004 SPGU operation mode must be ALWG (SIM 1).

2051 Over voltage emergency occurred.
All modules stopped their output and opened their output relay.

2052 Over current emergency occurred.
All modules stopped their output and opened their output relay.

2053 High temperature emergency occurred.
All modules stopped their output and opened their output relay.

2054 Over voltage H/W SRQ detected.
Specified module stopped the output and opened the output relay.

2055 Over current H/W SRQ detected.
Specified module stopped the output and opened the output relay.

2056 High temperature H/W SRQ detected.
Specified module stopped the output and opened the output relay.

2101 Specified load impedance is out of absolute limits.
Set the appropriate impedance value to SER.

2103 Specified period is out of absolute limits.
Set the appropriate pulse period value to SPPER.

2104 Specified trigger count is out of absolute limits.
Set the appropriate count value to SPRM.

2105 Specified load voltage is out of range.
Set the appropriate voltage to SPV or ALW.

2106 Specified load voltage of added amplitude is out of range.
Error Message
Keysight FLEX Execution Error

Set the appropriate voltage to SPV for setting the 3-level pulse output.

2107 Specified voltage is out of absolute limits (can't achieve amplitude).

Set the appropriate voltage to SPV. It must be the voltage which can be applied under the present load impedance condition.

2108 Specified transition time is out of absolute limits.

Set the appropriate value of leading time or trailing time to SPT.

2111 Leading/0.8 must be within Width value.

Set the appropriate value to SPT. The pulse width value must be more than leading time/0.8 value.

2112 Delay + Width + Trail/0.8 must be within Period value.

Set the appropriate value to SPT. The pulse period value must be more than delay time + pulse width + trailing time/0.8 value.

2113 Specified pulse delay is out of absolute limits.

Set the appropriate delay time value to SPT.

2114 Specified pulse width is out of absolute limits.

Set the appropriate pulse width value to SPT.

2115 Specified duration is out of absolute limits.

Set the appropriate duration value to SPRM.

2121 Delay + Width must be within Period value (ODSW Timing).

Set the appropriate value to ODSW. The period value must be more than delay + width value.

2122 Specified ODSW delay timing parameter out of absolute limits.

Set the appropriate delay value to ODSW.

2123 Specified ODSW width timing parameter out of absolute limits.

Set the appropriate width value to ODSW.

2131 Delay + Interval * N must be within Period value (ADC Timing).

Set the appropriate value to CORRSER?. The period value must be more than delay + interval * count value.

2132 Specified delay for DUT impedance measurement out of absolute limits.
Error Message
Keysight FLEX Execution Error

Set the appropriate delay time value to CORRSER?.

2133 Specified interval for DUT impedance measurement out of absolute limits.
Set the appropriate interval value to CORRSER?.

2134 Specified count for DUT impedance measurement out of absolute limits.
Set the appropriate count value to CORRSER?.

2151 ALWG Sequence Data is not ready.
Sequence data must be set by using ALS before starting the output.

2152 Specified ALWG Sequence Data size is out of absolute limits.
Set the appropriate sequence data to ALS. Too large data was specified.

2153 Specified pattern index of ALWG Sequence Data is out of absolute limits.
Set the appropriate sequence data to ALS. The pattern index in the sequence data must be the index of a pattern defined in the pattern data.

2154 Specified repeat count of ALWG Sequence Data is out of absolute limits.
Set the appropriate sequence data to ALS. The repeat count in the sequence data must be 1 to 1048576.

2155 ALWG Pattern Data is not ready.
Pattern data must be set by using ALW before starting the output.

2156 Specified ALWG Pattern Data size is out of absolute limits.
Set the appropriate pattern data to ALW. Too large data was specified.

2157 Specified interval time of ALWG Pattern is out of absolute limits.
Set the appropriate pattern data to ALW. The incremental time value in the pattern data must be 10 ns to 671.088630 ms in 10 ns resolution.

2158 Specified output voltage of ALWG Pattern Data is out of absolute limits.
Set the appropriate pattern data to ALW. The output level value in the pattern data must be 0 to ±40 V in 1 mV resolution.

2204 Load voltage is too small for DUT impedance measurement.
Error Message

Keysight FLEX Execution Error

Failed to perform the terminal voltage measurement and the load impedance calculation by the CORRSER? command. Set the SPGU output voltage more than 1 V. Set high voltage for high impedance.

2206 Auto correction of load impedance failed.

Cannot perform the SPGU automatic level adjustment. Load impedance exceeds the acceptable range. Change the SPGU output voltage or the DUT.

3000 WGFMU module does not exist.

Check the channel number of the WGFMU module and set the correct value.

3001 RSU is not connected.

Check the channel number of the WGFMU module connected to the RSU and set the correct value.

3015 Measurement data corrupted.

Cannot get the measurement data. Correct measurement result is not stored in the memory.

3050 Measurement data memory overflow error.

ALWG sequencer run time error. WGFMU module memory overflow occurred. Data exceeds memory size could not be stored.

3051 Measurement data FIFO overflow error.

ALWG sequencer run time error. WGFMU module FIFO overflow occurred because the averaging count was frequently changed.

3052 Measurement range change request error.

ALWG sequencer run time error. Measurement range cannot be changed because the range change interval is too short.

3201 ALWG Sequence Data is not ready.

Sequence data must be set to the specified WGFMU channel.

3202 ALWG Waveform Data is not ready.

Waveform data must be set to the specified WGFMU channel.

3301 Specified output voltage is out of absolute limits.
Error Message

Keysight FLEX Execution Error

Check the output voltage and set the correct value. The value must be
−3 V to +3 V for the 3 V range, −5 V to +5 V for the 5 V range, −10 V
to 0 V for the −10 V range, or 0 V to +10 V for the +10 V range.

3302 Specified voltage output range is invalid.
Check the voltage output range and set the correct value.

3303 Invalid measurement mode for current operation mode.
Operation mode must be Fast IV or DC to perform current
measurement.

3304 Specified ALWG Vector Data size is out of absolute limits.
ALWG data cannot be read because of too large data size.

3305 Specified ALWG Sequence Data size is out of absolute limits.
ALWG data cannot be read because of too large sequence data size.

3306 ALWG Waveform Data is empty.
ALWG data must not be empty.

3307 Specified ALWG Waveform Data size is out of absolute limits.
ALWG data cannot be read because of too large waveform data size.

3308 Specified waveform index of ALWG Sequence Data is out of absolute
limits.
Check the index value of the sequence data and set the correct value.

3309 Specified loop number of ALWG Sequence Data is out of absolute
limits.
Check the loop value of the sequence data and set the correct value.

3310 Specified output voltage of ALWG Waveform Data is out of absolute
limits.
Check the output voltage and set the correct value. The value must be
−3 V to +3 V for the 3 V range, −5 V to +5 V for the 5 V range, −10 V
to 0 V for the −10 V range, or 0 V to +10 V for the +10 V range.

3311 Specified interval time of ALWG Waveform is out of absolute limits.
Check the incremental time (interval time) and set the correct value.
The value must be 10 ns to 10995.11627775 s, in 10 ns resolution.

3312 Specified ALWG measurement interval time is out of absolute limits.
Error Message
Keysight FLEX Execution Error

Check the measurement interval time and set the correct value. The value must be 10 ns to 1.34217728 s, in 10 ns resolution.

3313 Specified ALWG measurement instruction code is invalid.
Check the measurement event setting and set the correct values.

3314 Specified ALWG range change instruction code is invalid.
Check the range event setting and set the correct values.

3315 Specified ALWG measurement count is out of absolute limits.
Check the measurement averaging time and set the correct value. The value must be 0, or 10 ns to 0.020971512 s, in 10 ns resolution.

3316 Specified ALWG measurement count is greater than measurement interval.
Check the measurement averaging time and set the correct value. The value must less than or equal to the measurement interval time.

3317 Specified slot is invalid.
Check the slot number and set the correct value. The slot number must be 1 to 10.

3318 Specified module channel is invalid.
Check the channel number and set the correct value.

3319 Output delay is out of absolute limits.
Check the output delay and set the correct value. The value must be -50 ns to 50 ns, in 625 ps resolution.

3320 Measurement delay is out of absolute limits.
Check the measurement delay and set the correct value. The value must be -50 ns to 50 ns, in 625 ps resolution.

3321 VM/IM measurement mode is invalid.
Check the measurement mode and set the correct value.

3322 Voltage measurement range is invalid.
Check the voltage measurement range and set the correct value.

3323 Current measurement range is invalid.
Check the current measurement range and set the correct value.

3324 WGMA?, WGMB? command query size is out of absolute limits.
Error Message
Keysight FLEX Execution Error

Check the data size for WGMA? or WGMB? and set the correct value.

3325 Specified count for spot measurement is out of absolute limits.
Check the count value for WGMS? and set the correct value.

3326 Specified interval for spot measurement is out of absolute limits.
Check the interval value for WGMS? and set the correct value.

3327 Specified operation mode is invalid for spot measurement.
Operation mode must be DC to perform spot measurement.

4304 HV/HC/HP SMU selector must be open state.
Set the module selector input-output path to the open status to execute the specified command.

4305 External relay control is not active.
Enable the external relay control function by using the ERHPE command to enter the specified command. Also, check the cable connection and the relay operation.

NOTE If one of the errors 4401 to 4408 occurs, the all module output is changed to 0 V and the all output switch is disconnected.

4401 HVSMU over voltage emergency occurred.
4402 HVSMU over current or guard abuse emergency occurred.
4403 HVSMU guard abuse emergency occurred.
4404 HVSMU HVPS cannot power-off emergency occurred.
4405 HVSMU V ADC lost emergency occurred.
4406 HVSMU I ADC lost emergency occurred.
4407 HVSMU Float lost emergency occurred.
4408 HVSMU HVPS cannot power-on emergency occurred.

5301 Specified module is already assigned to voltage control, current control or gate control.
Specify a free MCSMU/HCSMU.

5302 Voltage control module and current control module must be different.
Specify a free MCSMU/HCSMU.
<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>5303</td>
<td>Do not execute CN/CNX to the current control module set to ERPFUHCA. Execute the CN/CNX command to the module that is set to voltage control by the ERPFUHCA command.</td>
</tr>
<tr>
<td>5304</td>
<td>Ultra High Current Expander / Fixture drain path must be open state. Open the selector connection path before switch the HVSMU series resistor.</td>
</tr>
<tr>
<td>5305</td>
<td>Execute CL to the module set to ERPFUHCA. Execute the CL command to the modules that will be specified by the ERPFUHCA command.</td>
</tr>
<tr>
<td>5306</td>
<td>Ultra High Current Expander / Fixture gate path must be open state. Open the gate connection path before switching the series resistor for the path.</td>
</tr>
<tr>
<td>5307</td>
<td>CRC for N1265A/B1506A EEPROM Vs correction segment failed. N1265A/B1506A might be defective. Contact your nearest Keysight Technologies service center.</td>
</tr>
<tr>
<td>5308</td>
<td>CRC for N1265A/B1506A EEPROM Is correction segment failed. N1265A/B1506A might be defective. Contact your nearest Keysight Technologies service center.</td>
</tr>
<tr>
<td>5309</td>
<td>CRC for N1265A/B1506A EEPROM Vm correction segment failed. N1265A/B1506A might be defective. Contact your nearest Keysight Technologies service center.</td>
</tr>
<tr>
<td>5310</td>
<td>CRC for N1265A/B1506A EEPROM Im correction segment failed. N1265A/B1506A might be defective. Contact your nearest Keysight Technologies service center.</td>
</tr>
<tr>
<td>5311</td>
<td>Specified module is already assigned to voltage control or current control of HVMCU. Specify a free MCSMU/HCSMU.</td>
</tr>
<tr>
<td>5312</td>
<td>Different module must be assigned to voltage control and current control of HVMCU. Specify a free MCSMU/HCSMU.</td>
</tr>
</tbody>
</table>
Error Message
Keysight FLEX Execution Error

5313  Do not execute CN/CNX to the current control module set to ERHVCA.
Execute the CN/CNX command to the module that is set to voltage control by the ERHVCA command.

5314  HVSMU Current Expander output must be open state.
Open the input-output path before switching the HVSMU series resistor.

5315  Execute CL to the module set to ERHVCA.
Execute the CL command to the modules that will be specified by the ERHVCA command.

5316  CRC for N1266A EEPROM Vm correction segment failed.
N1266A might be defective. Contact your nearest Keysight Technologies service center.

5317  CRC for N1266A EEPROM Im correction segment failed.
N1266A might be defective. Contact your nearest Keysight Technologies service center.

5318  Over voltage is detected in Selector Output High Force, Low Force, or Low Sense terminal of N1265A/B1506A.
Remove the causes of overvoltage.

5319  Over voltage is detected in Selector Output High Sense terminal of N1265A/B1506A.
Remove the causes of overvoltage.

5320  Pulse width overrun is detected in N1265A/B1506A.
Check the assignment of control modules.

5321  Specified module is already assigned to voltage control or current control of UHVU.
Specify a free MCSMU/HCSMU.

5322  Different module must be assigned to voltage control and current control of UHVU.
Specify a free MCSMU/HCSMU.

5323  Do not execute CN/CNX to the current control module set to ERUHVA.
Execute the CN/CNX command to the module that is set to voltage control by the ERUHVA command.

5324 Execute CL to the module set to ERUHVA.

Execute the CL command to the modules that will be specified by the ERUHVA command.

5325 Specified module is already used for UHCU, Selector, or Gate of N1265A/B1506A.

Specify a free module.

5326 Specified module is already used for HVMCU.

Specify a free module.

5327 Specified module is already used for UHVU.

Specify a free module.

5330 N1265A/B1506A: Cooling fan is not operating.

Check the operation of cooling fan and the condition around the fan.

5331 Execute CL to the module set to ERCMAA.

5332 Execute ERCMAIO to clear measurement path of Device Capacitance Selector before executing ERCMAGRD.

5333 Invalid parameters for ERCMAIO.

5334 N1272A/B1506A/B1507A: Input modules are not assigned. Execute ERCMAA to assign input modules.

5340 N1265A/B1506A: Control modules are not assigned. Execute ERPFUHCA to assign control modules.

5341 N1265A/B1506A: Status test failed.

5342 N1265A/B1506A: Voltage pulse test failed.

5343 N1265A/B1506A: Current pulse test failed.

5344 N1265A/B1506A: Current measurement CMR test failed.

5345 N1265A/B1506A: Offset voltage test failed.

5346 N1265A/B1506A: Voltage measurement offset test failed.

5347 N1265A/B1506A: Current measurement offset test failed.

5350 N1266A: Control modules are not assigned. Execute ERHVCA to assign control modules.
Error Message
Keysight FLEX Execution Error

5351 N1265A/B1506A: Voltage measurement offset calibration failed.
5352 N1265A/B1506A: Current measurement offset calibration failed.
5355 N1266A: Cannot use N1258A’s series resistor for HVSMU.
5356 N1266A: Cannot use N1265A’s series resistor for HVSMU.
5360 N1268A: Control modules are not assigned. Execute ERUHVA to assign control modules.
5361 N1266A: Voltage pulse test failed.
5371 Specified module cannot be used in the present measurement mode.
5381 N1265A/B1506A diagnosis failed.
5385 N1268A diagnosis failed.
5395 N1272A/B1506A/B1507A diagnosis failed.

NOTE
If one of the errors 5401 to 5413 occurs, the all module output is changed to 0 V and the all output switch is disconnected.

5401 HCSMU high force over voltage emergency occurred.
5402 HCSMU high sense over voltage emergency occurred.
5403 HCSMU low force over voltage emergency occurred.
5404 HCSMU low sense over voltage emergency occurred.
5405 HCSMU low sense chassis over voltage emergency occurred.
5406 HCSMU power supply shortage voltage emergency occurred.
5407 HCSMU sense open error detected.
5408 HCSMU pulse peak over current emergency occurred.
5409 HCSMU DC over current emergency occurred.
5410 HCSMU pulse width over current emergency occurred.
5411 HCSMU float lost emergency occurred.
5413 HCSMU should not apply low current to high impedance device.

NOTE
If one of the errors 6401 to 6413 occurs, the all module output is changed to 0 V and the all output switch is disconnected.

6401 MCSMU high force over voltage emergency occurred.
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6402</td>
<td>MCSMU high sense over voltage emergency occurred.</td>
</tr>
<tr>
<td>6403</td>
<td>MCSMU low force over voltage emergency occurred.</td>
</tr>
<tr>
<td>6404</td>
<td>MCSMU low sense over voltage emergency occurred.</td>
</tr>
<tr>
<td>6410</td>
<td>MCSMU pulse width over current emergency occurred.</td>
</tr>
<tr>
<td>6411</td>
<td>MCSMU float lost emergency occurred.</td>
</tr>
<tr>
<td>6412</td>
<td>MCSMU calculation overflow emergency occurred.</td>
</tr>
<tr>
<td>6413</td>
<td>MCSMU should not apply low current to high impedance device.</td>
</tr>
</tbody>
</table>
Error Message
Keysight B1500 Self-test/Calibration Error

**Keysight B1500 Self-test/Calibration Error**

When Keysight B1500 fails the self-test or self-calibration, the B1500 returns the following error code and error message.

In the error code, N indicates the slot number. If the module is installed in slot 1, and it fails the function test, the error code will be 1760.

- **700** CPU failed NVRAM read/write test.
- **701** CPU failed FPGA read/write test.
- **702** CPU failed H-RESOLN ADC end signal test.
- **703** CPU failed H-RESOLN ADC start signal test.
- **704** CPU failed emergency status signal test.
- **705** CPU failed SRQ status signal test.
- **706** CPU failed high voltage status signal test.
- **707** CPU failed low voltage status signal test.
- **708** CPU failed DAC settling status signal test.
- **709** CPU failed measure ready status signal test.
- **710** CPU failed set ready status signal test.
- **711** CPU failed measure end status signal test.
- **712** CPU failed measure trigger signal test.
- **713** CPU failed pulse trigger signal test.
- **714** CPU failed abort trigger signal test.
- **715** CPU failed DAC set trigger signal test.
- **720** H-RESOLN ADC is not installed.
- **721** H-RESOLN ADC failed ROM/RAM test.
- **722** H-RESOLN ADC failed B-COM offset DAC test.
- **723** H-RESOLN ADC failed sampling ADC test.
- **724** H-RESOLN ADC failed integrating ADC test.
- **725** H-RESOLN ADC failed bus function test.
Error Message

Keysight B1500 Self-test/Calibration Error

740  GNDU failed calibration.
935  CMU FPGA version mismatch.
2400 SPGU module is in TEST FAIL state.
2401 Digital H/W function test failed.
2402 CPLD access function test failed.
2403 CPLD version check test failed.
2404 CPLD revision check test failed.
2405 FPGA configuration test failed.
2406 FPGA access function test failed.
2407 FPGA version check test failed.
2408 FPGA revision check test failed.
2409 DCM function test failed.
2410 CONVEND interrupt function test failed.
2411 EMG interrupt function test failed.
2412 10 MHz clock test failed.
2413 FPGA SYNC SEL pin control function test failed.
2414 FPGA SYNC FB pin control function test failed.
2415 FPGA SYNC IN pin control function test failed.
2416 IDELAY function test failed.
2417 NVRAM access function test failed.
2418 ADC function test failed.
2419 SDRAM access function test failed.
2430 Module EEPROM CRC data is invalid.
2431 Module EEPROM CRC data of module data ID is invalid.
2432 Module EEPROM CRC data of format revision data is invalid.
2433 Module EEPROM CRC data of analog reference data is invalid.
2434 Module EEPROM CRC data of timing calibration data is invalid.
2435 Module EEPROM CRC data is skew calibration data invalid.
2450  Internal ADC function test failed.
2451  0.5 Vref Internal ADC function test failed.
2452  4.5 Vref Internal ADC function test failed.
2453  Power Amp initial test failed.
2454  Filter & Amp test failed.
2455  Internal temperature test failed.
2456  Internal output resistance test failed.
2481  Invalid frame configuration.
2482  Frame has no modules.
2483  PLL not locked in slave module.
2484  Reference line is not connected.
2485  Sync line is not connected.
2486  Interrupt line is not available.
2487  Module service request assertion test failed.
2488  Module service request detection test failed.
2489  Emergency interrupt is not available.
2500  SPGU calibration failed.
2501  Power Amp idling calibration failed.
2502  DAC output level calibration failed.
3002  WGFMU initialization failure.
3003  WGFMU FPGA is not configured.
3004  EEPROM CRC data of system timing data is invalid.
3005  EEPROM CRC data of DAC DCM PS data is invalid.
3006  EEPROM CRC data of ADC DCM PS data is invalid.
3007  EEPROM CRC data of DAC clock edge data is invalid.
3008  EEPROM CRC data of ADC clock edge data is invalid.
3009  EEPROM CRC data of DAC level calibration data is invalid.
3010  EEPROM CRC data of ADC level calibration data is invalid.
Error Message

Keysight B1500 Self-test/Calibration Error

3011  EEPROM CRC data of DAC skew calibration data is invalid.
3012  EEPROM CRC data of ADC skew calibration data is invalid.
3013  EEPROM CRC data of RSU calibration data is invalid.
3014  Invalid EEPROM type.
3400  WGFMU module is in TEST FAIL state.
3401  Digital H/W function test failed.
3402  CPLD access function test failed.
3403  FPGA configuration test failed.
3404  FPGA1 access function test failed.
3405  FPGA2 access function test failed.
3406  FPGA1 System Clock DCM function test failed.
3407  FPGA1 DAC Clock DCM function test failed.
3408  FPGA1 ADC Clock DCM function test failed.
3409  FPGA1 Memory Clock DCM function test failed.
3410  FPGA2 System Clock DCM function test failed.
3411  FPGA2 DAC Clock DCM function test failed.
3412  FPGA2 ADC Clock DCM function test failed.
3413  FPGA2 Memory Clock DCM function test failed.
3414  FPGA1, 2 communication I/F test failed.
3415  CONVEND interrupt function test failed.
3416  10 MHz clock test failed.
3417  FPGA SYNC SEL pin control function test failed.
3418  FPGA SYNC FB pin control function test failed.
3419  FPGA SYNC IN pin control function test failed.
3420  IDELAY function test failed.
3421  Channel 1 SDRAM access function test failed.
3422  Channel 2 SDRAM access function test failed.
3423  WGFMU EEPROM access function test failed.
Error Message

Keysight B1500 Self-test/Calibration Error

3424 Channel 1 RSU EEPROM access function test failed.
3425 Channel 2 RSU EEPROM access function test failed.
3426 WGFMU EEPROM CRC data is invalid.
3427 WGFMU EEPROM CRC data of format revision data is invalid.
3428 WGFMU EEPROM CRC data of serial number data is invalid.
3429 WGFMU EEPROM CRC data of system timing data is invalid.
3430 WGFMU EEPROM CRC data of DAC DCM PS data is invalid.
3431 WGFMU EEPROM CRC data of ADC DCM PS data is invalid.
3432 WGFMU EEPROM CRC data of DAC clock edge data is invalid.
3433 WGFMU EEPROM CRC data of ADC clock edge data is invalid.
3434 WGFMU EEPROM CRC data of DAC level calibration data is invalid.
3435 WGFMU EEPROM CRC data of ADC level calibration data is invalid.
3436 WGFMU EEPROM CRC data of DAC skew calibration data is invalid.
3437 WGFMU EEPROM CRC data of ADC skew calibration data is invalid.
3438 RSU EEPROM CRC data of format revision data is invalid.
3439 RSU EEPROM CRC data of serial number data is invalid.
3440 RSU EEPROM CRC data of type id data is invalid.
3441 RSU EEPROM CRC data of calibration data is invalid.
3450 WGFMU EEPROM data is invalid.
3451 WGFMU EEPROM data of RSU type is invalid.
3452 WGFMU EEPROM data of RSU cable type is invalid.
3460 Main DAC, Main ADC test failed.
3461 Bias DAC, Main ADC test failed.
3462 Main DAC, Reference ADC test failed.
3463 VM function test failed.
3464 IM offset test failed.
3465 IM short test failed.
3480 Invalid frame configuration.
Error Message

Keysight B1500 Self-test/Calibration Error

3481 Invalid frame configuration.
3482 Frame has no modules.
3483 PLL not locked in slave module.
3484 Reference line is not connected.
3485 Sync line is not connected.
3486 Sync Reserve line is not connected.
3487 Interrupt line is not available.
3488 Module service request assertion test failed.
3489 Module service request detection test failed.
3490 Emergency interrupt is not available.
3500 WGFMU calibration failed.
3501 ADC gain calibration failed.
3502 CMR calibration failed.
3503 IM offset calibration failed.
3504 VM offset calibration failed.
3505 VF gain calibration failed.
3506 VF offset calibration failed.
3507 Reference ADC does not exist. Cannot perform WGFMU calibration.
3508 WGFMU, RSU cable length calibration failed.

**NOTE**

Error codes 4501 to 4701 are for HVSMU.

4501 Digital H/W function test failed.
4502 CPLC access function test failed.
4503 FPGA access function test failed.
4504 SERDES access function test failed.
4505 Bus FPGA JTAG function test failed.
4506 Float FPGA JTAG function test failed.
4507 OPT I/F access function test failed.
4508 Internal temperature test failed.
Error Message
Keysight B1500 Self-test/Calibration Error

4509 ADC access test failed.
4510 EEPROM access function test failed.
4511 Float lost detection test failed.
4512 ADC lost detection test failed.
4513 HVPS control test failed.
4514 ADC control test failed.
4515 DAC switch test failed.
4516 DAC control test failed.
4517 CALBUS control test failed.
4520 V divider gain test failed.
4521 V loop control test failed.
4522 Voltage detector test failed.
4523 Oscillation detector test failed.
4524 I ADC gain test failed.
4525 I loop control test failed.
4526 I range change test failed.
4527 HVPS force test failed.
4528 Over current detector test failed.
4529 Guard abuse detector test failed.
4601 VFVM calibration failed.
4602 EEPROM CRC data of VFVM adjust is invalid.
4603 Non-feedback mode offset calibration failed.
4604 Calculation of VM correction data failed.
4605 Calculation of VF correction data failed.
4611 IFIM calibration failed.
4612 EEPROM CRC data of IFIM adjust is invalid.
4613 IFIM offset measurement failed.
4614 IFIM gain measurement by Ref ADC failed.
Error Message

Keysight B1500 Self-test/Calibration Error

4615  IFIM gain measurement by I ADC failed.
4616  Calculation of IM correction data failed.
4617  Calculation of IF correction data failed.
4701  Non-feedback offset adjustment is failed.

NOTE

Error codes 5501 to 5701 are for HCSMU.

5501  Digital H/W function test failed.
5502  CPLC access function test failed.
5503  FPGA access function test failed.
5505  Bus FPGA JTAG function test failed.
5506  Float FPGA JTAG function test failed.
5507  OPT I/F access function test failed.
5509  ADC access test failed.
5510  EEPROM access function test failed.
5513  Power AMP bias test is failed.
5551  V offset self-test is failed.
5552  V sense self-test is failed.
5553  HS VADC self-test is failed.
5554  V CMR DAC self-test is failed.
5555  I offset self-test is failed.
5556  V loop self-test is failed.
5557  I sense low self-test is failed.
5558  HS IADC self-test is failed.
5559  I CMR DAC self-test is failed.
5560  I sense high self-test is failed.
5561  Power supply test is failed.
5562  V switch test is failed.
5563  High force output relay test is failed.
5564  High sense output relay test is failed.
Error Message
Keysight B1500 Self-test/Calibration Error

5601  VM offset calibration is failed.
5602  V CMR DAC calibration is failed.
5603  VM gain calibration is failed.
5604  IM offset calibration is failed.
5605  I CMR DAC calibration is failed.
5606  Iad gain calibration is failed.
5607  Power AMP bias adjustment is failed.

NOTE
Error codes 6501 to 6606 are for MCSMU.

6501  Digital H/W function test failed.
6502  CPLC access function test failed.
6503  FPGA access function test failed.
6504  Bus FPGA JTAG function test failed.
6505  Float FPGA JTAG function test failed.
6506  OPT I/F access function test failed.
6507  ADC access test failed.
6508  EEPROM access function test failed.
6509  V offset self-test is failed.
6510  V sense self-test is failed.
6511  HS VADC self-test is failed.
6512  V CMR DAC self-test is failed.
6513  I offset self-test is failed.
6514  V loop self-test is failed.
6515  I sense low self-test is failed.
6516  HS IADC self-test is failed.
6517  I CMR DAC self-test is failed.
6518  I sense high self-test is failed.
6519  V switch test is failed.
6520  High force output relay test is failed.
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6564</td>
<td>High sense output relay test is failed.</td>
</tr>
<tr>
<td>6601</td>
<td>VM offset calibration is failed.</td>
</tr>
<tr>
<td>6602</td>
<td>V CMR DAC calibration is failed.</td>
</tr>
<tr>
<td>6603</td>
<td>VM gain calibration is failed.</td>
</tr>
<tr>
<td>6604</td>
<td>IM offset calibration is failed.</td>
</tr>
<tr>
<td>6605</td>
<td>I CMR DAC calibration is failed.</td>
</tr>
<tr>
<td>6606</td>
<td>Iad gain calibration is failed.</td>
</tr>
<tr>
<td>N760</td>
<td>SMU failed function test.</td>
</tr>
<tr>
<td>N761</td>
<td>SMU failed VF/VM function test.</td>
</tr>
<tr>
<td>N762</td>
<td>SMU failed IF/IM function test.</td>
</tr>
<tr>
<td>N763</td>
<td>SMU failed loop status test.</td>
</tr>
<tr>
<td>N764</td>
<td>SMU failed temperature sensor test.</td>
</tr>
<tr>
<td>N765</td>
<td>SMU failed CMR amplifier calibration.</td>
</tr>
<tr>
<td>N766</td>
<td>SMU failed CMR amplifier adjustment.</td>
</tr>
<tr>
<td>N767</td>
<td>SMU failed CMR 100 V range full output test.</td>
</tr>
<tr>
<td>N768</td>
<td>SMU failed VF/VM calibration.</td>
</tr>
<tr>
<td>N769</td>
<td>SMU failed VM offset calibration.</td>
</tr>
<tr>
<td>N770</td>
<td>SMU failed VM gain calibration.</td>
</tr>
<tr>
<td>N771</td>
<td>SMU failed VF offset calibration.</td>
</tr>
<tr>
<td>N772</td>
<td>SMU failed VF gain calibration.</td>
</tr>
<tr>
<td>N773</td>
<td>SMU failed VF gain calibration at 20 V range.</td>
</tr>
<tr>
<td>N774</td>
<td>SMU failed VF filter offset calibration.</td>
</tr>
<tr>
<td>N775</td>
<td>SMU failed H-SPEED ADC self-calibration.</td>
</tr>
<tr>
<td>N776</td>
<td>SMU failed H-SPEED ADC VM offset calibration.</td>
</tr>
<tr>
<td>N777</td>
<td>SMU failed H-SPEED ADC VM gain calibration.</td>
</tr>
<tr>
<td>N778</td>
<td>SMU failed IF/IM calibration.</td>
</tr>
<tr>
<td>N779</td>
<td>SMU failed calibration bus test.</td>
</tr>
<tr>
<td>N780</td>
<td>SMU failed IM offset calibration.</td>
</tr>
</tbody>
</table>
Error Message
Keysight B1500 Self-test/Calibration Error

N781 SMU failed IM gain calibration.
N782 SMU failed IF offset calibration.
N783 SMU failed IF gain calibration.
N784 SMU failed IDAC filter offset calibration.
N785 SMU failed oscillation detector test.
N786 SMU failed I bias test.
N787 SMU failed common mode rejection test.
N789 SMU failed high voltage detector test.
N790 SMU failed zero voltage detector test.
N791 SMU failed V hold test.
N792 SMU failed V switch test.
N800 CMU failed NULL DC offset adjustment.
N801 CMU failed NULL DC offset measurement.
N802 CMU failed VRD DC offset adjustment.
N803 CMU failed VRD heterodyne offset adjustment.
N804 CMU failed NULL gain/phase adjustment.
N805 CMU failed MODEM offset adjustment.
N806 CMU failed relative Z adjustment.
N807 CMU failed Vch full scale measurement.
N808 CMU failed nominal gain measurement
N809 CMU failed extent range X3 adjustment.
N810 CMU failed range resistor 50ohm adjustment.
N811 CMU failed range resistor 1kohm adjustment.
N812 CMU failed range resistor 10kohm adjustment.
N813 CMU failed range resistor 100kohm adjustment.
N814 CMU failed relative Z calculation.
N820 CMU failed correction.
N830 CMU failed configuration test.
Error Message

Keysight B1500 Self-test/Calibration Error

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N831</td>
<td>SCUU failed SCUU configuration test.</td>
</tr>
<tr>
<td>N832</td>
<td>SCUU failed SMU configuration test.</td>
</tr>
<tr>
<td>N833</td>
<td>SCUU failed CMU configuration test.</td>
</tr>
<tr>
<td>N834</td>
<td>CMU failed digital function test.</td>
</tr>
<tr>
<td>N835</td>
<td>CMU failed CPLD test.</td>
</tr>
<tr>
<td>N836</td>
<td>CMU failed FPGA test.</td>
</tr>
<tr>
<td>N837</td>
<td>CMU failed EEPROM test.</td>
</tr>
<tr>
<td>N838</td>
<td>CMU failed PLL1/PLL2 test.</td>
</tr>
<tr>
<td>N839</td>
<td>CMU failed PLL DET low state test.</td>
</tr>
<tr>
<td>N840</td>
<td>CMU failed PLL DET high state test.</td>
</tr>
<tr>
<td>N841</td>
<td>CMU failed PLL1 lock test.</td>
</tr>
<tr>
<td>N842</td>
<td>CMU failed PLL2 lock test.</td>
</tr>
<tr>
<td>N843</td>
<td>CMU failed PLL2 lock test.</td>
</tr>
<tr>
<td>N844</td>
<td>CMU failed Hcur DC and VRD ADC test.</td>
</tr>
<tr>
<td>N845</td>
<td>CMU failed DC offset test.</td>
</tr>
<tr>
<td>N846</td>
<td>CMU failed DC bias 0V test.</td>
</tr>
<tr>
<td>N847</td>
<td>CMU failed DC bias -25V test.</td>
</tr>
<tr>
<td>N848</td>
<td>CMU failed DC bias +25V test.</td>
</tr>
<tr>
<td>N849</td>
<td>CMU failed PLL0 test.</td>
</tr>
<tr>
<td>N850</td>
<td>CMU failed PLL0 lock test.</td>
</tr>
<tr>
<td>N851</td>
<td>CMU failed PLL0 lock test.</td>
</tr>
<tr>
<td>N852</td>
<td>CMU failed DDS test.</td>
</tr>
<tr>
<td>N853</td>
<td>CMU failed DDS1 test.</td>
</tr>
<tr>
<td>N854</td>
<td>CMU failed DDS2 test.</td>
</tr>
<tr>
<td>N855</td>
<td>CMU failed VRD normalizer test.</td>
</tr>
<tr>
<td>N856</td>
<td>CMU failed RA1 test.</td>
</tr>
<tr>
<td>N857</td>
<td>CMU failed RA2 test.</td>
</tr>
<tr>
<td>N858</td>
<td>CMU failed ExR test.</td>
</tr>
</tbody>
</table>
Error Message
Keysight B1500 Self-test/Calibration Error

N859  CMU failed R_LPF2 f1 test.
N860  CMU failed MODEM DAC test.
N861  CMU failed N_II_DAC test.
N862  CMU failed N_QI_DAC test.
N863  CMU failed N_IQ_DAC test.
N864  CMU failed N_QQ_DAC test.
N865  CMU failed TRD normalizer test.
N866  CMU failed NA1 test.
N867  CMU failed NA2 test.
N868  CMU failed NA3 test.
N869  CMU failed N_LPF1 f2 test.
N870  CMU failed N_LPF1 f3 test.
N871  CMU failed N_LPF1 f4 test.
N872  CMU failed N_LPF1 f5 test.
N873  SCUU failed EEPROM test.
N874  SCUU failed output relay test.
N875  SCUU failed control test.
N876  SCUU failed CG2 test.
N877  SCUU failed LRL test.
N880  CMU failed Hcur AC and VRD Fm test.
N881  CMU failed SA/RA 32mV test.
N882  CMU failed SA/RA 64mV test.
N883  CMU failed SA/RA 125mV test.
N884  CMU failed SA/RA 250mV test.
N885  CMU failed ExR test.
N886  CMU failed Bias_chg test.
N887  CMU failed R_LPF2/R_HPF_vs test.
N888  CMU failed VRD IF test.
<table>
<thead>
<tr>
<th></th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>N889</td>
<td>CMU failed IRM local 0deg test.</td>
</tr>
<tr>
<td>N890</td>
<td>CMU failed IRM local 90deg test.</td>
</tr>
<tr>
<td>N891</td>
<td>CMU failed S_LPF1 f1 120kHz test.</td>
</tr>
<tr>
<td>N892</td>
<td>CMU failed S_LPF1 f2 500kHz test.</td>
</tr>
<tr>
<td>N893</td>
<td>CMU failed S_LPF1 f3 2MHz test.</td>
</tr>
<tr>
<td>N894</td>
<td>CMU failed S_LPF1 f4 5MHz test.</td>
</tr>
<tr>
<td>N895</td>
<td>CMU failed TRD MODEM test.</td>
</tr>
<tr>
<td>N896</td>
<td>CMU failed VG local 90deg test.</td>
</tr>
<tr>
<td>N897</td>
<td>CMU failed VG local 0deg test.</td>
</tr>
<tr>
<td>N898</td>
<td>CMU failed NA4 test.</td>
</tr>
<tr>
<td>N899</td>
<td>CMU failed NA5 X1/4 test.</td>
</tr>
<tr>
<td>N900</td>
<td>CMU failed NA5 X1/8 test.</td>
</tr>
<tr>
<td>N901</td>
<td>CMU failed N_LPF2 f2 500kHz test.</td>
</tr>
<tr>
<td>N902</td>
<td>CMU failed N_LPF2 f3 5MHz test.</td>
</tr>
<tr>
<td>N903</td>
<td>CMU failed MODEM PSD test.</td>
</tr>
<tr>
<td>N904</td>
<td>CMU failed PSD 0deg test.</td>
</tr>
<tr>
<td>N905</td>
<td>CMU failed PSD 90deg test.</td>
</tr>
<tr>
<td>N906</td>
<td>CMU failed Rr/Rf 100ohm test.</td>
</tr>
<tr>
<td>N907</td>
<td>CMU failed Rr/Rf 1kohm test.</td>
</tr>
<tr>
<td>N908</td>
<td>CMU failed Rr/Rf 10kohm test.</td>
</tr>
<tr>
<td>N909</td>
<td>CMU failed Rr/Rf 100kohm test.</td>
</tr>
<tr>
<td>N910</td>
<td>CMU failed TRD IV Amp test.</td>
</tr>
<tr>
<td>N911</td>
<td>CMU failed N_HPF1/N_LPF1 10kHz test.</td>
</tr>
<tr>
<td>N912</td>
<td>CMU failed N_HPF1/N_LPF1 200kHz test.</td>
</tr>
<tr>
<td>N913</td>
<td>CMU failed N_HPF1/N_LPF1 1MHz test.</td>
</tr>
<tr>
<td>N914</td>
<td>CMU failed N_HPF1/N_LPF1 2MHz test.</td>
</tr>
<tr>
<td>N915</td>
<td>CMU failed N_HPF1/N_LPF1 5MHz test.</td>
</tr>
<tr>
<td>N916</td>
<td>CMU failed NA1 test.</td>
</tr>
</tbody>
</table>
Error Message
Keysight B1500 Self-test/Calibration Error

N917  CMU failed NA2 test.
N918  CMU failed NA3 test.
N919  CMU failed IV saturation detector test.
N920  CMU failed normal status test.
N921  CMU failed normal status test.
N922  CMU failed IV saturation status test.
N923  CMU failed IV saturation status test.
N924  CMU failed unbalance detector test.
N925  CMU failed normal status test.
N926  CMU failed normal status test.
N927  CMU failed unbalance status test.
N928  CMU failed unbalance status test.
N929  CMU failed over current detector test.
N930  CMU failed normal status test.
N931  CMU failed normal status test.
N932  CMU failed over current status test.
N933  CMU failed over current status test.
Setup File Converter Execution Error

#01 Maximum length for the file path is 256 characters.
#02 fopen failure. Could not open source file.
#03 Specify a proper source file. The specified file is unsupported.
#04 Specify a proper source file. The specified file is corrupt.
#05 fopen failure. Could not open destination file.
MDM File Converter Execution Error

Error message:

10001  Reading XTR file was aborted.  
Conversion was aborted because of XTR file read error.  

10002  Reading ZTR file was aborted.  
Conversion was aborted because of ZTR file read error.  

10003  Writing MDM file was aborted.  
Conversion was aborted because of MDM file write error.  

10004  Writing log file was aborted.  
Conversion was aborted because of log file write error.  

10005  Invalid command option: A.  
Specify the effective option. The option A is not valid.  

10006  Invalid XTR or ZTR file: A.  
Specify a proper XTR/ZTR file. The file A may be defective.  

Warning message:

20001  Invalid element: A. Could not complete the conversion.  
Cannot convert the data of the improper element A.  

20002  Unsupported classic test: A.  
Cannot convert the data of the classic test A other than I/V Sweep,  
Multi Channel I/V Sweep, or C-V Sweep.  

20003  Application test result data is not supported: A.  
Cannot convert the application test result data.  

20004  Could not convert test setup using different V/I mode for VAR1  
channels.  
Cannot convert the test result data including the setup using different  
V/I mode for VAR1 channels in Multi Channel I/V Sweep classic test.  

20005  Unsupported impedance model: A.  
Cannot convert the data of the impedance model A.  

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20006      | Invalid value for the element: A. Maximum limit is B.
The value of the element A must not exceed B. |
| 20007      | Could not calculate the number of data for log sweep. Start: A, Stop: B.
Cannot calculate the number of data for log sweep. Start and stop values must be a non-zero value. Start value: A. Stop value: B. |
| 20008      | Unknown parameter: A, Value: B.
Data contains the unknown parameter A. The value is B. |
| 20009      | The element: A is not found in the search target: B. |
| 20010      | Invalid character: A. Could not convert to integer.
Data contains the character A which cannot be converted to integer. |
| 20011      | Invalid character: A. Could not convert to double.
Data contains the character A which cannot be converted to double. |
| 20012      | Invalid Unit: A. IC-CAP does not support this Unit. |
| 20013      | Log sweep stop value A was adjusted automatically. |
| 20014      | Could not convert test setup using multiple log sweep sources.
Cannot convert the test result data including the setup using multiple log sweep sources. |
Error Message

MDM File Converter Execution Error
Appendix
This appendix shows useful reference information for the use of the EasyEXPERT.

- “EasyEXPERT Measurement Capabilities v.s. Instruments”
- “EasyEXPERT File Summary”
EasyEXPERT Measurement Capabilities v.s. Instruments

Table A-1 shows the EasyEXPERT measurement capabilities supported by the instruments. The revision number in this table shows the first revision supporting the function.

<table>
<thead>
<tr>
<th></th>
<th>Advance Device Analyzer</th>
<th>Precision IV Analyzer</th>
<th>Economic IV Analyzer</th>
<th>Discontinued</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B1500A</td>
<td>B1505A</td>
<td>E5270B</td>
<td>E5260A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>E5262A</td>
<td>E5263A</td>
<td>B2900A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SMU Series</td>
<td>4155B/C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4156B/C</td>
</tr>
<tr>
<td>Classic Test</td>
<td>I/V Sweep</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 3.0 a</td>
</tr>
<tr>
<td>Multi-ch I/V Sweep</td>
<td>Rev. 3.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>I/V List Sweep</td>
<td>Rev. 3.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>I/V-t Sampling</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 3.1</td>
</tr>
<tr>
<td>C-V Sweep</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>SPGU Control</td>
<td>Rev. 3.1</td>
<td>-</td>
<td>-</td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 3.0</td>
</tr>
<tr>
<td>GUI based switching</td>
<td>Rev. 2.0</td>
<td>-</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td>matrix control</td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td>Direct Control</td>
<td>Rev. 3.0</td>
<td>Rev. 4.0</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Application Test</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 3.0</td>
</tr>
<tr>
<td>Tracer Test</td>
<td>Rev. 4.0 (DC/Pulse)</td>
<td>Rev. 4.0 (DC/Pulse)</td>
<td>Rev. 6.1 (DC)</td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(DC/Pulse)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Quick Test</td>
<td>Rev. 2.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Rev. 3.0</td>
</tr>
</tbody>
</table>
### EasyEXPERT Measurement Capabilities v.s. Instruments

<table>
<thead>
<tr>
<th>Function</th>
<th>Advance Device Analyzer</th>
<th>Precision IV Analyzer</th>
<th>Economic IV Analyzer</th>
<th>Discontinued</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B1500A</td>
<td>B1505A</td>
<td>E5270B</td>
<td>E5260A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>E5262A</td>
<td>E5263A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B2900A Series SMU</td>
<td>4155B/C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4156B/C</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>B1500A</th>
<th>B1505A</th>
<th>E5270B</th>
<th>E5260A</th>
<th>E5262A</th>
<th>E5263A</th>
<th>B2900A Series SMU</th>
<th>4155B/C</th>
<th>4156B/C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscilloscope View</td>
<td>Rev. 5.5</td>
<td>Rev. 5.0</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>External Instrument Driver Support</td>
<td>Rev. 3.1</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.1</td>
<td>Rev. 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCR Meter</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.1</td>
<td>Rev. 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse Generator</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.1</td>
<td>Rev. 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVM</td>
<td>Rev. 1.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.1</td>
<td>Rev. 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prober Control in Quick Test Mode</td>
<td>Rev. 2.0</td>
<td>Rev. 4.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.0</td>
<td>Rev. 6.1</td>
<td>Rev. 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Firmware Requirement</td>
<td>A.04.00</td>
<td>A.04.00</td>
<td>B.01.10</td>
<td>B.01.10</td>
<td>1.0</td>
<td>HOSTC: 03.08</td>
<td>SMUC: 04.08</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>h</td>
<td>h</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**

a. PGU and VSU/VMU are supported. Differential voltage measurement of VMU is not supported.
b. Keysight B2200/01A and E5250A/E5252A are supported.
c. Only available for supported modules.
d. Keysight 4284A/E4980A
e. Keysight 8110A/81110A/81150A/81160A
f. Keysight 3458A
g. Cascade Microtech Sumit 12000/S300 (Nucleus), Cascade Microtech (Suss MicroTec) PA200/PA300, and Vector Semiconductor VX-2000/VX-3000
h. The latest FW revision is strongly recommended to take full advantage of measurement capabilities.
# EasyEXPERT File Summary

Table A-2 shows the summary of files regarding the EasyEXPERT software.

## Table A-2  
**EasyEXPERT Files**

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Attribute</th>
<th>Description</th>
<th>To make it</th>
<th>To read it</th>
</tr>
</thead>
<tbody>
<tr>
<td>.gtr</td>
<td>EasyEXPERT</td>
<td>Includes the measurement traces recorded by the automatic trace record function in the tracer test mode.</td>
<td>Click the Save button in the Replay traces dialog box that is opened by clicking the Replay traces button.</td>
<td>Click the Open button in the Replay traces dialog box that is opened by clicking the Replay traces button.</td>
</tr>
<tr>
<td>.xdb</td>
<td>EasyEXPERT</td>
<td>Includes the EasyEXPERT database (backup).</td>
<td>Click Options &gt; EasyEXPERT Database &gt; Backup EasyEXPERT Database in the Start EasyEXPERT window.</td>
<td>Click Options &gt; EasyEXPERT Database &gt; Restore EasyEXPERT Database in the Start EasyEXPERT window.</td>
</tr>
<tr>
<td>.xpg</td>
<td>EasyEXPERT</td>
<td>Includes the My Favorite Setup (Preset) Group and setup data as its elements.</td>
<td>Click My Favorite &gt; Export.</td>
<td>Click My Favorite &gt; Import.</td>
</tr>
<tr>
<td>.xtd</td>
<td>EasyEXPERT</td>
<td>Includes the test definition of the application test.</td>
<td>Click Library &gt; New (or Export) in the application test mode.</td>
<td>Click Library &gt; Open (or Import) in the application test mode.</td>
</tr>
<tr>
<td>.xtr</td>
<td>EasyEXPERT</td>
<td>Includes sets of setup data and test result data.</td>
<td>Click Result &gt; Export &gt; As Test Result.</td>
<td>Click Result &gt; Import.</td>
</tr>
</tbody>
</table>
## EasyEXPERT File Summary

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Attribute</th>
<th>Description</th>
<th>To make it</th>
<th>To read it</th>
</tr>
</thead>
<tbody>
<tr>
<td>.xts</td>
<td>EasyEXPERT Test Setup</td>
<td>Includes setup data for Application Test/Classic Test/Tracer Test.</td>
<td>Click File &gt; Export &gt; Test Setup.</td>
<td>Click File &gt; Import &gt; Test Setup.</td>
</tr>
<tr>
<td>.xws</td>
<td>EasyEXPERT Workspace</td>
<td>Includes the EasyEXPERT workspace (backup).</td>
<td>Specify a new workspace in the workspace configurator during EasyEXPERT starting up.</td>
<td>Select the workspace in the workspace configurator during EasyEXPERT starting up.</td>
</tr>
<tr>
<td>.ztr</td>
<td>EasyEXPERT Compressed Test Results</td>
<td>Includes sets of compressed setup data and test result data.</td>
<td>Click Results &gt; Export &gt; As Compressed Test Result.</td>
<td>Click Results &gt; Import.</td>
</tr>
</tbody>
</table>